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C
ette affaire Mac Intel n’aura pas long-
temps traîné. Rondement menée, même !
Cette nouvelle pas forcément encore bien

digérée par tous les utilisateurs, voici donc les
deux premiers modèles de Mac construits au-
tour des technologies Intel. Le temps que les
stocks se vident, iMac G5 et PowerBook sont
encore en vente, si cela vous intéresse… Pour
ma part, je ne regrette pas d’avoir acquis un

iMac G5 il y a tout juste deux mois. Ainsi va l’informatique, je suis
rôdé. Et puis, c’est une excellente machine qui se révélera indispen-
sable au magazine: l’architecture PowerPC ne va pas disparaître du
jour au lendemain ! En revanche, mon PowerBook G4 de la pre-
mière heure a désormais fait son temps et comme je n’utilise plus
Classic depuis des lustres, mon passage au MacBook Pro devrait se
faire dès sa mise en disponibilité en février. Certes, mon disque Fire-
Wire 800 ne fonctionnera plus qu’en 400 et j’aurai peut-être besoin
d’un modem USB. Rien de bien méchant… Bien sûr, au départ, plu-

sieurs logiciels que j’utilise au jour le jour vont demander un coup
de main à Rosetta – l’émulateur PowerPC – et donc tourner moins
vite qu’attendu. Mais comme la bête est annoncée jusqu’à deux à
trois fois plus performante par rapport à mon PowerBook 1 GHz,
je devrais sans doute être gagnant! Certains vont dire que c’est bien
le MacBook Pro, mais qu’il faut avoir les moyens de se le payer .
Presque 2700 € certes, mais ce n’est pas systématiquement plus
cher que les autres portables PC Core Duo déjà sortis. Faites un
tour sur les sites marchands des constructeurs, vous serez surpris.
Je sais, ce n’est pas parce que je travaillerai avec un MacBook Pro
que VVMac sera un meilleur magazine, mais cela aidera sans doute
un peu. D’autant que, comble de chance, Quark a annoncé que la
version 7, attendue pour le printemps, sera directement compatible
Intel et deux à trois fois plus rapide que sur PowerMac. Au prin-
temps, l’immense majorité des softs que j’utilise fonctionneront de
façon native sur la nouvelle architecture. Que du bonheur, donc, et
beaucoup de travail à VVMac pour gérer et couvrir tout cela !

Bernard Le Du (bledu@vvmac.com)

Vous et Votre Mac
www.vvmac.com

Directeur de la publication :
Alain Lalisse
Rédaction : 
e-mail : redac@vvmac.com
Rédacteur en chef : 
Bernard Le Du 
Rédacteur en chef adjoint :
Alain Lalisse
Ont également collaboré :
Vincent Absous, Alynpier 
(Mac et Vidéo), Jean-Jacques
Ardoino, Jean-Louis Bataller
(secrétaire de rédaction),
Frédéric Blaison, Nicolas
Klingsor, Mathieu Lavant,
Franck Méréo, Henri-Dominique
Rapin, Frédéric Sanuy, André
Sterpin, Jean-Christophe
Vignes, et Laboratoire SUPINFO
des technologies APPLE
(www.labo-apple.org). 
Illustrations et photostous
droits réservés.

Publicité :
DIGICIA MEDIA 
Angélique Mermet
Tél. : 0140337956
angelique@vvmac.com

Vente au numéro :
Contact réservé aux 
dépositaires de presse : 
AE Media Olivier Le Potvin
Tél. / Fax : 0149760531
Prix du numéro France 
métropolitaine : 5,50 €
(dont TVA à 2,10 %)

Abonnement :
Vous et Votre Mac
howtodo publishing
114, rue des Pyrénées 
75020 Paris
abo@vvmac.com
Abonnement France
Métropolitaine 11 numéros: 48€.
DOM-TOM: 60,50 €.
Offre d’abonnement page 57.

Édito

Sommaire
E Markzware’s Q2ID 30
E Plug-in Akvis 32
E Diagonal Myriade 3 34
E ComicLife 36
E Google Earth 38
E Multifonction Brother MFC-640CW 39

[DOSSIER]

Le Web est, avec les emails, la plus importante 
utilisation de l’Internet. De très nombreux 
navigateurs sont disponibles sur Mac OS X,
mais tous ne se valent pas. Il ne suffit plus 
d’être rapide. Désormais, il faut aussi proposer 
un maximum de services. 40

E Safari, Firefox, Opera et OmniWeb : 
quatre navigateurs en vedette 42

E Optimisez Safari 48
E Musclez Firefox 52

[MAC OS X]
E Pour approfondir votre maîtrise 

de Mac OS X, jouez sa partition Unix 58

[TRUCS & ASTUCES]
E Questions techniques des lecteurs

et astuces de la rédaction 6

[À SAVOIR]
E iMac Core Duo et MacBook Pro : 

les Mac Intel sont déjà là ! 14
E iWork’06… pas de tableur 15
E iLife’06 mise sur le Web et .Mac 16
E En bref : Microsoft Office, encore 

pour cinq ans ; EyeTV 2.0 ; les fichiers 
WMV dans QuickTime. 14

E Trouvailles : SiteSucker, Spotlaser, 
SWF Movie Player, Vienna… 18

E Livres et sites 20

[PRISES EN MAIN]
E Adobe LightRoom Beta 1 22
E Chronos StickyBrain 4 24
E LaCie Carte Orange 27
E L’iPod 5G face au Palm LiveDrive 28
E Imprimante Seïko SLP420 30

Adieu PowerBook, vive le MacBook Pro!

Distribution kiosque France :
MLP

Imprimeur : BOCCIA
Via Tiberio Claudio Felice, 7
84131 Salerno. Italie.
Imprimé en Union européenne
Printed in European Union

Commission paritaire : 
0307K86157
Dépôt légal à parution
ISSN : 1771-7108

Vous et Votre Mac est 
une publication de la société
howtodo publishing SAS 
au capital de 37000 €
Siège social : 114, rue des
Pyrénées 75020 Paris, France
Tél. : 0870333738
RCS Paris B 479017857
SIRET 479017857 00018
Président : Alain Lalisse
Principaux actionnaires : 
Alain Lalisse, Bernard Le Du,
DIGICIA Media SAS

Toute reproduction, représentation,
traduction ou adaptation, qu’elle soit
intégrale ou partielle, quels qu’en
soient les procédés, supports 
ou médias, est strictement illicite
et interdite sans consentement de la
société howtodo publishing SAS, sauf,
conformément aux alinéas 2 et 3 
de l’article 41 de la Loi du 11 mars 1957,
les copies ou reproductions 
strictement réservées à l’usage privé
du copiste et non destinées 
à une utilisation collective, ou 
les analyses et courtes citations dans
un but d’exemple et d’illustration 
© howtodo publishing 2005.
Crédit photo et copyright, tous droits
réservés. Les prix mentionnés dans
les pages de ce magazine sont TTC,
sauf mention HT. Ils sont donnés à
titre purement indicatif, susceptibles 
de changements à tout moment 
et ne sont là que pour fournir 
une indication approximative 
des prix pratiqués sur le marché. 
Les adresses postales ou Internet 
de courriel ou de site sont 
susceptibles d’arrêt ou 
de changement à tout moment ; 
le magazine ne saurait en être tenu
responsable. Elles ne sont données
ici qu’à titre d’information.

4 N°12 février 2006Vous et Votre Mac

Le Web, profitez-en un max !

Retrouvez Vous et Votre Mac N° 13 dans les kiosques fin février 2006

Sommaire VVMac 12 JLOK.qxd  13/01/06  18:23  Page 4

mailto:bledu@vvmac.com
http://www.vvmac.com
mailto:redac@vvmac.com
http://www.labo-apple.org
mailto:angelique@vvmac.com
mailto:abo@vvmac.com


Le site de Vous et Votre Mac existe avant tout pour vous informer 
de la vie du magazine. Vous y consultez les sommaires, téléchargez 
des ressources nécessaires à la réalisation de certains articles pratiques
ou interrogez les index en ligne pour retrouver un article publié
dans un numéro passé. Pour vous éviter d’avoir à découper le magazine,
nous vous proposons aussi en ligne les coupons d’abonnement ou de
commande du hors-série ou du CD des PDF. Répondez à notre Enquête
lecteurs permanente pour nous aider à améliorer VVMac ou rendez-vous
sur le forum pour échanger avis et idées avec la rédaction ou partager
vos trucs et astuces avec d’autres lecteurs.
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Maîtrisez Tiger !
Un hors-série de

Vous et Votre Mac

À commander à la rédaction
(voir pages 57 et 93)

Contacts
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ou par courrier postal à l’adresse :
howtodo publishing
Vous et Votre Mac
114, rue des Pyrénées 75020 Paris

L’équipe de Vous et Votre Mac se consacre 
exclusivement à la réalisation du magazine
et de son site compagnon. Elle n’assure 
aucun support technique ou service 
de conseil. Nous ne répondons pas directement
au téléphone, ni de façon personnalisée 
aux lettres et emails reçus. Vous et Votre Mac
se réserve la possibilité de sélectionner 
certains courriers reçus et de les publier,
accompagnés ou non d’une réponse.

Pièces jointes !
Cette icône présente 
dans certains articles
indique que des éléments
fichiers, exemples 
complémentaires, etc.,
sont disponibles sur notre
site Web www.vvmac.com.
Téléchargez-les !
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L
a Terre nous préoccupe et c’est nor-
mal. Sur le site de la Nasa, vous
trouverez des milliers d’images de

notre planète en haute définition. La
Terre est ici montrée sous toutes ses cou-
tures (ouragans, nuages de sable, vues
depuis l’espace des grandes villes, Afri-
que, Asie, Europe et Antarctique com-

me on ne l’avait jamais vu de
si près…). Ces fichiers télé-
chargeables étant proposés
en très haute définition (sou-
vent en 2000 x 3000 pixels)
vous pouvez vous en servir
pour créer de superbes fonds
d’écran, même sur de très
grands écrans en pleine réso-
lution. Je vous rappelle pour
l’occasion qu’il est vraiment
très simple de placer une
photo en fond d’écran. 
Il suffit d’installer les fichiers quelque
part dans un dossier sur votre disque
dur. Vous faites ensuite un clic droit
sur le Bureau, puis choisissez Modifier
le fond d’écran…, ce qui ouvre les Pré-

férences système au panneau Bureau
et économiseur d’écran. Choisissez le
dossier de photos personnelles dans la
colonne de gauche. Grâce au pop-up
menu qui apparaît, vous réglez facile-
ment le redimensionnement. Essayez
tous les choix; cela occasionne parfois
des effets graphiques auxquels vous

n’auriez pas pensé. Et si vous êtes du
genre à vous lasser très vite des fonds
d’écran, cochez donc la case Changer
d’image. Un autre pop-up menu pro-
pose de régler la temporisation.

Sauvegardez
les numéros de série

Travailler avec des sharewares demande de l’organisa-
tion, ces logiciels étant distribués uniquement 
via Internet. Parfois, vous pouvez les obtenir sur CD,

voire dans un coffret, mais c’est un service qui se paie.
Notez que c’est désormais aussi le cas de nombreux 
logiciels «commerciaux» qui ne sont plus proposés 
en coffret, mais uniquement au téléchargement. Les coûts
pour l’éditeur sont ainsi réduits, mais cela ne se traduit
pas forcément par une réduction du prix de la licence!
Bref, les logiciels se téléchargent directement depuis 
le site des éditeurs. Parallèlement, on ne vous envoie pas
une lettre ou un coupon avec un numéro de série bien 
imprimé, mais un simple email. Il est donc de votre 
responsabilité d’effectuer une copie de sauvegarde 
du logiciel, le plus souvent une archive .dmg compressée
(.sit ou .zip), et du numéro de série indispensable pour 

le réinstaller en cas de problème. Vous pouvez également 
imprimer l’email contenant le numéro de série, mais 
pourquoi ne pas sauvegarder logiciel et numéro au même
endroit? Il suffit de faire Lire les informations sur 
l’archive et d’utiliser le champ Commentaire Spotlight
afin d’indiquer le code qui vous a été fourni. 
Notez de plus que, souvent, le code est lié à une version
bien précise du produit (il sera souvent nécessaire 
de payer à nouveau lors d’une mise à jour importante). 
Et comme il est extrêmement rare que, quelques 
années – voire seulement quelques mois – plus tard, 
la version que vous avez achetée soit toujours 
téléchargeable sur le site de l’éditeur, il est essentiel 
de conserver précieusement à la fois l’application 
et son sésame. Vous serez un jour bien content 
de posséder l’archive et son code dans un lieu sûr.

Pages réalisées par Alain Lalisse

La Terre en fond d’écran

Fenêtres express

http://earthobservatory.nasa.gov/Newsroom/NewImages/images_index.php3

P
our les machines pas très puissantes, accélérer un peu Mac OS X n’est pas un luxe. Il est possible de supprimer
ainsi les effets introduits par Apple pour l’ouverture et la fermeture des fenêtres. La procédure, sans risques, 
va vous prendre deux minutes. Ouvrez le Terminal (dossier Applications/Utilitaires) et tapez : defaults write

com.apple.finder DisableAllAnimations -bool true. Faites un [Alt clic-droit] ou [Alt Ctrl-clic] sur l’icône du Finder dans le Dock 
et demandez Relancer le Finder. Vous pouvez aussi quitter la session, mais c’est un peu plus long. Pour rétablir les effets, 
il suffit de saisir la commande inverse : defaults write com.apple.finder DisableAllAnimations -bool false et de relancer le Finder. 

6 N°12 février 2006Vous et Votre Mac
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Capture de pages Web

Aperçu ajuste vos photos

J
e pensais vraiment avoir tout vu en terme de capture, et Apple
avait d’ailleurs produit un gros travail en ajoutant l’option Sau-
vegarder en PDF dans le menu Impression. Et voilà un petit lo-

giciel gratuit, orienté «sauvegarde des pages Web», qui remet toutes
mes habitudes en question. Les sites Web ont en effet souvent ten-
dance à largement déborder en hauteur de l’écran, et parfois aussi en
largeur. Il faut alors jouer avec les ascenseurs, à moins que vous n’uti-
lisiez Opera qui offre une fonction unique de zoom. Pour sauvegar-
der une page, on peut créer une archive – mais ce n’est pas un for-
mat très pratique –, ou alors imprimer sous la forme d’un fichier PDF.
Hélas, dans ce dernier cas, la page est découpée en pages A4, par exem-
ple, et les images avec, si elles «tombent mal». Paparazzi règle le pro-
blème avec brio. Il suffit de lui donner l’adresse d’une page Web, de
capturer, puis d’enregistrer «la copie de la page » dans le format de
votre choix (PNG, JPeg en mode bitmap, ou mieux encore en PDF).
Au format PDF, les textes restent éditables, ce qui est très pratique
pour les copier-coller. On note tout de suite que la capture s’adapte
à la taille de la fenêtre, comme si on faisait dérouler les ascenseurs.
On peut donc obtenir un fichier très long ou très large, mais toujours
bien supérieur et sans rapport avec la définition de l’écran.
Paparazzi conserve en outre l’historique des visites. Vous en définis-
sez le nombre dans les préférences du logiciel. Il est donc très facile
de recapturer des pages qui changent souvent. Mieux : si vous défi-
nissez dans Safari un signet qui commence par «paparazzi:» en lieu
et place de «http:», vous ouvrez directement l’application Paparazzi
prête à faire la capture (essayez avec paparazzi:www.vvmac.com). 
www.derailer.org/paparazzi

V
oici tout d’abord quelques petits raccourcis clavier pour bien 
maîtriser Dashboard. Si vous avez déjà utilisé ce dernier, vous 
savez que, par défaut, c’est la fonction F12 qui l’appelle à l’écran.

C’est aussi avec cette même touche que vous revenez à l’environnement
habituel du Finder. Libre à vous cependant de choisir une autre touche 
dans les Préférences système, panneau Dashboard et Exposé.
Souvent, on ouvre Dashboard pour simplement consulter des informations
(l’heure, la météo, le trafic routier, les Post-it…), sans interagir avec 
les widgets. Dans ce cas, affichez Dashboard avec F12 et maintenez
cette touche enfoncée pendant la consultation. Lorsque vous relâchez 
la touche F12, Dashboard s’évanouit. Ce petit truc fonctionne également
si vous activez Dashboard avec un bouton de la souris. Il existe d’autres
raccourcis intéressants. Par exemple, au lieu de cliquer sur le signe «+»,
faites la combinaison de touches [Cmd –] (le signe moins). Pour faire 
défiler les widgets, utilisez la combinaison de touches [Cmd flèche
droite/gauche]. Il ne semble pas qu’Apple ait prévu une combinaison 
de touches pour choisir et activer un widget. Un oubli, peut-être! 
Pour relancer un widget afin de forcer une mise à jour d’informations 
dynamiques, faites [Cmd R] – vous aurez en prime un bel effet 
de tourbillon (si votre carte graphique est compatible Quartz Extreme).

A
perçu propose des fonctions qui n’ont plus rien à voir avec la simple 
visualisation. Non, il ne remplacera pas un Photoshop Elements, mais
dans le menu Outils > Correction d’image, vous trouverez les outils 

courants d’ajustement (disponibles aussi dans iPhoto), avec prévisualisation
immédiate: l’exposition pour corriger vos photos sous ou surexposées, 
le gamma pour leur donner un peu de pêche, le réglage du point blanc pour
corriger une lumière non naturelle, la saturation, le contraste, la luminosité…
Bien sûr, après vos corrections, vous enregistrez votre nouvelle image.

Dashboard en touches
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V
ous savez que Mac OS X possède de nombreuses 
ressources internationales. Vous pouvez ainsi jongler
entre des interfaces en diverses langues, des diction-

naires ou encore disposer de multiples claviers. Vous pouvez
avoir, par exemple, un clavier QWERTY et un clavier AZERTY.
Saviez-vous que vous pouvez choisir un clavier à l’ouverture
de session? Cela peut s’avérer particulièrement utile 
précisément à cet endroit, car la fenêtre de session vous 
demande votre mot de passe (et éventuellement votre nom).
Cela dit, si le Mac est utilisé par plusieurs personnes, 
la langue de travail a pu être modifiée et vous ne pouvez pas
le savoir. Quand vous tapez votre mot de passe, il est refusé!
Pour faire apparaître l’option du clavier dans la fenêtre 
d’ouverture de session, il faut cocher la case Afficher le menu
Saisie dans la fenêtre d’ouverture de session, située dans 
les Options du panneau Comptes des Préférences système
(vous devrez préalablement cliquer sur le cadenas et entrer 
un mot de passe administrateur).

Toujours dans la fenêtre de session, cliquez sur le texte 
en gris clair qui se trouve sous le logo Mac OS X. À chaque
clic, vous obtenez une information différente: le nom du Mac,
son adresse IP, le numéro de version de Mac OS X et sa build,
le numéro de série et les comptes réseau. Dans les petits
groupes de travail ou les entreprises, voilà un moyen très 
rapide de savoir quel Mac on a devant soi, si vous n’êtes pas 
l’utilisateur habituel et que vous n’avez pas le mot de passe).

Ouverture de session Jouez avec la musique
I

l existe de nombreuses solutions musicales à petit prix. J’ai trouvé par hasard
le site ronimusic qui propose des produits sympas. Audio Companion ré-
cupère une source provenant d’un micro ou de l’entrée ligne du Mac, à utili-

ser pour numériser des vinyles si vous n’avez pas Toast Deluxe et son CD Spin
Doctor. Il découpe automatiquement les morceaux en se basant sur les silences
et s’occupe également des crachotis et autres petits bruits parasites. Amazing Slow
Downer règle le pitch d’une boucle musicale sans en affecter la vitesse, et fait
aussi l’inverse. Parfait pour les amateurs de création musicale. Vous pouvez aussi
effectuer quelques essais sur des morceaux connus, le résultat est plutôt impres-
sionnant. Enfin, Sweet MIDI Player est un lecteur de fichiers MIDI de type
.mid ou .kar (karaoke). Tous ces petits outils sont compatibles Mac OS X Tiger.
On peut les télécharger sur le site de l’éditeur pour les évaluer avant achat. Les
prix des versions complètes sont raisonnables, de 25 à 45 $ (20 à 38 €).
www.ronimusic.com

3

2

1

Supprimer un prefPane?

L
es Préférences système sont ouvertes
aux développeurs tiers. Apple 
a d’ailleurs prévu une zone spécifique,

intitulée Autre, pour ces panneaux 
qui peuvent être de vraies applications 
autonomes (le logiciel de sauvegarde Déjà
Vu ou la télécommande Salling Clicker) 
ou des fichiers liés à d’autres logiciels.
Ces éléments portent l’extension .prefPane
et résident dans le dossier Bibliothèque/
PreferencePanes à la racine du disque dur,
ou dans un dossier Bibliothèque/Preference
Panes de votre compte utilisateur. Ainsi,
plusieurs utilisateurs du même Mac 
peuvent avoir un jeu de panneaux différent.
Comment supprimer un de ces panneaux
lorsque vous n’en avez plus besoin? 
Il existe un moyen très simple, sans avoir 
à fouiller dans le système. Faites un clic-droit
sur l’icône du panneau (ou [Ctrl-clic]). Le
menu qui apparaît vous propose de suppri-

mer le fichier et donc de faire disparaître
l’icône de la zone Autre des Préférences
système. Attention, cette méthode 
n’autorise pas la suppression des panneaux
partagés par plusieurs utilisateurs. 
Un message d’erreur est alors envoyé.

8 N°12 février 2006Vous et Votre Mac
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Sans coupures

Aperçu dévoile les images

V
ous possédez sans doute des CD-audio enregistrés en live, durant un concert. Même
si le CD est divisé en plusieurs morceaux, son écoute en est continue, sans aucune
coupure, les applaudissements faisant (en principe) jonction entre les titres. Lorsque

vous numérisez ces CD avec iTunes, vous aurez un petit «blanc» entre chaque titre, très
désagréable puisque l’on perd l’impression d’être dans la salle de concert, pendant l’enre-
gistrement en public ! Il suffit d’une case à cocher pour pallier ce problème. Ouvrez les
préférences d’iTunes à l’onglet Lecture. Cochez la case Lecture en fondu et placez le cur-
seur sur 0. Vous pouvez laisser ce réglage actif en permanence, pour tous les morceaux
joués. Cela ne dérange en rien l’écoute des titres enregistrés en studio.

A
perçu est l’application typique dont on pense en avoir fait le tour en quel-
ques minutes. Eh bien, depuis que je travaille sous Tiger, je découvre régu-
lièrement de nouvelles possibilités. Il était bien sûr possible d’ouvrir un

groupe d’images dans Aperçu (on les sélectionne et on les glisse toutes en même
temps sur l’application). Avec Tiger, voici un moyen beaucoup plus rapide. Tout
d’abord, choisissez un dossier avec des images. Il peut lui-même contenir des
sous-dossiers et le format des images n’a pas beaucoup d’importance. Du Tiff,
JPeg, Gif, PNG, et PDF bien sûr… Il n’est également pas très vital que le dos -
sier contienne ou non d’autres types de fichiers qui ne peuvent être ouverts avec
Aperçu. Laissez tout ce beau monde dedans, pas la peine de faire le tri! Glissez
le dossier sur l’icône d’Aperçu tout en appuyant sur les touches [Cmd Alt], une
combinaison qui force l’application à s’ouvrir en prenant en compte ce que vous
lui présentez (un dossier en l’occurrence).
Aperçu s’ouvre alors et affiche toutes les images dans sa fenêtre. Les PDF sont
ouverts quant à eux dans des fenêtres séparées. Voilà un moyen de retrouver ra-
pidement une image perdue dans une multitude de sous-dossiers.
Allons donc un peu plus loin… Vous savez peut-être que les applications se pré-
sentent aussi, sous Mac OS X, sous forme de dossiers qui contiennent de nom-
breuses ressources et notamment des images. Essayons donc de glisser une ap-
plication sur Aperçu, toujours en appuyant sur les touches [Cmd Alt]. Ça mar-
che! Vous accédez directement à toutes les images contenues dans l’application,
souvent celles qui servent à son interface. Essayez donc avec iChat ou iDVD.

Télécommande

L
a télécommande du nouveau iMac G5 ne sert pas qu’à
contrôler Front Row, le médiacenter d’Apple. Elle 
pilote aussi très bien iTunes en lançant la première

musique en liste. La touche Pause fonctionne. Et vous 
passez de morceau en morceau avec les touches avant et
arrière. Il faut que l’application iTunes soit déjà ouverte,
mais si vous ne voulez pas encombrer votre écran, 
vous pouvez réduire sa fenêtre ou la mettre dans le Dock.
La télécommande contrôle d’ailleurs toujours iTunes même
si vous travaillez dans une autre application. 
Et iPhoto ? Eh bien, ça marche aussi : la télécommande
lance et contrôle les diaporamas. Soit avec toute votre 
photothèque, soit avec un album précis que vous lui 
indiquez. Le lecteur QuickTime tire aussi parti de la 
télécommande. C’est intéressant pour faire une pause dans
un film ou une vidéo. Idem pour lecteur DVD ! 
Mais il semble quand même qu’iTunes soit prioritaire : si
vous avez ouvert iTunes, iPhoto et le lecteur QuickTime, et
que vous travaillez dans Photoshop, c’est la musique qui est
contrôlée avec la télécommande. 
Enfin, la télécommande d’Apple interagit avec le Finder. 
Elle assure par exemple le réglage du volume avec 
ses touches + et -. Et même la mise en veille du Mac : 
il suffit d’appuyer quelques secondes sur la touche Pause
pour voir apparaître le pictogramme de la télécommande
qui s’endort. Le Mac se met alors en veille. Et un autre appui
sur une touche de la télécommande le réveille.
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Exif au vol
V

oici un utilitaire gratuit qui nous accompagne dans le monde des données Exif.
Exif est une abréviation de EXchangeable Image File. Il définit des métadon-
nées techniques intégrées aux fichiers images (JPeg, par exemple) qui décrivent

en particulier les paramètres de prise de vue et les réglages de l’appareil numérique
qui a servi à prendre les photos. On retrouve par exemple dans les données Exif le
nom du fabricant et le modèle de l’appareil, la hauteur et la largeur de l’image, la
date et l’heure de la prise de vue, l’orientation, la résolution, le temps d’exposition,
l’ouverture du diaphragme, la mise en œuvre du flash… Comme vous pouvez le
constater avec cette liste, les données Exif sont générées automatiquement par l’ap-
pareil et elles ne sont pas éditables. Il ne faut pas les confondre avec d’autres méta-
données appelés IPTC qui sont, elles, définies par le photographe à fin d’organisa-
tion, histoire qu’il s’y retrouve plus facilement s’il possède quelques centaines de cli-
chés, voire plusieurs dizaines de milliers. Glissez une ou plusieurs photos sur Exif
Viewer. Ce dernier ouvrira une fenêtre d’informations pour chaque photo avec un
aperçu et tous les renseignements recueillis. Si vous prenez beaucoup de photos et
que vous souhaitez analyser précisément les résultats de réglages différents, c’est le
logiciel qu’il vous faut. Bien sûr, Photoshop, GraphicConverter, iViewMedia Pro ou
iPhoto sont également capables de lire ces données issues de l’appareil. L’avantage
ici, c’est la mise en œuvre d’un outil spécialisé qui ouvre directement, pour compa-
raison, une dizaine de clichés en un temps record – ce qui n’est pas toujours le cas
d’une application plus volumineuse. http://homepage.mac.com/aozer/EV
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N
e vous échinez pas à redimensionner les colonnes de 
la fenêtre d’iTunes à la main! Double-cliquez simplement
sur la petite barre de séparation à droite d’une colonne,

au niveau de son titre: sa largeur s’ajuste automatiquement.
Vous utilisez souvent les listes de lecture intelligentes? 
C’est bien pratique, mais alors que dans la bibliothèque 
une simple pression de la touche [Suppr] sur un titre
sélectionné suffit à éliminer le fichier, dans une liste 
de lecture intelligente, cela ne fonctionne pas. Une astuce: 
utilisez la combinaison [Suppr Alt].

Manips iTunes

E
n passant à Mac OS X, nous n’avons
pas perdu au change ! Reste que de pe-
tites fonctions du vieux Mac OS, très

utilisées, manquent toujours à l’appel après
cinq années écoulées et quatre versions ma-
jeures. C’est le cas de l’impression du contenu
des fenêtres du Finder. Les «anciens» se sou-
viennent peut-être de cette fonction qui per-
mettait d’imprimer le listing complet d’un
dossier. Beaucoup de sauvegardes sur CD
étaient accompagnées de cette feuille pliée
dans le boîtier cristal. Un moyen vraiment
pratique de retrouver rapidement ses petits.
Comme Apple ne veut décidément rien en-
tendre, il nous faut nous tourner vers des dé-
veloppeurs tiers. L’utilitaire Printwindow re-
prend cette fonction oubliée et la développe.
Avec la version gratuite de Printwindow, il
suffit de glisser un dossier, un disque dur, une
image DMG, etc., sur son icône pour défi -
nir les caractéristiques de l’impression du lis-
ting: une liste détaillée, seulement les noms,
avec ou sans les icônes, en descendant auto-
matiquement ou pas les sous-dossiers… On
note aussi des fonctions de tri. Le tout est im-
primé en format A4 ou comme une pochette
de CD/DVD. Si vous devenez accro, le même
utilitaire existe en shareware avec quelques
fonctions supplémentaires.
www.searchwaresolutions.com

Imprimez vos fenêtres
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Paroles de chansons

i
Tunes utilise désormais un champ d’informations nommé Paro-
les (Lyrics en anglais) longtemps ignoré. Il s’agit d’un simple champ
de texte, sans vraiment de limite théorique en terme de longueur

de la copie et censé contenir les paroles des chansons. Vous pouvez
remplir ce champ de plusieurs manières. Tout d’abord à la main, en-
suite par copier/coller, et enfin avec des outils automatiques. L’ou-
til le plus connu, pearLyrics, vient de fermer boutique suite à une in-
jonction des grandes maisons de disques qui voient dans ces logi-
ciels des outils de piratage. Heureusement, il nous en reste d’autres,
ainsi que des sites Web toujours bien actifs pour la musique fran-
çaise. Voici quelques pistes…
Côté utilitaire, iLyric fonctionne plutôt bien si vous avez des chan-
sons en langue anglaise. Si vous êtes amateur de chanson française,
ce n’est pas terrible… Il se base sur le site Web www.leolyrics.com
pour effectuer ses recherches et il n’y a pas beaucoup de références
dans notre langue. Par contre, utiliser iLyric est vraiment simple et
pratique. Il recherche automatiquement vos chansons dans la base

de données iTunes. On
peut alors sélectionner des
titres et faire Get Selected
ou directement Get All
pour rechercher tous les ti-
tres. iLyric place une petite
marque sur les chansons
trouvées. Ce qui est vrai-
ment bien, c’est le bouton
Sync iTunes qui place les
textes directement dans
iTunes, dans l’onglet Pa-
roles de vos chansons. 
iLyric est téléchargeable sur
VersionTracker (www.ver-
siontracker.com) ou sur
www.logicielmac.com

(avec une petite
explication en
français). Vous
p o u v e z a u s s i
consulter le site
http://lyrics.astra-
web.com. 
Pour trouver des
textes de chan-
sons françaises, cela se complique beaucoup, car je n’ai pas pu dé-
gotter un seul utilitaire qui travaille efficacement. On en revient donc
à la méthode du copier-coller. Voyez, par exemple, le site www. 
paroles.net. Pensez également à taper dans Google «paroles» ou
«lyrics» suivi du nom de l’artiste. On tombe souvent sur le site d’un
fan qui a fait le travail pour vous.
La piste des widgets est intéressante. Je vous conseille Sing that iTune!
que vous pouvez télécharger directement sur le site d’Apple (www.
apple.com/downloads/dashboard). Vous lancez iTunes avec une
chanson, vous passez dans Dashboard et le widget va vous chercher
les paroles de la chanson en cours de lecture. Si vous cliquez sur l’op-
tion adéquate (sur la deuxième face du widget), il stocke ces paro-
les directement dans l’onglet Paroles. Enfin, il lance une recherche
Google s’il ne trouve pas les paroles dans sa base de référence.

L
orsque vous transférez des fichiers à des utilisateurs qui travaillent 
sous Windows, il n’est plus trop nécessaire de se poser des questions 
existentielles sur la compatibilité des applications. Tous les grands 

standards existent dans les deux environnements : bureautique, graphique,
PAO… En revanche, il faut prendre quelques précautions en ce qui concerne 
les noms que vous donnez à vos fichiers. Mac OS X et Windows ne se sont pas
beaucoup rapprochés sur ce point, hélas. 
Tout d’abord, pensez aux extensions. Un fichier sans extension va laisser 
votre interlocuteur Windows devant un vrai casse-tête! Il est presque 

certain qu’il vous rappellera pour vous demander des précisions. Sur ce point,
Mac OS X a beaucoup apporté. Si ce dernier nous cache les extensions, 
il les conserve néanmoins toujours. Il suffit de se rendre dans les informations
d’un fichier pour ne plus en douter.
Cela dit, Mac OS X accepte certains caractères qui, eux, sont totalement proscrits
sous Windows. Les caractères ?, *, /, \, «, <, > et | seront refusés par Windows. 
Un refus signifié de différentes manières selon le mode de transfert. Parfois, 
le fichier apparaît tout de même dans Windows, mais son nom est totalement
modifié. On retrouve quelque chose du genre TCZSCU~O.DOC. Parfois aussi, 

Windows refuse obstinément 
de récupérer le fichier. Des fichiers
mal nommés dans un fichier Zip 
sont un exemple très courant. 
Si vous ne voulez pas vous fâcher
avec des collègues ou des amis sur
PC, pensez à eux et nommez 
vos fichiers sans signes spécifiques.

Dialogue Mac et Windows
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L
es iApps sont des
logiciels fournis par
Apple avec le sys-

tème Mac OS X. Elles
sont toutes stockées par

défaut dans le dossier Applications. Jus-
que-là, rien d’original, mais vous pour-
riez être tenté de les organiser dans des
sous-dossiers spécifiques ou d’en dé-
placer certaines dans une partition dif-
férente de celle de démarrage. C’est bien
évidemment possible et ces applications
continueront à fonctionner normale-
ment. Le problème interviendra lors
des mises à jour du système, car Apple
en profite pour faire évoluer certains
de ces logiciels. 
Le système de mise à jour ne recherche
les applications Apple que dans le dos-
sier Applications. Lorsqu’il ne les trouve
pas, il ne se pose pas de question exis-
tentielle : il considère qu’elles ont été
supprimées et il recrée tout simplement
de nouvelles versions dans Applica-
tions. Résultat, vous vous retrouvez au
fil du temps avec des versions multi-

ples et différentes! À moins de refuser
toute mise à jour du système – ce qui
est l’option certainement la plus stu-
pide –, le mieux est de s’abstenir de dé-
placer les applications. Laissez-les
dans… Applications. Pour les autres
logiciels Apple, faites en sorte de les
installer également dans Applications:
le système ne propose de mise à jour
automatique que s’il détecte les logi-
ciels là où il les attend. 
Bien que cela n’ait rien à voir directe-
ment, voici un autre petit conseil…
Lorsque vous supprimez des ressour-
ces de langues des applications dont
vous n’avez que faire, vous gagnez un
peu d’espace disque. Nous en avons
parlé le mois dernier. Mais lors des mi-
ses à jour système, Apple va réinjecter
toutes les langues des applications ou
des éléments du système concernés par
la mise à jour. En conséquence, pensez
à repasser, après une ou plusieurs mi-
ses à jour, l’utilitaire Youpi, par exem-
ple, afin d’effacer à nouveau les res-
sources de langues inutiles.

Lorsque vous faites Obtenir des informations sur un mor-
ceau de musique, vous accédez à l’ensemble des tags I3D,
informations qui sont stockées dans le morceau lui-même.

Dans l’onglet Options, vous pouvez maintenant cocher Conser-
ver la position de la lecture. Conçue au départ pour la lecture des
livres audio, cette option peut être utilisée sur n’importe quel
morceau. Lorsque l’option est activée, iTunes (et votre iPod) re-
tient la position où vous avez stoppé la lecture. Une nouvelle lec-
ture reprendra sur cette même position et pas au début. Bien en-
tendu, lorsque le morceau a été entièrement joué, on recom-
mence le cycle depuis le début, mais comme votre option est tou-
jours cochée, vous pouvez à nouveau vous arrêter et reprendre
ultérieurement au même endroit. J’ai personnellement trouvé
cela très pratique à l’occasion de cours audio d’apprentissage
d’une langue étrangère.

Pour les morceaux qui ne s’écoutent habituellement pas dans les
réunions familiales ou les parties entre amis – une symphonie ou
un opéra, par exemple –, cochez la case Ne pas lire en ordre aléa-
toire. iTunes ignorera alors ces morceaux dans la constitution
automatique de ses listes de lecture aléatoire.

[ ]

Passez le relais

Options iTunesNe déplacez pas les iApps!

V
ous venez d’avoir un tout nouveau Mac pour Noël – beau cadeau, non? – et
vous avez décidé de donner l’ancien à vos enfants, à un ami ou à un proche.
Ce bon vieux camarade a sans doute encore de longues années de services

à rendre. Vous avez donc installé votre nouveau «petit bijou» en récupérant 
votre compte d’utilisateur (pour faire simple). Reste à «préparer» votre ancienne
machine pour ses nouvelles aventures, réinstaller un système, les applications,
etc., tout cela pour passer le relais. La manœuvre va prendre du temps 
et, vraiment, cela ne vous enchante guère. Ce qui vous préoccupe, ce sont 
vos données et travaux personnels qui, eux, n’intéressent que vous. Vous 
ne voulez donc pas les voir tomber dans d’autres mains ou regards indiscrets.
La méthode est extrêmement simple! Il suffit de supprimer votre compte 
d’utilisateur. Pour cela, il faut au préalable en créer un autre. Dans les Préférences
système, ouvrez le panneau Comptes. Déverrouillez le cadenas et cliquez sur
le signe +. Une fenêtre vous invite à créer le nouveau compte (celui qui servira 

à vos enfants, par exemple). Donnez-lui un nom, un mot de passe et cliquez 
sur l’option Autoriser à administrer cet ordinateur. Le système prend quelques
secondes pour créer le compte. Fermez la session et reconnectez-vous 
sous ce nouveau compte. Ouvrez à nouveau les Préférences système
au panneau Comptes. Déverrouillez le cadenas. Sélectionnez votre ancien compte
et cliquez sur le signe –. Le système vous propose alors de créer un fichier 
avec vos données. Si vous les avez déjà transférées, cliquez sur Supprimer 
immédiatement, sinon une image disque de votre compte d’utilisateur sera créée
sur le disque. À vous d’en disposer comme vous voulez. Voilà, votre ancien 
Mac est prêt pour une nouvelle vie. Si cette procédure vous prend plus de trois
minutes, il faut lire plus souvent VVMac…
Bien évidemment, la même méthode peut être utilisée lorsque vous changez 
de Mac dans votre entreprise: votre machine contient peut-être des données 
encore plus sensibles!
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ModeT

Fonds d’écran

D
ans le panneau Bureau et économiseur d’écran des Préférences système,
l’onglet Bureau gère vos images de fond d’écran. Ces images sont situées
dans des dossiers ou reprises directement depuis iPhoto et notamment les

albums que vous avez créés. Malheureusement, avec iPhoto 5, lorsque vous sé-
lectionnez un album iPhoto, il n’est plus possible de changer d’image régulière-
ment. Les options de changement d’image sont en effet grisées . Voici un
moyen de contourner cette limitation.
Dans iPhoto 5, reprenez l’album qui contient la sélection d’images que vous vou-
lez utiliser comme fonds d’écran . Cliquez sur l’icône Bureau de la barre
d’outils : un nouveau dossier nommé Sélection iPhoto est alors créé dans
l’onglet Bureau (Préférences système > Bureau et économiseur d’écran). Cette
fois, la zone de changement d’images devient active . Cochez ensuite la case
Changer d’image, définissez l’intervalle de temps et le mode aléatoire pour ne
pas vous lasser au fil du temps.
Ceux qui possèdent deux écrans connectés sur le Mac ne verront pas ce dossier
Sélection iPhoto sur leur deuxième écran. Il faut donc ruser! En fait, ce dossier
est simplement un sous-dossier créé dans le répertoire Images/iPhoto Library de
votre compte d’utilisateur. Il contient les alias des photos de l’album . Pour
le deuxième écran, utilisez donc la fonction Choisir un dossier… et naviguez
pour choisir le dossier Sélection iPhoto indiqué ci-dessus. Les options de chan-
gement d’images sont toujours actives!
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N
ormalement, on filme en tenant le caméscope 
horizontalement. Moi qui pratique aussi la photo, 
j’ai l’habitude de tourner mon appareil un peu comme 

je veux, et passe au vol les modes paysage et portrait, car il y a
des sujets qui se prêtent mieux à telle ou telle orientation.
Aussi, filmer horizontalement en toutes circonstances devient 
un peu frustrant. Vous pouvez aussi basculer votre caméscope
pour filmer en mode portrait. Bien sûr, vous ne pourrez pas 
le visionner normalement sans risquer de vous déboîter le cou
mais avec un peu de travail, vous en ferez un fichier QuickTime
et conserverez cet effet de «hauteur» du mode portrait.
Peut-être que d’autres utilitaires permettent l’opération, 
mais j’utilise ici QuickTime Pro. Capturez tout d’abord 
votre séquence, avec iMovie par exemple. Glissez le clip 
obtenu sur le Bureau, ce qui crée un fichier DV. 
Si vous visionnez ce fichier directement dans QuickTime, 
bonjour le torticolis ! Faites alors Fenêtre > Propriétés 
de la séquence. Sélectionnez Vidéo Piste et affichez l’onglet
Réglages visuels. Il vous suffit de cliquer sur le bouton 
Rotation. Fermez la fenêtre et enregistrez comme séquence
autonome. Voilà, vous avez maintenant un fichier QuickTime
(.mov) qui se regarde normalement. Vous pouvez le mettre
sur votre site Web ou l’envoyer par email à vos amis.

L
es utilisateurs d’iBook ou de PowerBook connaissent
bien le mode T : ils connectent leur portable à un Mac 
cible (en FireWire 400 ou 800) et le démarrent avec 

la touche [T] enfoncée. Le portable est vu par le Mac comme
un disque dur FireWire externe, dont les volumes montent sur
le Bureau. Le Mac cible peut même redémarrer dessus! 
Ce mode T n’est pas réservé aux seuls portables. J’ai ainsi pu 
démarrer un vieux PB Titanium qui «patinait à l’allumage»
sur mon tout nouveau iMac G5 placé en mode T.

Vidéo en
mode portrait
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O
n s’attendait bien à quelque chose sur le
front Apple-Intel lors de cette Macworld
Expo 2006, mais les plus optimistes pen-

chaient pour l’annonce d’un Mac Mini et d’un
iBook. Eh bien, pas du tout! C’est un iMac et
le tout premier successeur des PowerBook qui
font une entrée fracassante puisqu’ils sont immé-
diatement disponibles à la vente ou presque (les
MacBook Pro ne seront là qu’en février). Voilà
une très bonne stratégie. L’iMac a beaucoup
plus de succès commercial que le Mac Mini
et devrait voir ses ventes s’envoler davantage
désormais et rallier encore de nouveaux adep-
tes issus du monde Windows tant il est vrai qu’il
n’y a pas grand-chose de comparable côté PC.
Qui plus est, que certains logiciels pros ne soient
pas encore au format Binaires Universels (notam-
ment ceux d’Apple pour lesquels il faudra atten-
dre jusqu’en mars), le «tout public» n’en a que
faire. Quant au MacBookPro, Apple se devait
de désigner le plus vite possible un successeur
aux PowerBook G4 vieillissants et s’aligner sur
la sortie de portables Core Duo de tous les autres
fabricants de PC. Chose faite… Et ce n’est qu’un
premier modèle avec écran 15,4” ! Les autres
(certainement un 17” et peut-être un 12”) sui-
vront sans doute rapidement.

iMac Core Duo: seul le processeur change
Revenons un peu sur les annonces de la Mac-
World Expo. En ce qui concerne l’iMac Core
Duo, il s’agit exactement de la même machine
que l’iMac G5 iSight, mais dotée d’un proces-
seur Intel Core Duo (Yona) à 1,83 GHz sur le
17” et à 2 GHz sur le 20”. C’est un processeur
double cœur. En attendant de tester la bête et
de vérifier avec de vrais logiciels qu’il est bien
deux fois plus puissant que l’iMac G5, il n’y

a pas grand-chose à dire. Il semble que seule
la carte vidéo change: l’ATI Radeon X600XT
est remplacée par l’ATI Radeon X1600 avec
toujours 128 Mo de mémoire (256 en option).
La gestion du Bureau étendu est standard (enfin).
Ce passage à Intel n’aura aucun impact sur
les étiquettes: les prix demeurent en effet iden-
tiques: 1379 € pour le 17” et 1799 € pour le
20”. L’iMac Core Duo est livré sous Mac OS
X 10.4.4 et il est fourni avec iLife’06 (ainsi
qu’une démo d’iWork’06).
Du côté des portables, il y a davantage à dire,
bien que le design ne change pratiquement pas.
Tout d’abord, pour bien marquer que les pro-
cesseurs PowerPC, c’est bel et bien fini, exit les
PowerBook, bonjour les MacBookPro. Un nom
que je trouve sympathique et qui a l’avantage
de bien dire qu’il s’agit d’un Mac, pas d’un PC!
L’autre point clé où Apple est attendu au tour-

Microsoft Office pour
cinq ans encore!

Àl’occasion de la MacWorld Expo et 
de la présentation des premiers Mac 

sur Intel, on apprenait qu’Apple et Microsoft
avaient signé le 25 novembre dernier 
un nouvel accord de partenariat au terme
duquel la Macintosh Business Unit de Microsoft
s’engage à développer Office pour Mac OS X
au cours des cinq prochaines années. 
En échange, Apple facilitera le développement
d’Office en communiquant ses nouvelles 
technologies. En mars, une mise à jour 
gratuite de Microsoft Office sera Binaires 
Universels. La prochaine version d’Entourage
utilisera les Sync Services d’Apple, 
se synchronisera avec le Carnet d’adresses 
et iCal ainsi qu’avec les PDA et smartphones. 
Le logiciel de courriel de Microsoft supportera 
Spotlight ainsi que la technologie SmartCard.
MSN Messenger 5.1 améliorera l’intégration
avec le Live Communications Server, 
mais toujours sans conférences audio et vidéo.

ElGato propose 
une version 2 de son

logiciel EyeTV qui pilote
tous les matériels 
d’acquisition EyeTV, mais
aussi ceux de nombreux
autres fournisseurs 
(Terratec, Miglia…). 
L’interface a été 
repensée pour Tiger, avec
notamment une nouvelle
télécommande virtuelle,
une gestion intégrée 

de la programmation des
enregistrements, des listes

de lecture et des groupes 
de chaînes, l’export One Click ou totalement
automatique en fin d’enregistrement vers
l’iPod vidéo, des fichiers EyeTV double-cliqua-
bles et gérés par le Finder. Jusqu’au 31 mars,
le logiciel coûtera 49 €, puis il reviendra 
à son prix normal de 79 €. Mise à jour gratuite
si vous avez acquis, après le 1er décembre
2005, EyeTV ou un matériel l’utilisant.
www.elgato.com
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Une version attendue
d’EyeTV

Microsoft et Telestream ont trouvé 
un accord pour que Flip4Mac Player, 

le lecteur vidéo de fichiers WMV intégré 
à QuickTime de cet éditeur (lire VVMac N° 7),
soit désormais distribué gratuitement 
(au lieu de 9,95 $). Il suffit de le télécharger 
et de l’installer. Il permet de lire des vidéos
WMV directement dans QuickTime et Safari.
Bien que cela ne soit pas officiel, cette info 
marque la fin du développement de Microsoft
Windows Media Player pour Mac OS X.
On ne s’en plaindra pas, le lecteur Flip4Mac
étant de meilleure qualité. Notez 
que les outils Flip4Mac d’export (codec) 
pour QuickTime restent quant à eux payants. 
/www.microsoft.com/windows/
windowsmedia/player/flip4mac.mspx

Les fichiers WMV 
dans QuickTime

Les iMac Core Duo et MacBook Pro sontdéjà là!
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iWork’06… pas de tableur

nant des tests, ce sont les performances. Privés de G5, les utilisateurs
de PowerBook «ont les dents». Moi qui ne travaille que sur Power-
Book, je remue ma frustration depuis des mois… Le constructeur
annonce des gains significatifs: le MacBook Pro Core Duo 1,83 GHz
serait en moyenne deux fois plus rapide que le PowerBook G4 à 1,67
GHz avec des logiciels comme GarageBand ou Final CutPro. Avec des
outils de benchmarking, on constaterait des gains de 4 à 6. De plus,
il embarque une carte graphique ATI Mobility Radeon X1600 avec
une capacité mémoire de 128 ou 256 Mo sur connecteur PCI Express.
Le point faible des portables est donc complètement effacé.

MacBook Pro: d’abord la performance
Je regrette un peu la disparition du port FireWire 800 (j’ai un dis-
que de 500 Go avec cette seule et unique connectique). Il n’y a donc
plus qu’un port FW 400 et deux USB 2. Je regrette aussi l’absence
de modem RTC interne (notre comptable nous envoie encore des fax),
option supplémentaire à 55 € qui occupe en plus un port USB.Nous
avions sur les derniers PowerBook un SuperDrive 8x DL, format ultra
slim oblige, or le SuperDrive du MacBook Pro n’est qu’un 4x sim-
ple couche. Le slot PCMCIA laisse la place à un slot ExpressCard/34
(encore peu répandu). Enfin, les documents d’Apple restent muets sur
l’autonomie. Les sites PC qui décortiquent le Yona disent qu’il s’avère
plutôt gourmand lorsque les deux cœurs sont utilisés à plein régime
par les applications. Mais bon, comme tous les fabricants de PC
utilisent ce processeur (parfois à des vitesses d’horloge supérieures),
ce problème ne devrait pas être cantonné aux seuls MacBook Pro.
S’il y a des moins, il existe aussi des plus sous la forme d’une minus-
cule caméra iSight intégrée à l’écran (ce qui fait perdre 60 pixels en
hauteur, la résolution n’étant plus que de 1 440 x 900) et de la télé-
commande infrarouge Apple Remote (pour le logiciel Front Row).
Utile et très sûre, la prise d’alimentation MagSafe… est magnétique.
En ce qui concerne les prix, le 1,67 GHz est facturé 2149 € (1079 €

pour le PowerBook G4 15” à 1,67 GHz) et le 1,83 GHz coûte 2699 €
(2599 € pour le PowerBook 17” à 1,67 GHz). Chez Acer, le Tra-
velMate 8200 Core Duo 1,66 GHz, avec la même carte graphique,
vient de sortir à 2247 € ou 2810 € selon la configuration. Donc,
sur ce coup-là, Apple n’est pas plus cher que les fabricants de PC! 
Les MacBook étaient très attendus, et ce premier modèle ne déçoit
pas, malgré ses petits défauts. Dernier point : impossible de lancer
Classic sur l’iMac Core Duo ni sur le MacBook Pro. Et si vous sou-
haitez acheter finalement un iMac G5 ou un PowerBook, c’est encore
possible: l’Apple Store les proposait toujours à la vente, aux mêmes
prix, les jours suivants l’annonce. n Bernard Le Du
www.apple.com

La mise à jour d’iLife et d’iWork à la MacWorld
Expo de janvier devient une tradition (je reviens
plus loin sur l’importante évolution d’iLife).

Tout d’abord, un mot sur iWork dont le succès reste
discret. Sans nouveau module, le package ne devrait
pas voir exploser ses ventes. Beaucoup attendaient
le renfort d’un tableur, mais l’accord signé avec Micro-
soft (lire la brève en page précédente) repousse
cette perspective d’au moins cinq ans! Toutefois, il
semble que Page 2, le logiciel d’édition de documents
d’Apple, intègre une nouvelle gestion de tableaux
calculés qui acceptent des formules dans leurs cel-
lules, mais cela reste avant tout un outil de mise
en page de données chiffrées. Page 2, c’est aussi
de nouveaux modèles de docu-
ments, toujours très « léchés »,
mais aussi d’esprit vraiment amé-
ricain. Un outil de dessin libre fait
son apparition, avec des formes
prédéfinies et même la gestion
des courbes de Bézier. Le logi-
ciel dialogue directement avec le
Carnet d’adresses de Mac OS X: de
quoi créer des documents person-
nalisés et des publipostages. 

Enfin, il est possible
d’annoter des docu-
ments lors d’un pro-
cessus de révision, et
ce de manière très
élégante. À noter que
les tableaux calculés,
mais aussi la gestion
avancée de graphi-
ques en 3D, l’édition
des photographies, les
outils de dessin et les
masques, la fonction
de révision… sont tous partagés avec Keynote 3. Une

manière très élégante d’apporter
des fonctions à plusieurs logiciels
sans alourdir aucun d’eux – Apple
recyclerait-il ici des technologies
conçues pour OpenDoc et Copland
(ce successeur de Mac OS 9 qui n’a
jamais vu le jour)? 
Outre ces fonctions communes, Key-
note 3 offre bien sûr de nouveaux
thèmes (en HD) et des transitions
« cinématiques » assez spectacu-

laires que l’on ne retrouve dans aucun autre logiciel
de présentation du marché. La licence d’iWork 06
coûte à nouveau 79 €. Il n’y a pas de prix de mise
à jour d’une version précédente, il faut simplement
renouveler l’achat. 
Ce qui est compréhensible de la part d’un shareware
à 20€ l’est moins d’un logiciel à 80 € - même s’il est
vrai qu’iWork n’est vraiment pas un produit coûteux.
Reste que pour 79 € également, vous pouvez ache-
ter le nouvel iLife 06 qui contient, lui, cinq logiciels
complets – avec iWeb – et de plus en plus sophisti-
qués au fil des versions. n BLD
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J
e ne l’ai pas encore eu entre les mains mais, étant un homme
a priori positif, cette mise à jour 2006d’iLife semble assez inté-
ressante. iPhoto est vraiment mis en vedette et GarageBand

devient un véritable studio d’enregistrement de podcasts. Une
cinquième application, iWeb, dédiée à la création de sites Web, fait
désormais son apparition… Bref, que du très bon.Le prix d’achat
(comme une sorte «d’abonnement annuel») reste fixé à 79 €.

iPhoto a été réécrit en grande partie avec à nouveau la vitesse et la
réactivité comme points d’orgue. Et cette fois, il semblerait qu’Ap-
ple y soit vraiment parvenu. Si vous voulez gérer toute votre photo-
thèque, vous avez le temps de voir venir: la librairie d’iPhoto 6 peut
accepter jusqu’à 250000 photos («1000 photos par jour pendant
vingt ans», précise Apple). Parmi les autres nouveautés, l’édition et la
comparaison de photos en mode plein écran, l’accès à davantage d’ef-
fets (notamment Core Image), la création de cartes de vœux, cartes
postales et calendriers. Il y a aussi le photocasting: vous publiez des
albums sur votre compte .Mac auxquels d’autres utilisateurs Mac
ou PC s’abonnent via iPhoto ou un lecteur RSS pour recevoir par la
suite automatiquement les mises à jour.

Le Web: le cœur battant d’iLife
Les principales évolutions des autres composantes de la suite por-
tent pratiquement toutes sur le Web, le podcasting et .Mac, dont
l’intégration est plus que jamais renforcée. Vous ne pouvez plus exploi-
ter toutes les possibilités d’iLife sans être également abonné au service
en ligne d’Apple (99 €/an). Nul doute que des développeurs tiers trou-
veront des moyens d’offrir des services similaires via des serveurs
«libres». Ainsi, dans iMovie HD 6, le moviecasting est à l’honneur.
Bien entendu, l’export direct au format iPod est au rendez-vous, mais
iMovie HD 6 offre surtout des thèmes animés comme iDVD et des
effets d’image ou de titrage de niveau professionnel et temps réel grâce
à Core Vidéo. Enfin, vous pouvez ouvrir plusieurs montages et glis-
ser-déposer des clips de l’un à l’autre.
L’application iDVD 6 prend – enfin – en compte n’importe quel
graveur de DVD connecté en externe. Jusqu’alors, il s’obstinait à ne
gérer que les SuperDrive. Dix nouveaux thèmes font leur entrée
dont certains en 16:9. Et si vous ne voulez pas vous compliquer la vie,
il se charge de créer des DVD d’un seul clic et de remplir pour vous
les zones actives de menus. Le plan graphique du DVD a été amé-
lioré afin que vous puissiez directement modifier son architecture.
GarageBand, déjà très utilisé par les podcasteurs, devient presque

incontournable: enre-
gistrement d’inter-
views audio iChat,
fader automatique des
micros, optimisation
de la voix, mixage… 
Il y a aussi beaucoup d’autres nouveautés pour celles et ceux qui créent
du son ou connectent des instruments à leur Mac.
Venons-en à iWeb. Il me semble très inspiré à première vue de Page.
Normal, c’est aussi un logiciel de mise en page, livré avec de nom-
breux modèles prêts à servir, mais que vous pourrez complètement
modifier – et en créer de tout nouveaux. Il a accès à toutes les librai-

ries et bibliothèques des différents logiciels d’iLife: images, films, musi-
ques, fichiers… Des pages spéciales automatisent la création de
blogs avec gestion RSS ou des podcasts. Bien entendu, la liaison
avec le service .Mac est à portée d’un seul clic, mais on peut tout de
même travailler avec un site personnel FTP classique.
Bref, cette version d’iLife est vraiment très belle sur le papier. Nous
y reviendrons dès notre prochain numéro. n Bernard Le Du
www.apple.com/fr/iwork/

iLife’06 mise sur le Web et .Mac
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S
potlight est un bel outil de recherche, sou-
vent controversé, mais tourné vers l’ave-
nir. Reste que son utilisation actuelle n’est

pas toujours concluante. Certains outils sont
donc apparus pour étendre ses possibilités.
Parmi eux, Spotlaser est un petit shareware à
la présentation soignée, réunissant toutes ses
fonctions dans une seule fenêtre. Il permet d’ob-
tenir, avant de lancer la recherche Spotlight, un

accès à divers critères comme la recherche sur
le nom de fichier uniquement, comment pren-
dre en compte les mots lors d’une recherche
(tous les mots, seulement certains, la phrase
exacte…), de préciser le type de fichiers, une
fourchette de dates, etc. On peut bien sûr dé-
finir où doit s’effectuer la recherche. Puis, grâce
au bouton bleu en bas de la fenêtre, on lance
la recherche, ce qui a pour effet de créer un dos-
sier intelligent dans une nouvelle fenêtre du
Finder. Ce dossier intelligent est créé par Spot-
light et conservé dans les recherches enregis-
trées de la Bibliothèque utilisateur. Il possède
donc les attributs habituels de ces dossiers,

du moins en théorie, car l’accès aux modifi-
cations des critères est actuellement inopérant.
C’est pour le moins gênant et il serait souhai-
table que cela soit corrigé très vite. Cela dit,
pour une application distribuée sur le mode du
«donationware», les résultats sont déjà plus
que satisfaisants et la façon d’affiner les critè-
res est intuitive et efficace. Une seconde manière
d’utiliser Spotlight (bien entendu pour Mac OS
X 10.4 minimum) .

n Jean-Jacques Ardoino
http://members.optusnet.com.au/frovil/
spotlaser.html (logiciel soumis au don)

À SAVOIR
Trouvailles[ ]

Aspirez les sites Web

Tout l’audio
sur AirPort Express

Rogue Amoeba, auteur de perles
comme Detour ou Audio HiJack Pro,

propose une nouvelle version d’Airfoil, 
un logiciel qui gère l’envoi de flux audio
sans-fil vers une ou plusieurs bornes 
AirPort Express. Surtout, on peut envoyer
n’importe quelle source audio et 
pas seulement ce qui est prévu par Apple.

Ainsi, depuis votre Mac, rien n’interdit
d’écouter dans la salle de bains 
une chanson jouée par Windows Media
Player pendant que, dans la salle 
de séjour, on peut entendre des MP3 lus
par une autre application. C’est tout 
simple, mais bien pratique. n JJA
www.rogueamoeba.com/airfoil/
(logiciel à 22 €)

MrDrum est une application pour 
programmer des boucles 

de batterie et leur adjoindre une petite 
ligne de basse. Les sons utilisés sont 
très corrects et, en plus des boucles
proposées, vous créez les vôtres. Cela
devient vraiment intéressant depuis les
dernières versions grâce à une fonction
d’export en midifile. On ne peut donc pas
exporter le son de la boucle à moins
d’utiliser WireTap ou Audio HiJack, mais

le midifile permet de récupérer la «parti-
tion» de la boucle sous un logiciel audio
comme GarageBand et de la jouer avec
les kits de batterie de votre choix. Ah,
l’ambiance des boîtes à rythme! n JJA
http://arcobaleno2001.interfree.it
(logiciel gratuit)

Programmez
vos rythmes
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Optimisez Spotlight

A
vec certains sites, notamment quand ils publient
une documentation répartie sur de nombreuses
pages, il est intéressant de pouvoir récupérer

tout ou partie du contenu. C’est là qu’un bon logiciel
spécialisé, nommé «aspirateur de site», peut jouer 
un rôle essentiel. SiteSucker est une solution 
assez complète, et surtout, ses préférences sont assez
précises quant aux types de fichiers à traiter 
(ou à ne pas traiter) et au nombre de niveaux à prendre
en compte pour que le résultat soit concluant. 
Une fois ces options réglées, les fonctions du logiciel
sont simples, mais le résultat dépend de l’organisation
du site lui-même. Ainsi, désigner un dossier d’un site
ne suffit-il pas à en ramener le contenu si les éléments
qu’il contient sont gérés à un autre niveau 
d’arborescence logique. Aspirer un site aujourd’hui
n’est pas toujours simple du fait de l’organisation 
logique sur le serveur et le code utilisé. J’ai comparé
pour un même site SiteSucker à Web Devil, qui est 
une des références, et leur comportement s’avère 
similaire: les fichiers sont pris en compte suivant 

l’organisation logique des liens qui les appellent. Ce qui
implique qu’on doit plutôt pointer sur la page d’index
et prévoir le nombre de niveaux nécessaires pour 
la partie qui vous intéresse. Une fois cela admit, 
cette application gratuite fait fort bien son travail.

n Jean-Jacques Ardoino
www.sitesucker.us (logiciel gratuit)
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La chasse
aux jaquettes

Préservez
vos documents

Il existe beaucoup d’utilitaires 
pour rechercher les jaquettes des

chansons conservées dans la Biblio-
thèque d’iTunes, mais Utilitunes 
apporte un petit plus. Il recherche
également les notes sur les albums 
(détails sur les chansons, auteurs,
compositeurs…). Même si la recher-
che automatique de paroles et 
de tablatures a été désactivée pour
des raisons légales, le logiciel peut
les stocker et les ajouter aux tags
des chansons. Utilitunes sait vous
proposer plusieurs jaquettes ainsi
que diverses versions des notes 
de l’album. Bref, une source
d’informations très riche sur des 
albums qu’on croyait oubliés. n JJA
www.exspectatorsoftware.com
(logiciel à 5 $)

Combien de fois un plantage, 
si rare pourtant, vous a-t-il fait

perdre vos dernières modifications
sur un document? SaveMe peut 
vous rendre service: l’application
gère des sauvegardes régulières
pour la plupart des logiciels. 
Quand SaveMe est lancé, un menu
permet d’accéder aux préférences
et à l’inspecteur. Vous pouvez 
régler la fréquence des sauvegardes,
un comportement distinct 
par application, des alertes sonores,
un raccourci clavier, etc. SaveMe 
est toutefois un peu cher. n JJA
www.zapptek.com
(logiciel à 17,95 $)

S
afari 2.0, livré avec Tiger, gère
de manière originale les flux
RSS, mais certains préfèrent

utiliser une application dédiée. Parmi
ces outils spécialisés dans la gestion
des RSS, Vienna, développée 
en open source pour Mac OS X 10.3.9
et plus, gratuite et traduite en 
français, offre toutes les fonctions 
que vous êtes en droit d’attendre. 
Sa fenêtre affiche la liste des flux
auxquels vous êtes abonnés, la liste
des articles du flux sélectionné et 
un visualiseur pour lire chaque flux.
Les liens sont ouverts dans un nouvel
onglet et s’affichent grâce au Webkit,
le moteur HTML de Mac OS X.
Ils peuvent être aussi ouverts dans
le navigateur par défaut via le menu
contextuel. Ajouter des flux se fait
simplement avec le bouton +
ou bien en glissant un flux depuis
une autre application. Vous placez
des marques, rafraîchissez, déclarez
tout comme lu, etc. Des dossiers 
intelligents vous assurent de réunir

les articles répondant aux critères
souhaités. Dans les préférences,
vous réglez la fréquence des rafraî-
chissements, le lecteur RSS par 
défaut, le dossier de télécharge-
ment, la taille des polices… Vienna
réunit tout ce qui est utile aussi bien
que le font certaines applications 

célèbres comme NetNewsWire 
ou NewsFire. Avec sa gestion par 
onglets, le marquage, les dossiers 
intelligents et une interface aussi
pratique qu’agréable, difficile de 
ne pas adopter cette perle? n JJA
www.opencommunity.co.uk/
vienna2.html (logiciel gratuit)

Lisezvos flux RSS

Movies Flash avec tout le confort

L
a lecture des documents
Flash (SWF) est assurée
par les navigateurs Web.

Glissez un fichier pour lancer
la lecture et le menu contextuel
liste les commandes. Cela dit,
Eltima nous offre gratuitement
SWF Movie Player, un petit bi-
jou d’interface complète pour
lire confortablement ces fichiers.
Un panneau de commandes
permet de zoomer à loisir, de
revenir en arrière ou d’aller en
avant, de placer le point de lec-
ture où vous voulez, de met-
tre en pause… Vous pouvez gé-
rer une liste de lecture, lire vos
documents en ordre aléatoire,
obtenir des informations complètes sur un docu-
ment actuellement en cours de lecture en bas-
culant sur le panneau d’information sur le SWF…
L’application fonctionne avec quasiment tous les
types de documents SWF, y compris les jeux qui
sont de plus en plus nombreux. Certes, en dehors
de la liste de lecture, SWF Movie Player n’apporte
pas de fonctions fondamentalement différentes
de la gestion sous un navigateur, mais le confort

est bel et bien réel. Les commandes via le pan-
neau sont évidemment bien plus souples que par
le menu contextuel (qui reste d’ailleurs disponi-
ble dans l’application) et la liste de lecture conserve
la trace de tous les documents visionnés, ce qui
les rend aisés à retrouver si besoin est. Une pe-
tite application sans prétention, mais soignée, qui
vous sera sans doute très utile. n JJA
www.eltima.com (logiciel gratuit)
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CSS… initiation

Eyrolles • 5 € le dépliant

U
ne nouvelle collection d’aides-
mémoires est proposée par Eyrolles.
Chaque fascicule de 14 pages 

plastifiées est un véritable concentré
d’informations, avec la description 
des actions les plus courantes, 
les raccourcis clavier… Pour l’instant, 
les logiciels open source sont à l’honneur
avec des fascicules sur SPIP, UML, CSS 
et OpenOffice.org. Attention, pour utiliser
ces dépliants, mieux vaut déjà 
bien connaître les logiciels concernés.

D
ave Shea et Molly Holzschlag,
auteurs de cet ouvrage, se sont
fait les apôtres du design CSS.

Dave Shea a lui-même créé un site très
réputé dédié à cette technologie,
www.csszengarden.com (en anglais),
auquel des designers du monde entier
contribuent. Une initiation prolongée par
ce très beau livre qui expose en détail
procédure, code et outils utilisés pour
quelque trente-six des meilleures 
contributions faites à CSS Zen Garden.
Un livre qui ne sera vraiment utile 
qu’aux professionnels du Web.

Vous vous posez des questions sur l’environnement Free, la Freebox 
et toutes les options associées? Ce livre vous apporte, sous forme 
de questions/réponses, toutes les informations techniques, sans rien

cacher des problèmes. C’est intéressant pour ceux qui souhaitent mieux
connaître leur futur opérateur Internet et pour ceux qui utilisent Free,

mais n’ont jamais été beaucoup plus loin. Prenez les options 
du téléphone, par exemple: savez-vous que l’on peut faire des transferts,

mettre en place un répondeur, utiliser le double appel, 
la conférence…? Autant de réponses qui modifieront votre quotidien.

Freebox à 200% 19 € ISBN : 2-84177-341-8 Éditeur O’Reilly

Maîtrisez votre Freebox

Les cahiers d’exercices Photoshop sont une nouvelle 
collection basée sur des pas à pas, avec une copie 
d’écran légendée pour chaque étape. Le cahier 1 

est dédié aux débutants et comporte 34 exercices 
(par exemple supprimer une couleur dominante ou teindre
les cheveux en brun). Le cahier 2 s’adresse à ceux qui
connaissent déjà un peu Photoshop. Il comporte 
29 exercices (par exemple ajouter une ombre ou greffer
une tête de chat sur un modèle). Chaque cahier est
accompagné d’un CD-Rom avec les images originales 
et finales, ainsi qu’une copie d’écran des différentes étapes. Les pas 
à pas, quand ils sont bien conçus, sont un bon moyen de progresser sans pour autant 
se «payer» la lecture de dizaines de pages de documentation.
Photoshop Cahiers d’exercices 1 et 2 19,90 €chacun ISBN : 2-212-11694-2 et 2-212-11695-0
Éditeur Eyrolles

Photoshop
pratique

Marre des embouteillages, des heures passées dans les transports…
Le travail à la maison séduit de plus en plus les employés, 
et peut-être bientôt les employeurs. Les indépendants, eux, 

ne se posent plus de questions. En 128 pages de petites saynètes, 
brossées avec humour par Jean-Christophe Courte et illustrées 
d’un dessin ou d’une planche signée Lukino, ce petit livre fait le tour 
du sujet. Ce n’est ni une thèse en sciences sociales ni un essai 
juridique sur le télétravail. Les auteurs travaillent simplement chez eux
après avoir fréquenté des entreprises, et c’est de leur expérience vécue
que se nourrissent tous ces tableaux de vie au quotidien. De l’humour
oui, mais sur le fond, beaucoup d’idées pratiques. Lorsque le livre 
est arrivé à la rédaction, je l’ai ouvert au hasard et suis tombé sur la page
consacrée au syndrome du pyjama… Et comme, justement, je n’étais pas rasé et encore en robe de chambre… 
cela m’a fait un peu froid dans le dos, et puis bien rire! Travailler chez soi, c’est loin d’être facile. Se réserver 
du temps, optimiser sa vie, gérer le regard des autres (famille, parents, clients), etc., tout est abordé sans complexe. 
Jean-Christophe Courte anime également un blog renommé: www.macdigit.com.
Comment travailler… chez soi 10 € ISBN : 2-7081-3417-5 Éditeur Eyrolles

Le Zen des CSS
Eyrolles • 30 € ISBN : 2-212-11699-3 
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Je télétravaille !
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[ ]À SAVOIR
Livres & Sites

Ce site offre une liste des utilitaires les plus 
courants pour Mac, et dans tous les domaines. 
La présentation est plutôt sympa. La liste affiche

l’icône du logiciel, une petite description, l’indication 
du système, du statut freeware, shareware, démo, et une
note. La fiche détaillée propose parfois une description
complémentaire avec copie d’écran. Il est possible 
de lire et d’ajouter des commentaires. Il est souvent 
intéressant de voir ce que pensent ceux qui ont utilisé
un produit. Le jour de ma visite, il y avait 330 logiciels
référencés. Vous pouvez participer à cette sélection 
en envoyant votre utilitaire préféré: utilisez le menu
Ajouter un logiciel en haut à droite, dans la page 
d’accueil. Enfin, en cas de gros souci ou simplement pour
aider d’autres utilisateurs, vous pourrez utiliser le forum. 
www.logicielmac.com

Pierre Labbe met à jour son ouvrage de référence pour Photoshop. 
Ce très gros livre reprend toutes les fonctions de la version CS 
et y ajoute les nouveautés de la CS2 : objets dynamiques, filtre Point 

de fuite… L’ouvrage «pèse» maintenant plus de 800 pages et s’adresse 
au débutant comme au professionnel. C’est une bible sur le logiciel d’Adobe,
traitant des aspects les plus simples aux plus complexes. Pour ceux qui veu-
lent une documentation papier de qualité, c’est parfait ! Il est accompagné
d’un CD-Rom avec les fichiers d’exemples pour réaliser les exercices.
Photoshop CS2 39 € ISBN : 2-212-11693-4 Éditeur Eyrolles

Àla différence du premier, cet ouvrage de Martin Evening est dédié 
aux professionnels de l’image et aux photographes passés 
au numérique et retravaillant leurs images (l’auteur est lui-même 

photographe professionnel). Ce beau livre de plus de 500 pages, tout en cou-
leurs, est une mise à jour d’un précédent livre, prenant en compte Photoshop
CS2. Il donne vraiment envie de se mettre à la création photo ! Les exemples
donnés sont de grande qualité. Il est accompagné d’un CD-Rom avec des
petits films QuickTime (en anglais) et, pour la première fois, les photos du livre.
Photoshop CS2 pour les photographes 36 € ISBN : 2-212-11700-0
Éditeur Eyrolles

Référence Photoshop

Cet ouvrage pratique est issu des stages de formation de la Color 
Academy, société d’audit, de conseil, de formation et d’assistance dans
le domaine de l’imagerie numérique pour les professionnels. Il traite 

du calibrage, de l’utilisation des profils ICC depuis la prise de vue jusqu’à 
l’impression. On verra tout d’abord les outils de création de profils, 
la prise de vue (fichier Raw) et la problématique du scanner. Ensuite, 
on passe aux écrans d’ordinateur et aux méthodes de correction rapide.

Enfin, on termine par l’impression en jet d’encre, en couleur et en noir & blanc.
Calibrage facile pour la photographie 26 € ISBN : 2-9525-0761-9 Éditeur Color Academy

Calibrage et impression

Plug-in

E
ntrez dans le monde enchanté 
des plug-in Photoshop. Dommage
que nombre d’entre eux 

ne fonctionnent que sur PC (l’auteur 
précise à chaque fois Mac & PC ou PC
seulement). Toutes les copies d’écran ont
été faites sous Windows. Vous risquez
donc d’être un peu déçu si le plug-in qui
vous intéresse n’est pas compatible Mac.
Sinon, l’ouvrage tout en couleur est bien
réalisé. L’auteur a fait une tentative 
de classement qui permet de rendre 
l’ensemble agréable à lire.

Le grand livre des plug-in 
Photoshop • Dunod • 35 €
ISBN : 2-10-048704-3 

Scripts Shell

C
e livre technique, bien qu’il 
présente en introduction 
les langages de scripts et les bases

minimales indispensables, n’est pas 
à la portée de tous les utilisateurs Mac.
Les exemples sont nombreux et didacti-
ques, mais mieux vaut avoir une prédis-
position à la programmation pour en tirer 
le bénéfice. Si vous vous accrochez, 
vous verrez que votre système peut 
faire des tas de choses intéressantes 
à votre place. Des efforts certes, mais 
de gros gains de temps à la clé!

Scripts Shell • O’Reilly• 38 €
ISBN : 2-84177-375-2 

Trouvez un logiciel…

Pages réalisées par Alain Lalisse
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Adobe LightRoom (Beta)

PRISE EN MAIN

Adobe ne veut pas abandonner le marché des photographes 
professionnels à Apple et être détroussé comme jadis avec la vidéo. 
La bataille entre LightRoom et Aperture va être sublime. Tant mieux!

Une réplique magistrale!

LightRoom n’est pas le portage 
d’un logiciel Windows, ni même 

un logiciel multi-plateforme (même 
s’il sortira in fine pour Windows).
LightRoom est un logiciel Cocoa, 
natif Mac OS X. C’est un logiciel 
omnifenêtre dans lequel on retrouve 
toutefois des éléments de l’interface
traditionnelle d’Adobe, mais ici, pas 
de palettes multiples. Tout est clair !

Vos photos là où elles sont
Si l’on peut recopier ou déplacer 
les photos dans une librairie gérée 
par LightRoom (et les renommer 
au passage), celle-ci n’est qu’un dossier
dont vous fixez le nom et l’emplacement

dans les Préférences, onglet File 
management). Ce dossier contiendra
lui-même des sous-dossiers qui
correspondent à chaque importation
d’images (shoot). Par ailleurs, 
LightRoom référence les images dans
sa base de données relationnelle.
C’est aussi dans cette base que 
les ajustements et modifications 
apportés aux images sont stockés,
comme dans Aperture, sous forme 
de scripts qui les décrivent. Les photos
originales ne sont jamais altérées.
Cela dit, LightRoom peut également 
se contenter de référencer les images
là où vous avez décidé de les ranger 
et de les organiser .1

+ Un logiciel pensé pour les professionnels de la photographie et plus 
spécialement ceux qui travaillent en format Raw ; concurrent frontal 
du logiciel Aperture d’Apple ; excellent logiciel, même au stade Beta.

- Une version Beta dans laquelle de nombreuses fonctions manquent encore ;
comme dans Aperture, j’aimerais pouvoir accéder aux différentes versions
d’une même image traitée dans LightRoom.

PRIX : Version Beta en téléchargement libre, 
date de sortie et prix non communiqués
FOURNISSEUR : Adobe (http://www.macromedia.com/cfusion/
entitlement/index.cfm?e=labs%5Flightroom)
CONFIGURATION MINIMALE : Mac G4 et G5 à 1 GHz, 
Mac OS X 10.4.3

1

2

6

3

4

Q
uelques semaines après la commercialisation d’Aperture, Adobe,
qui travaillait depuis de longs mois sur son propre projet de
logiciel dédié aux photographes professionnels, a décidé de

dévoiler ses cartes. Il nous livre aujourd’hui son bébé sous forme
de Beta publique, fonctionnelle jusqu’en juin 2006. Cette transpa-
rence est peut-être quelque peu contrainte par les événements, mais
elle est la bienvenue. Adobe a tout à gagner : LightRoom pourra
évoluer très vite et surtout mieux coller aux vrais besoins des pho-
tographes. Le logiciel fonctionnant bien en l’état – même s’il man-
que encore quelques fonctions importantes –, je vous livre ici un compte
rendu rapide de cette première prise en main. n Bernard Le Du
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Quelle que soit la méthode choisie,
lors de l’importation, vous pouvez
marquer l’ensemble des photos 
d’un import (shoot) d’un copyright 
et assigner des mots-clés. Après 
importation, vous commencez à 
travailler avec vos photos. LightRoom
gère directement les Raw, mais prend
également en charge les JPeg et les Tiff.

Une interface très claire
Par défaut, l’affichage s’effectue 
en mode Grille . Toutes les images
contenues dans le shoot ou la collec-
tion que vous avez sélectionné dans 
le panneau Library (à gauche) vous
sont présentées. Vous pouvez régler 
la taille des vignettes. Lorsque vous
survolez une image, vous effectuez
une rotation horaire ou anti-horaire 
et donnez une note quand bon 
vous semble. Pour visualiser une photo
en particulier, sélectionnez-la et 
double-cliquez dessus ou cliquez sur 
le bouton Loupe. Une fois affichée dans
ce mode, vous pouvez encore zoomer
dans la photo en cliquant une fois (un
second clic provoque un zoom arrière).
De même, vous recherchez des photos
par mot-clé ou en fonction d’une note.
Avec la touche [L], vous réduisez 
la lumière afin que l’interface s’estompe

(tout en restant totalement active) 
. Les images au centre sont ainsi

mises en valeur. Une sorte d’Exposé…
Un second appuie sur [L] fait disparaî-
tre l’interface . La touche [F]
permet d’escamoter la barre générale
de menus, puis la barre de menus
de LightRoom afin d’obtenir 
une visualisation modulaire et souple
jusqu’à la photo seule ou pour 
comparer plusieurs clichés . 
Notez aussi que la police utilisée dans
l’interface est d’une taille correcte.

Ajustements rapides
Le panneau Quick Develop
propose des ajustements simples : 
exposition, luminosité, contraste 
et saturation, réglage de la balance
des blancs (en choisissant parmi 
certains préréglages ou en fixant 
les vôtres). Adobe a aussi intégré 
des jeux de réglages prédéfinis. 
Vous travaillez image à image ou sur
une sélection d’images. Toujours 
dans Quick Develop, la possibilité 
de convertir les photos en niveaux 
de gris, de recopier des réglages 
effectués sur une photo sur d’autres
images, ou même de synchroniser 
un ensemble d’images. Ainsi, 
une modification apportée à l’une 
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d’elles sera répercutée sur les autres.
Vous avez accès aux informations Exif
données par l’appareil photo, vous
pouvez renseigner quelques champs
et donner une note (cinq étoiles maxi).

Développez vos photos
Il suffit de cliquer sur le bouton 
Develop, en haut à droite, pour bascu-
ler dans l’environnement de travail 
de l’image . L’interface comprend
au centre la photo traitée. À gauche, 
le panneau des jeux de réglages 
prédéfinis. À droite, l’ensemble 
des outils et réglages de l’image. 
En bas, vous pouvez facilement passer
d’une image à une autre, dans 
un shoot. Aucune de ces parties n’est
fixe. Vous pouvez les faire disparaître
pour donner plus d’espace à la photo,
et dans ce cas elles deviennent esca-
motables. Ces parties n’apparaissent
que lorsque vous approchez le curseur
sur le bord de l’écran correspondant.
Le panneau des outils comprend
l’histogramme en haut. En dessous,
vous avez accès grosso modo
à l’ensemble des réglages et outils
d’Adobe CameraRAW, souvent avec 
des noms différents (à noter toutefois
que certains fonctionnent très 
différemment de leur équivalent 

dans CameraRAW, à l’instar 
des courbes de tonalité). Un nouvel 
outil fait son apparition, le Split
Toning, pour travailler spécifiquement 
sur les parties éclairées/sombres
d’une photo. Aux amateurs de noir 
et blanc, Adobe LightRoom propose, 
en sus des jeux de préréglages, 
un outil particulier, le Grayscale Mixer.

Diaporamas et impressions
LightRoom propose encore deux 
environnements. Slideshow
assure la création de diaporamas, 
avec de nombreuses possibilités 
de sortie (notamment Flash). Print
permet de créer, tout comme dans 
Aperture, des planches-contacts, 
des livres, etc. Ce sont là deux parties 
qui méritent encore pas mal 
d’efforts de la part d’Adobe. 
Les performances? Je ne me pronon-
cerai pas sur une Beta, mais il est vrai
que j’ai pu travailler sans problème 
sur mon PowerBook G4 Alu 1 GHz/1 Go.
Comme le précisent des responsables
d’Adobe, «le produit n’est pas fini» :
de nombreuses autres fonctions sont
prévues. Cela dit, il s’agit d’un très bel 
outil qui concurrence de plein fouet
Aperture. Tant mieux, les deux logiciels
n’en seront que meilleurs.
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StickyBrain 4
SOHO Notes 5

PRISE EN MAIN

Une vraie gestion de documents

L
e mois dernier, Frédéric Blaison vous avait présenté DevonNote.
Quant à moi, je vous ai souvent parlé de DevonThink, son grand
frère. La gestion de documents est en effet un de mes dadas,

car mon métier m’oblige à gérer des milliers de fichiers de tous ty -
pes, contenant des infos qui me sont plus ou moins précieuses pour
concevoir le magazine, suivre des projets, rédiger des articles…
Outre l’application DevonThink Pro que j’utilisais jusqu’alors au
quotidien – j’ai délaissé tout traitement de texte afin de travailler
directement dans cette gestion de documents qui m’offre un édi-
teur de texte très complet, avec statistiques calculées en temps réel –,
et iViewMedia Pro pour mes éléments iconographiques, j’apprécie
beaucoup StickyBrain. Je stocke dans ce dernier de petites notes, voire
l’ensemble des numéros de série et autres clés d’accès nécessaires pour
tester tous les logiciels que VVMac reçoit – et que j’entretiens avec
rigueur. Autant de bases que je sauvegarde chaque jour sur mon iDisk.

Aussi, lorsque j’ai appris à la veille de Noël que StickyBrain était dé-
sormais passé en version 4, je me suis littéralement précipité sur le
site de Chronos, son éditeur. Croyez-moi, il s’agit bien d’une évolu-
tion qui justifie une mise à jour (25 $).

Tous les documents et fichiers!
Tout d’abord – et c’était pour beaucoup d’utilisateurs un vrai point
«noir» – StickyBrain 3 n’était pas très réactif, notamment à son
ouverture. Un problème que j’ai considéré pour ma part comme
annexe puisque mon Mac n’est jamais éteint et StickyBrain, comme
quelques autres applications, toujours présent en arrière-plan. Bonne
nouvelle, ce problème a disparu avec cette version 4 : l’ouverture
de ma base est même environ six fois plus rapide qu’auparavant et
mes recherches sont également instantanées. Si mon utilisation de
StickyBrain était jusqu’alors limitée, c’est parce que ce dernier n’ac-

PRIX : 40 $ pour StickyBrain 4 ; 
50 $ pour SOHO Notes 
ÉDITEUR : Chronos (www.chronosnet.com)
DISTRIBUTION : Internet
CONFIGURATION MINIMALE : Mac OS X 10.4.3

Cette version prend en charge avec efficacité tous les types de documents
et de fichiers, tout en intégrant nombre de technologies Mac OS X.
Cela dit, je préfère sa version multibase et multi-utilisateur, SOHO Notes.

+ L’interface utilisateur encore améliorée ; le support en interne ou par lien 
externe de tous types de documents et fichiers ; le support des technologies
Mac OS X ; le fonctionnement multibase et réseau de SOHO Notes.

- Malheureusement, pas de version française ; si le prix de StickyBrain 
ou de SOHO Notes est correct, celui des mises à jour est plus élevé.

1
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ceptait pas de prendre en charge tous les documents dont j’ai be-
soin pour travailler. DevonThink Pro est à ce niveau beaucoup plus
ouvert, mais StickyBrain 4 offre désormais la même souplesse et
intègre les technologies Apple de Mac OS X nécessaires à l’ouver-
ture directe de fichiers, tels que des URL , des archives Web ou
bien sûr les PDF . Les divers moyens d’ajouter de l’information
dans la base de données SQL (OpenBase) de StickyBrain ont été
par ailleurs optimisés. Spotlight est enfin supporté: une requête re-
trouve les documents dans la base OpenBase aussi facilement que
s’ils étaient classés dans un dossier du Finder. Ou comment avoir
le beurre et l’argent du beurre! Bref, vous avez compris que Sticky-
Brain 4 mérite toute votre attention si vous avez une problémati-
que de gestion similaire à la mienne. C’est le cas de nombreux pro-
fessionnels ou de particuliers qui gèrent de manière dématérialisée
leurs documents personnels et administratifs, d’autant plus sou-
vent que de plus en plus de formulaires sont échangés via Internet.

StickyBrain 4 offre même une gestion d’alarme: de quoi vous «son-
ner» lorsque votre passeport doit être renouvelé. Que lui manque-
t-il encore par rapport à DevonThink? Ce dernier offre un sys-
tème basé sur l’Intelligence artificielle (IA) pour organiser les docu-
ments, créer entre eux des associations qui dynamisent votre «base
de connaissances». Une fonction utile lorsqu’on a des milliers de
fichiers à gérer, à confronter…, mais qui concerne avant tout les cher-
cheurs et autres travailleurs du savoir. Même pour moi, Sticky-
Brain 4 est donc parfaitement suffisant. J’ai pu exporter toutes mes
bases depuis DevonThink Pro et les intégrer sans problème à Sticky-
Brain 4. En une heure de temps, j’ai ainsi reconstitué mon envi-
ronnement de travail. Je regrette cependant les fonctions de traite-
ment de texte plus complètes de DevonThink.Et si StickyBrain livre
des statistiques sur les documents (nombre de caractères, de mots…),
il ne le fait pas en temps réel. Enfin, il faut souligner que Sticky-
Brain 4 n’est disponible qu’en anglais. n Bernard Le Du

2
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StickyBrain accepte à peu près tout…

Vous pouvez toujours créer des «notes» , c’est-
à-dire des documents qui varient en termes 

de longueur et de présentation, du Post-it traditionnel 
au texte de plusieurs pages, avec tous les attributs 
typographiques qu’offre en standard l’environnement
Mac OS X (dommage que les développeurs ne soient pas
encore allés jusqu’à intégrer complètement TextEdit). 
Ces notes peuvent tout à fait contenir des images. 
Dans sa version 4, en revanche, StickyBrain propose 
en plus des «fiches» dédiées à la gestion de sept 
nouveaux types d’objets . La fiche Bookmark permet
de stocker des URL et assure l’affichage au vol de la page
Web ainsi que la navigation. Pas la peine d’aller dans 
Safari ou un autre navigateur si vous voulez juste 
consulter. La fiche Web Archive fonctionne de la même
manière. La fiche PDF permet de référencer dans 
votre base de données des documents PDF et de les lire

directement grâce à quelques outils dédiés. C’est plus
sommaire qu’Aperçu, mais largement suffisant là encore.
Les fiches Image, Movie et Audio ont des noms explicites.
Dommage que chaque fiche ne puisse contenir qu’un seul
objet. Il n’est pas possible de créer une fiche « Week-end 
à Étretat » qui contiendrait les vingt photos importantes
que je veux absolument conserver. Pour cela, il faut 
«ouvrir» un dossier et y créer les vingt fiches 
individuelles. Enfin, la fiche File vous autorisera à ranger
dans la base tout autre type de document. Il est aussi 
important de noter que, selon les types de documents ou
de fichiers, vous avez parfois le choix d’intégrer l’élément
lui-même (par exemple un PDF) à la base de données 
ou seulement sa référence (son chemin). Dans ce dernier
cas : en cas de déplacement ou de suppression, 
StickyBrain dit que le fichier n’est plus disponible. À vous
de gérer le problème.

4
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Outre le fait de pouvoir stocker dans Sticky-
Brain 4 tous les documents qui vous 

servent dans le cadre de votre travail 
ou dans celui de votre vie (notamment tous 
vos courriers, déclarations et autres 
documents administratifs), il vous offre grâce
à l’intégration des technologies de Mac OS X
la possibilité d’y accéder au vol le plus 
naturellement du monde, sans avoir à ouvrir
systématiquement d’autres logiciels. Pour cela,
StickyBrain 4 met en œuvre des «versions 
limitées» du Webkit et du PDFkit . 
Ce qui signifie que vous disposez dans 
l’interface même du logiciel d’un mini-Safari
et d’un mini-Aperçu. J’aurais aimé avoir sous
la main un tout petit peu plus de fonctions,
mais il est vrai que si je veux exploiter 
plus complètement un document, je peux 
l’ouvrir d’un clic dans une autre application.
Une autre intégration bienvenue est Spotlight.
Cela signifie que tout ce que vous intégrez 

à la base de donnés de StickyBrain reste 
totalement accessible à partir du Finder grâce
à Spotlight . Vous bénéficiez donc 
d’une architecture d’organisation dans 
une puissante base de données OpenBase,
tout en conservant une complète visibilité.

7
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… et intègre les grandes technologies Apple
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PRISE EN MAIN

StickyBrain 4 ne gère qu’une seule
base, ce qui ne constitue pas un gros

problème car OpenBase (sur lequel 
il s’appuie) est capable de gérer 
des milliers de documents et d’objets.
Dans de nombreuses situations, 
il serait tout de même très pratique 
de créer différentes bases pour 
séparer le professionnel du personnel,
gérer plus facilement des bases 
pour chacun de vos grands clients,
ou tout simplement soulager 
des collections de photos, de films 
ou de fichiers devenues trop lourdes.
L’éditeur Chronos offre toutefois une
solution, SOHO Notes, qui n’est rien
d’autre qu’une version de StickyBrain
4 dotée de fonctions réseau supplé-
mentaires. C’est exactement le même

produit : même interface, mêmes 
fonctions, même format de stockage
de notes, documents et objets multi-
média… Avec SOHO Notes, pour 
seulement 10 $ de plus (donc 50 $), 
je crée autant de bases que je veux,
en local ou en réseau, et je peux gérer
différents utilisateurs. Et si je crée 
des bases dont je me désigne 
seul utilisateur , cela revient 
à jongler avec plusieurs bases que
j’ouvre et ferme selon mon travail,
mes besoins. Mieux encore, comme 
je peux «monter» simultanément 
plusieurs bases dans SOHO Notes, rien
ne m’empêche de déplacer par glisser-
déposer des documents d’une base
dans une autre, ce que je ne peux pas
faire avec DevonThink Pro…

8

SOHO Notes, un StickyBrain 4 en version multibase et multi-utilisateur

SOHO Organizer: de bonnes idées mal «ficelées»

E
n même temps que StickyBrain 4, l’éditeur Chronos renou-
velle son offre «gestionnaire d’informations personnelles» en
lançant SOHO Organizer, davantage destiné aux petits grou-

pes de travail qu’aux particuliers puisqu’il fonctionne en réseau. Pour
100 $, outre SOHO Notes (évoqué juste au-dessus), vous bénéfi-
cierez d’un gestionnaire de contacts, un gestionnaire d’événements
et d’un outil d’impression de documents. Le tout s’intègre plus ou
moins. Une nouvelle solution, intéressante sur le papier…, mais j’ai
dû un peu déchanter car il existe encore quelques bogues et cer-
taines fonctions bizarrement «fichues».
SOHO Contacts utilise de manière transparente la base de noms
de Carnet d’adresses. Son «plus»? Vous attachez à un contact
des notes, des fichiers et des événements et enregistrez des ap-
pels téléphoniques entrants et sortants ou envoyez des SMS .
Pas mal! Las, avec mes deux téléphones BT pas très récents (Sony
Ericsson T39i et P800), le passage en mode Bluetooth bloque le
logiciel ou provoque une erreur Bluetooth. 

Le module SOHO Calendars est quant à lui un peu bizarre. Son
seul mode de travail est un affichage en liste . Pourquoi pas…
Mais impossible de trouver le moindre champ de recherche: re-
mettre la main sur un événement est un vrai casse-tête! De plus,
iCal offre déjà un mode liste associé à une puissante recherche.
Et pour l’affichage par jour, mois ou année, SOHOCalendars ou-
vre automatiquement… iCal! SOHO Organizer ne sert vraiment
à quelque chose que si on l’utilise en réseau, pour un petit groupe
de travail. Enfin, Print Essentials imprime toute sorte de docu-
ments standardisés et fonctionne avec des packs d’extensions ven-
dus par Chronos. Le problème est qu’il n’est pas internationa-
lisé et n’offre que des formats de papier, d’étiquette et autre dis-
ponibles aux États-Unis. n Bernard Le Du
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Si vous recherchez un système de stockage de faible capacité 
et petit encombrement, ce disque de 1” en 4 ou 8 Go fera l’affaire,
d’autant plus que son coût est très intéressant.

LaCie Carte Orange
www.LaCie.com/fr

Mini-disque dur de poche

N
on, cette Carte Orange n’est pas une bête carte mémoir e !
C’est un véritable disque dur, un tout petit dis-
que d’une taille de 1”, de marque Seagate, tour-

nant à 3600 t/min et doté d’une cache de 2 Mo. Au
final, on obtient un objet minimaliste, de la taille exacte
d’une carte de crédit. Avec son poids plume de 56 g,
je peux donc l’emmener partout dans ma poche de
chemise, mais pas dans mon portefeuilles, car la carte
présente tout de même une épaisseur de 6 mm.
La Carte Orange existe en version 4 ou 8 Go (un
volume qui n’est pas encore disponible sous forme
de clé Flash dans le commerce). À la rédaction
de VVMac, nous avons eu en main la version 8 Go. 
Ce disque dur n’a pas besoin d’être alimenté : il tire son énergie
du port USB 2.0 sur lequel je le branche grâce à son cordon de 2 cm
et son connecteur USB. Pour le transport, le connecteur se range
tout simplement dans l’espace en plastique qui lui est réservé et qui
entoure le disque dur. Il y est bien maintenu.Si vous avez besoin d’une

rallonge, un câble USB de 62 cm est fourni avec la carte. Son utili-
sation est exactement la même que pour un disque dur traditionnel et

il monte tout seul sur le Bureau. Reste à savoir si d’un point
de vue économique, cette technologie miniature est
compétitive par rapport à d’autres supports. 
Les versions 4 et 8 Go reviennent respectivement
à 27,5 € et 18,6 € le Go. Les clés USB offrent des
capacités plus petites, même si on en trouve à 4 Go,
mais elles s’avèrent hors de prix: comptez de 60 €
à 90 € le Go. Si l’on se tourne vers des disques

durs 1,8” ou 2,5”, les capacités augmentent et le prix
au Go chute, mais on perd tout l’intérêt du format

«carte de crédit». Et un iPod Nano? Ce dernier est
presque trois fois plus cher et c’est avant tout un lecteur

musical. Bref, à 119 € les 4 Go – ou bien plus intéres-
sant encore, à 159 € les 8 Go, ce qui en fait le produit

de ce type le moins cher du marché –, la Carte Orange de LaCie 
séduira nombre d’utilisateurs, surtout les monades. n Alain Lalisse
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Apple iPod 5G 30 Go
Palm LifeDrive

PRISE EN MAIN

Vidéo et plus en poche

C
omparer un assistant numérique per-
sonnel et un baladeur MP3, voilà qui
peut sembler curieux ! Pourtant, les

évolutions qu’ont récemment connues
les gammes iPod et Palm contri-
buent à les rapprocher. En in-
tégrant une fonction de
lecture vidéo dans sa
cinquième géné-
ration d’iPod,
Apple a ajou-
té une cou-
ronne très at-
tendue au roi
des baladeurs,
tandis qu’avec le Life
Drive, Palm est le pre-
mier fabricant à proposer un
PDA embarquant un disque dur en
standard. Un écran, un disque dur, une prise
casque et des logiciels intégrés : pas besoin
de plus pour écouter paisiblement de la mu-
sique en balade ou regarder des vidéos dans
les transports en commun! 
Toutefois, les deux appareils n’usent pas des
mêmes armes. Taille, poids, écran, possibili-
tés de communication, richesse fonction-
nelle…: il s’agit bien là de deux matériels qui
offrent certaines utilisations similaires, mais
ne jouent pas sur le même terrain.

Accessoire du Mac
L’iPod est un périphérique passif d’un ordi-
nateur Mac ou PC sans lequel il ne sert qua-
siment à rien puisque tout passe par iTunes.
Son écran n’est pas tactile et vous ne pouvez
pas saisir des infos en direct (tout ce qu’il
contient provient de l’ordinateur auquel il
est «associé»). Le bon côté de la chose est
une intégration parfaite et poussée avec Mac
OS X et l’iTunes Music Store. Il a aussi un
avantage de taille: son disque dur offre 30 Go
et même 60 Go dans le modèle haut de gam-
me. À son bénéfice encore, le support des
podcasts vidéo, mais il refuse le format DivX
en standard alors que le Palm s’en tire bien!
Enfin, comme tout iPod, c’est un objet culte. 

Un ordinateur complet
Le LifeDrive, lui, est avant tout un ordi-
nateur de poche complet. Il est donc bien
plus autonome par rapport à votre Mac que 

l’iPod. Certes, Palm OS n’a pas profon-
dément évolué depuis des années, mais fina-
lement, il «assure» plutôt bien, même sur un
appareil fort en fonctions multimédia comme
le LifeDrive. Alors que l’iPod ne connaît que
l’USB pour se relier au monde extérieur, le
LifeDrive est très communicant: USB, bien
sûr, mais aussi un support de Bluetooth et
de Wifi! Un téléphone mobile et un LifeDrive
et vous voilà connecté à Internet! Son écran
est tactile et, comme sur tous les Palm, vous
entrez des informations grâce au stylet ou
au clavier virtuel. Vous disposez d’une fabu-
leuse panoplie de logiciels de tous types et,
au besoin, vous partagez des fichiers avec vo-
tre Mac. En revanche, il est plus gros et plus
lourd que l’iPod bien qu’il ne propose qu’un
disque de 4 Go (comme l’iPod Nano): un peu
léger pour un outil multimédia (le support

des cartes SD
est intéressant,

mais certainement
pas suffisant)! 

L’iPod et le LifeDrive coûtent chacun moins
de 400 € et assurent une autonomie équiva-
lente. Comme ils sont très différents tout de
même, difficile de trancher et de dire que l’un
est le meilleur. Cela dépend vraiment de l’uti-
lisation que vous comptez en avoir. Si l’ac-
cès à Internet et la saisie d’informations sur
l’appareil de poche sont des priorités et que
vous voulez vraiment profiter des vidéos
en balade, le LifeDrive est plus intéressant.
En revanche, si la musique est primordiale
pour vous et que visionner des films sur un
très petit écran dans un taxi suffit à vous com-
bler, l’offre d’Apple devrait vous satisfaire.

n Jean-Christophe Vignes

A priori, ces deux matériels de poche n’appartiennent pas à la même classe.
Pourtant, ils offrent des fonctions multimédia et se connectent 
au Mac pour échanger des fichiers. De quoi hésiter au moment de l’achat?

+ Le design très fin ; l’écran est petit, mais d’excellente qualité ; un espace disque de 30, voire 
60 Go ; la gestion et la synchronisation de la musique, de la vidéo et des autres données avec 
un seul logiciel : iTunes ; l’iTunes Music Store ; le support de la vidéo et de la projection sur TV.

- L’abandon du FireWire ; peu de vidéos prêtes à être consommées (notamment en France) ; 
un processus de conversion vidéo laborieux.

PRIX : 325 €
FABRICANT : Apple (www.apple.com/fr)
DISTRIBUTION : Apple Store, réseau Apple, magasins d’informatique 
et de loisirs numériques
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Dire que la lecture de films sur l’iPod était 
une fonction attendue est un euphémisme! 

Pourtant, Apple ne s’est pas contenté de mettre 
à jour les modèles existants (les iPod «photo» 
peuvent parfaitement lire des vidéos en utilisant 
une version spécifique de Linux!), mais il a conçu 
un nouvel appareil avec un écran plus grand, 
d’une résolution de 320 x 240 pixels, et surtout une
«boutique vidéo» intégrée à l’iTunes Music Store. 
Hélas, l’iPod ne reconnaît que deux formats vidéo. 
Si le petit nouveau H.264 propose une excellente 
qualité d’image pour des fichiers de taille réduite, 
il y a encore fort peu de contenus disponibles pour 
en profiter. Quant au MPeg-4, il s’agit du format 
«officiel», pas du DivX, certes préféré des réseaux

P2P, mais surtout très largement répandu et pour 
lequel le plus grand nombre de vidéos circulent… 
De plus, si les utilisateurs américains bénéficient 
des dernières séries à un prix modique sur le nouvel
iTunes, les Français – faute de droit d’exportation –
doivent se contenter de bandes-annonces. Frustrant!
À défaut de trouver des vidéos toutes prêtes, 
il faut donc passer par un processus de conversion
assez lourd et lent, heureusement simplifié 
grâce à nombre de petits utilitaires comme iSquint

, un freeware qui s’appuie sur des librairies open
source (www.isquint.org).
Soyons juste, le Life Drive ne gère pas plus le format
DivX en standard. En revanche, il bénéficie 
de toute la logithèque Palm, extrêmement riche, 
et notamment de l’excellent et gratuit TCPMP (http://
tcpmp.corecodec.org) grâce auquel le LifeDrive 
que nous avions en test a lu sans broncher des DivX,

MPeg-1, MPeg-4 et même
des vidéos Ogg-Vorbis, 
le format open source,
et ce, sans qu’aucune
conversion préalable
ne soit nécessaire!
C’est un avantage 
de poids du Palm pour
quiconque possède
déjà des vidéos sur
son ordinateur… Enfin,
même si l’iPod dispose
d’un très bon écran, 
le LifeDrive en possède un magnifique et près 
de deux fois plus grand! Sur ce terrain, le LifeDrive
est donc à l’évidence un bien meilleur choix, même si
son disque dur s’avère sous-dimensionné pour satis-
faire un cinéphile vorace ou un téléphage acharné.

1

Vidéo : le LifeDrive est plus flexible

Si l’on s’arrête au hardware, le LifeDrive a de quoi séduire :
prise casque au format Walkman – complétée par 

un casque Philips dans une opération spéciale qui pourrait
être prolongée jusqu’au printemps –, et haut-parleur 
qui permet de partager sa musique sans accessoire. 
Là encore, la richesse de Pam OS et de l’environnement 
ouvert fait qu’on peut choisir son lecteur musical 
– le standard ressemble, un comble, à iTunes! – sans être 
limité aux MP3 et AAC! Malheureusement, le LifeDrive n’est
compatible avec aucun système de DRM et l’ensemble des 
magasins de musique en ligne lui est donc fermé. À l’opposé,
l’iPod s’appuie bien sûr sur l’iTunes Music Store, le premier
d’entre eux. Il bénéficie aussi d’une galaxie d’accessoires 
dédiés qui permettent de le transformer en vraie chaîne 
hi-fi, de l’intégrer à sa voiture… iTunes est aussi un excellent 
logiciel non seulement de gestion, mais encore d’interaction
avec le Mac et le PC. Le LifeDrive ne peut pas rivaliser ! 

Musique : l’iPod reste leader

L’iPod a été conçu pour fonctionner 
en complète symbiose avec 

un ordinateur. Le dernier modèle s’appuie
encore davantage sur iTunes qui lui permet
d’embarquer de la musique, des photos
(avec iPhoto) , des rendez-vous (iCal) 
des contacts (Carnet d’adresses), 
et désormais de la vidéo. Si vous avez 
un Mac «USB 2», vous bénéficiez 
d’un transfert rapide… Dommage que l’iPod
5G abandonne complètement le FireWire 
(il est donc difficilement utilisable sur les Mac 
de plus de trois ans). A contrario, le Life-
Drive bénéficie de Palm Desktop pour 
les données d’agenda et de contacts.
Un peu vieux jeu, certes, mais gratuit. 
Il accueille aussi des documents Office (Word, Excel) grâce à DocumentsToGo (fourni en standard) : 
ce n’est pas ce qu’on demande à un iPod, bien sûr, mais cela peut servir ! Côté multimédia, on peut
aussi copier « à la main» le contenu en montant le Palm comme un disque dur dans le Finder : pas
vraiment de synchronisation, mais cela marche très bien. Toutefois, sur ce terrain, la palme revient 
à l’iPod, sauf si vous êtes prêt à rajouter 40 $ pour acquérir The Missing Sync for Palm OS 5 
de Mark/Space , un outil qui s’est rendu indispensable au fil du temps. Vous accédez alors 
à une synchro de même niveau que ce qu’apporte le couple iSync-iTunes. Qui plus est, via Bluetooth
éventuellement, mais surtout WiFi (AirPort), plus besoin de câble pour relier le tout !

3
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Une bonne intégration avec le Mac

+ Un ordinateur de poche complet, avec toutes les fonctions PDA ; la saisie directe 
des informations ; accès à la logithèque Palm OS ; connexions USB, BT et WiFi ; le support 
de nombreux formats vidéo dont le DivX.

- Un petit disque de 4 Go et une moins bonne intégration à Mac OS X sans recours à un utilitaire
tiers ; plus encombrant ; pas de support de musique en ligne.

PRIX : 375 €
ÉDITEUR : Palm (http://euro.palm.com/fr/fr/products/lifedrive/)
DISTRIBUTION : Boutique Palm sur Internet, magasins d’informatique
ou de loisirs numériques.
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PRISE EN MAIN

Vous voulez imprimer des étiquettes en petite série 
ou à la demande? Une imprimante spécialisée 
comme cette SLP de Seïko devient un investissement justifié.

Ouvrez des maquettes 
XPress 6.5 dans InDesign CS 
en toute simplicité.

Seïko SLP 420
www.siibusinessproducts.com

Markzware’s Q2ID
www.xchangefr.com

Étiquettes à la seconde

P
our tirer quelques étiquettes ou réaliser des badges personna-
lisés à l’entrée d’une conférence, rien de plus simple et de plus
sûr qu’une petite imprimante SLP utilisant une

technologie thermique directe, sans ruban encreur
ni cartouches. Ce sont ici les étiquettes Seïko qui s’avè-
rent spéciales. Il en existe de tous les formats pour
le courrier, les dossiers, les cassettes vidéo, etc., en blanc
ou en couleur. C’est certes un peu plus cher que des
planches entières, mais il faut se souvenir qu’imprimer
en plusieurs fois sur une planche relève de la haute vol-
tige. Souvent, c’est toute la planche qui finit ainsi à la
corbeille. Et puis, il n’y a pas de dépense d’encre…
Livrée avec un logiciel pour Mac OSX, la SLP se con-
necte sur votre port USB. L’installation est simplissime
et j’imprime ma première étiquette en 2/3 sec ! Toute-
fois, maîtriser toutes les possibilités du logiciel prend un
peu plus de temps. La documentation papier est symbolique et
mieux vaut se reporter à l’aide en ligne. L’interface est bien… quand
on l’a comprise! Il faut tout d’abord créer un modèle d’étiquette avec
les outils Texte (polices, taille…) et Image (pour ajouter un logo ou
une photo). Le logiciel gère aussi les cadres et les codes à barres. Les
champs que vous lui indiquez serviront de balises pour le remplissa-
ge automatique ou la saisie manuelle. Évitez donc les espaces (écri-
vez «Codepostal» et non «Code postal»). Enregistrez les modèles
pour une utilisation ultérieure. Ensuite, le mode Expert génère les éti-
quettes. Vous importez les adresses depuis votre Carnet d’adresses,

Entourage ou un fichier texte tabulé avec, en guise
de première ligne, les balises d’en-tête précédemment défi-

nies. Il suffit de cocher un ou plusieurs contacts pour imprimer 
illico les étiquettes correspondantes. La saisie manuelle permet de créer
des étiquettes au vol. Je n’ai malheureusement pas trouvé de moyen
d’exporter les nouvelles données. Passée la phase d’apprentissage, cette
imprimante (distribuée par Theta Scan, Misco, Ebizcuss…) vous ren-
dra vraiment de grands services. À 109 €HT, ce n’est pas cher, d’au-
tant qu’il n’y a pas à se préoccuper de l’encre. Les étiquettes s’ac-
quièrent en bobine chez les revendeurs Seïko. Tout est fait pour fa-
ciliter son utilisation au bureau. n Alain Lalisse

Conversions efficaces

M
arkzware, éditeur de solutions PAO, vient de commercialiser
un nouveau plug-in qui va vite devenir fort utile pour tout gra-
phiste freelance ou studio. Depuis l’arrivée d’InDesign, le mar-

ché se trouve en effet partagé entre deux logiciels, d’où d’inévitables
problèmes de conversion. Si InDesign CS/CS2 est capable d’ouvrir
les fichiers XPress 4, il s’agit juste d’un «truc» pour faciliter la migra-
tion. La conversion opérée ne produit pas un fichier «nettoyé», d’où
un gros travail pour éviter des soucis au flashage. De l’autre côté, Quark
ne fournit pas d’export vers la version 4 depuis XPress 6.5. Avec
Q2ID, Markzware présente un plug-in pour InDesign CS/CS2 qui
assure la conversion dans InDesign de tout fichier XPress version 3.3,
4.1, 5.0, 6.0/6.5. Cela évite le laborieux détour par XPress 4 via
un XPress 5 ! Lors de la conversion, l’ensemble des éléments de la
mise en page XPress est reproduit avec fidélité, du contenu aux
calques. Lors de mes tests, une ou deux pages ont manifesté quelques
ralentissements lors de la conversion et présenté quelques erreurs à

l ’ impor t de
blocs ronds. Le
gain de temps
reste cependant
énorme et ce
plug-in est la
bienvenue. Le
support est assez réactif et n’hésite pas à proposer des mises à jour.
Dans le même ordre d’idée, l’Xtension ID2Q permet de récupérer
des éléments InDesign 1/2 dans XPress 4/5. Elle va être mise à jour
courant janvier, avant le salon Intergraphics, et proposera la lecture
des fichiers InDesign CS et CS2 directement dans XPress 6.5. La bou-
cle sera alors bouclée. Signalons également un module d’import de
fichiers PageMaker dans XPress, sans oublier les outils de contrôle
avant flashage Flighcheck Pro et Flighcheck Studio. Q2ID est dis-
tribué par XChange au prix de 199 € HT. n Frédéric Sanuy
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Plug-in Akvis

PRISE EN MAIN

Des plug-in intéressants, mais coûteux

PRIX : de 50 à 100 $ selon le plug-in. La collection 
complète Akvis Alchemy est vendue 250 $.
ÉDITEUR : Akvis (www.akvis.com) DISTRIBUTION : Internet
CONFIGURATION MINIMALE : Mac OS X, Photoshop (depuis 
la version 5+), Photoshop Elements, GraphicConverter X 5.6+.

Dans la grande foire des plug-in, où le meilleur côtoie souvent 
le pire, j’ai découvert la suite de plug-in Akvis qui sortent un peu du lot
avec leurs fonctions plus utilitaires qu’artistiques.

+ Les plug-in Retoucher, Chameleon et Coloriage sont vraiment intéressants 
et efficaces ; interface sans prise de tête et en français ; site Web 
en français avec des exemples de mise en œuvre ; bonne documentation.

- Certains plug-in n’apportent pas grand-chose de plus que les outils proposés
par les logiciels comme Photoshop ; le prix de chaque plug-in est assez élevé.

Enhancer renforce les détails d’une image dans les zones
surexposées ou sous-exposées ainsi que dans les tons

moyens. Il combine les effets d’une commande telle que 
Tons foncés/Tons clairs et ceux d’un filtre de renforcement,
la simplicité d’utilisation en plus. Pour tester ce plug-in, 
j’ai utilisé une photo d’extérieur dont les détails étaient
noyés dans une brume hivernale et dont le contraste laissait
à désirer. En exploitant Enhancer avec ses réglages par 
défaut, j’ai récupéré un bon niveau de contraste et l’image 
a gagné en piqué . Lorsqu’on active le «filtre» 
Enhancer, vous obtenez une fenêtre autonome qui affiche 
la photo corrigée avec les réglages par défaut. Dans la partie
supérieure, deux onglets permettent de visualiser 
la photo avant et après correction. Si le résultat ne vous
convient pas, vous accédez dans la partie droite à une série
de réglages à l’aide desquels vous ajustez les corrections:
quantité de détails, plages de tons et intensité.

3
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L
a suite de plug-in proposée par Akvis est composée, d’une part,
de trois plug-in dédiés à la correction et à la retouche d’image:
Enhancer pour renforcer les détails dans les zones sombres ou

surexposées, Retoucher pour réparer un cliché abîmé, et Stamp pour
effectuer des opérations de maquillage plus importantes. D’autre
part, deux plug-in sont dédiés à la création : Chameleon qui sim-
plifie l’incorporation d’une sélection dans un montage, et Colo-

riage qui colorise une image en
niveaux de gris (ou colorie une
image couleur). Avant de voir
plus en détail ce que proposent
ces différents plug-in, disons
deux mots de leur installation.
Chaque plug-in téléchargé se
présente sous la forme d’un fi-
chier .dmg qui contient un ins-
talleur standard Mac OS X.Il
suffit donc de lancer l’applica-
tion d’installation et, en fin de
parcours, d’indiquer le dossier
dans lequel copier le plug-in.
Si vous utilisez Photoshop Ele-

ments, vous indiquerez le dossier Adobe Photoshop Elements 3 >
Plug-ins ; si vous exploitez Photoshop CS, vous sélectionnerez le dos-

sier Adobe Photoshop CS > Modules externes. Après redémarrage
de votre application, vous retrouverez les différents plug-in dans le
sous-menu Filtre > Akvis . Attention, lors de la première utili-
sation de chaque plug-in, une boîte de dialogue vous demandera d’ac-
tiver la licence d’évaluation ; vous devrez pour cela disposer d’une
connexion Internet.
Sur le papier, la suite de plug-in Akvis est séduisante. Elle propose en
effet cinq produits en français compatibles avec Photoshop CS et
Photoshop Elements (ainsi que GraphicConverter X sur Mac et
PaintShop Pro ou Corel PhotoPaint sur PC). Côté prix, l’offre est
en revanche nettement moins percutante. Ce sont là des outils pour
les professionnels ou les passionnés qui en ont les moyens.
Après ces considérations bassement matérielles, voyons plutôt l’as-
pect utile du produit. Si l’on peut se passer de Enhancer et de Stamp,
qui n’apportent rien de bien révolutionnaire par rapport à ce que
proposent Photoshop CS et Photoshop Elements, le plug-in Retou-
cher est en revanche d’une efficacité redoutable et constitue un bon
investissement si vous avez décidé de vous lancer dans la restauration
des albums photo de votre famille. Du côté de la création, Chame-
leon est une solution intéressante pour ceux qui souhaitent faire du
photomontage, mais n’ont aucune envie de se battre avec les masques
de fusion et autres calques de réglage. Quant à Coloriage, sa prise
en main n’est pas très intuitive, mais il s’avère excellent pour colo-
riser de vieux clichés en noir & blanc. n Mathieu Lavant

1

1

2Renforcez une image

3
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Akvis nous propose avec Retoucher un automate
de nettoyage pour la restauration de vieux 

clichés. Il supprime les rayures, poussières et petits

accrocs sur une ou plusieurs zones de l’image 
préalablement sélectionnées. Pour le tester, j’ai mis 
à contribution une vieille photo de famille avec 
son lot de poussières, tâches et rayures, dans 
laquelle j’ai sélectionné les zones à corriger à l’aide 
du lasso. Après nettoyage, la photo a retrouvé 
une seconde jeunesse . Lorsqu’on choisit 
Retoucher, Photoshop Elements ou Photoshop 
ouvre une interface qui affiche la photo à corriger.
Les zones sélectionnées de l’image, avant d’activer 

la commande, s’affichent sous un masque rouge
semi-opaque . Il ne vous reste plus alors 
qu’à lancer le nettoyage en cliquant sur le bouton
vert, sis dans la partie supérieure de l’interface.
En pratique, la sélection préalable de toutes 
les pétouilles à corriger est un peu laborieuse.
Si vous utilisez Photoshop, vous aurez intérêt 
à effectuer ces sélections en mode Masque, car
vous gagnerez du temps. Si vous travaillez avec 
Photoshop Elements, effectuez ce travail préliminaire
avec le mode Masque de l’outil Forme de sélection.
Stamp est pour sa part un tampon de clonage 
pour la retouche et la duplication de portions
d’image; il s’apparente à l’outil Correcteur
de Photoshop et Photoshop Elements. Il adapte 
automatiquement la portion d’image clonée 
à son nouveau contexte, d’où des retouches sans 
raccords visibles. Lorsque vous lancez Stamp
à partir du menu Filtre, la photo à retoucher s’affiche
avec, en haut, une mini-palette d’outils comprenant
une Loupe et une Main pour ajuster la taille 
et la position de la zone à corriger, le Tampon
et ses réglages, ainsi qu’une Gomme .
En pratique, la commande Stamp s’utilise comme
l’outil Correcteur avec un petit «plus»: un mode 
Édition qui permet de ne pas fusionner 
immédiatement la portion d’image clonée. Vous avez

alors accès à l’outil Gomme et ajustez la zone 
à corriger. Cette fonction pourra vous être utile 
si vous utilisez Stamp pour cloner des éléments 
de grande dimension (personnages ou autres).

7

6

54

Retouchez une photo
4
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7

Chameleon propose une solution 
simple à l’intégration de sélections

dans un photomontage en fusionnant
l’élément collé avec les couleurs 
de l’arrière-plan. En pratique, vous com-
mencerez par copier-coller la sélection
dans votre document de montage avant
d’activer le filtre Chameleon qui procède

alors à une fusion des teintes et affiche
le résultat sans autre intervention 
de votre part . Ce filtre ne fait pas 
de miracle, mais si vous exploitez 
deux photos aux fonds relativement
homogènes, vous obtiendrez un résultat
convainquant, surtout si vous n’entendez
rien aux réglages des calques et modes
de fusion. Ici, j’ai utilisé un coucher 
de soleil, puis j’ai effectué une sélection
au lasso sur les bateaux d’une seconde
photo que j’ai collée dans le document 
de montage. Chameleon propose aussi,
via les commandes Take snapshot 
et Use snapshot, une fusion complète
des deux images en faisant apparaître 
la texture d’arrière-plan à travers 
la sélection que vous aurez collée.

8
Coloriage sert à coloriser 

une image en niveaux de gris et
à colorier une image en couleurs. 
Au-dessus de l’image à colorier, vous
avez une barre d’outils et deux 
onglets pour visualiser la photo
avant et après le travail. À droite,
l’indispensable palette de couleurs
ainsi qu’une série de nuanciers de
teintes prédéfinies pour les portraits
(cheveux, yeux, peaux…) ou 
les paysages (ciel, nuages, arbres,
feuilles…). Pour procéder à la mise
en couleurs d’une photo en niveaux
de gris, convertissez-la d’abord 
en mode RVB, puis à l’aide de l’outil
Crayon, définissez grossièrement 
le contour de chaque objet à colorier

en utilisant la couleur que vous
souhaitez appliquer. Il ne vous reste
plus qu’à lancer la colorisation 
en cliquant sur le bouton vert 
de la barre d’outils . Pour tester
Coloriage, j’ai choisi une photo 
de poivrons dont les contours
étaient bien définis afin de faciliter 
la tâche du filtre. J’ai dû parcourir 
le mode d’emploi (très bien conçu), 
car la mise en œuvre n’est pas très
intuitive. Quelques coups de crayons
ont suffi pour produire ce résultat.
Vous noterez au passage que si vous
n’avez pas défini de couleur pour
certaines zones de l’image, ces der-
nières seront par défaut colorisées
avec la couleur de la zone voisine.

10

9

Colorisez et coloriezPhotomontez
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PRISE EN MAIN

Ce bouquet de dictionnaires, que vous composez au choix, 
est disponible à tout moment dans Mac OS X et complète en parfaite
symbiose les célèbres outils de vérification ProLexis.

Myriade 3.1

Un beau bouquet de dictionnaires

N
ous connaissons tous Diagonal, un édi-
teur historique sur plateforme Mac et
développeur d’une ligne d’outils d’aide

à la rédaction connue dans tout le monde
francophone, ProLexis. Des outils particu-
lièrement fiables, et surtout dotés d’une pro-
digieuse rapidité d’analyse. Ils s’intègrent à de
nombreux logiciels, notamment destinés aux
professionnels de la presse écrite et de l’édi-
tion, mais également accessibles de moult fa-
çons dans presque tous les logiciels Mac OS
X. Diagonal propose cependant une seconde
ligne de produits, moins connue que ProLexis,
mais très intéressante et fort bien conçue, My-
riade, proposée en version 3.
Dans sa configuration complète, Myriade est
composée de quatre dictionnaires de lan-
gue française (Définitions, Synonymes, Conju-
gaisons et Grammatical), trois dictionnai-
res thématiques (Médical, Juridique et Locu-
tions latines), deux ouvrages géographiques
(Atlas mondial et Communes de France),
des dictionnaires de traduction mot à mot (et
brèves expressions idiomatiques) entre le fran-

çais, l’anglais et l’espagnol. Enfin, cette ver-
sion 3 propose en standard, quels que soient
vos autres choix, un ensemble de jeux de let-
tres et d’outils pour résoudre des mots croi-
sés, mots fléchés, anagrammes et autres gril-
les magiques … Vous composez votre bou-
quet de dictionnaires comme vous le souhai-
tez. Vous pouvez ainsi être intéressé, de par
vos activités professionnelles, aux dictionnai-
res Myriade Juridique et Locutions latines,
pas du tout au Myriade Médical.
Le logiciel de consultation Myriade 3 et ses
dictionnaires s’installent indépendamment
des outils ProLexis de vérification ortho-
graphique et grammaticale. On accède aux
ouvrages par une icône de la barre des me-
nus, donc toujours disponible. Si vous utili-
sez également ProLexis ou Le PetitProLexis,
ces derniers accéderont de manière trans-
parente aux bases de données de la plupart
des dictionnaires Myriade. Ainsi, ProLexis

saura corriger les noms de communes de Fran-
ce, les citations latines ou les termes juridi-
ques ou médicaux, selon les dictionnaires My-
riade que vous possédez.
L’autre point fort de Myriade est, selon moi,
sa recherche avancée qui travaille sur l’en-
semble des dictionnaires installés. Myriade
affiche dans une seule fenêtre , avec un
système de flèches et de liens hypertextes, tou-
tes les réponses, avec en regard de chacune le
symbole correspondant au dictionnaire dans
lequel elle a été trouvée. Il s’agit donc d’un
corpus encyclopédique immédiatement dis-
ponible. Vraiment très pratique…
Les jeux de lettres étaient déjà au rendez-vous
du Petit ProLexis et sont les bienvenus dans
Myriade. C’est une excellente manière d’en-
richir votre vocabulaire, et lorsque vous pei-
nez sur un article ou un mémo, il n’y a rien
de mieux pour vous délasser l’esprit que de
remplir une petite grille… n Bernard Le Du

3

2

1

+ La richesse des informations ici compilées et la simple élégance de l’interface 
de consultation ; l’intégration à Mac 0S X ; la possibilité de n’acheter que les dictionnaires
dont on a vraiment besoin, et d’en installer éventuellement d’autres plus tard ; la fenêtre 
de Myriade 3.1 est enfin redimensionnable ; la recherche avancée multidictionnaire ; 
pour les professionnels, l’intégration avec les outils ProLexis.

- Rien de particulier à signaler.

PRIX : À titre d’exemple, Myriade 
Langue française (Définitions et Synonymes)
est facturé 99 €.
ÉDITEUR : Diagonal (www.prolexis.com)
CONFIGURATION : Mac G3, G4 et G5, 
Mac OS 9.2 à Mac OS X 10.4

3

1

2
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Comic Life 1.2.2

PRISE EN MAIN

Vous possédez des stocks de dessins et de photos? Inventez donc 
une histoire! Grâce à Comic Life, vous les assemblerez, vous ajouterez 
des bulles, des encadrés narratifs et des effets pour les onomatopées.

Bandes dessinées et romans-photos

Comic Life est organisé comme 
un logiciel de mise en page. 

On y agence des blocs de graphiques
et de textes. Si vous avez déjà tâté 
d’un logiciel de PAO, vous ne serez pas
perdu. Bien évidemment, tout est 
ici conçu pour le montage de bandes
dessinées. Dès l’ouverture, Comic Life
présente une page blanche encadrée
par les outils utiles à la création 
de bandes dessinées ou de romans-
photos: des modèles de pages avec 
diverses dispositions de blocs destinés
à accueillir les images , l’accès 
à la bibliothèque d’iPhoto, aux dossiers
du Finder ou encore à la capture
d’image à partir d’une iSight ou d’un
caméscope DV , ainsi que des bulles
de formes diverses, les extensions 
de bulles, les styles d’onomatopées et
les encadrés narratifs . Vous pouvez
également choisir votre propre mise 
en page et glisser les blocs un à un
avant d’y placer les images et autres
éléments. Cela dit, les modèles 
proposés sont un bon point de départ,
d’autant plus que vous pouvez 
les modifier. Comic Life est très intuitif.

Après quelques essais, vous comprenez
vite comment partir d’une mise 
en page, glisser les photos, ajouter 
les bulles et les encadrés, y inclure le
texte, modifier la taille des bulles, leur
position, l’orientation vers le person-
nage qui parle… Seules les images sont
contraintes par les blocs, tout autre
élément peut déborder et même être 
à cheval sur deux images. Quelques clics
suffiront pour constater que vous avez
toute liberté de disposition. Suivant 
le format de page choisi, des marges
apparaîtront chaque fois que 
vous sortez de la zone d’impression.
On retrouve certaines fonctions 
d’alignement et d’agencement d’objets
pouvant passer devant ou derrière, 
des modèles, la possibilité de sauver et
de charger des mises en page. 
Les outils principaux sont accessibles
tout autour du plan de travail, par 
glisser-déposer sur la page. D’autres
outils, accessibles par le menu
Arrange, permettent d’organiser 
les objets. Certains de ces outils 
peuvent aussi être ajoutés 
dans la barre d’outils de la fenêtre. 

Le menu View offre de nombreux 
repères et des outils additionnels : 
une grille magnétique, des guides 
d’alignement, des règles dotées 
de points de tabulation et d’attributs
de texte… Comme je l’ai déjà dit, Comic
Life ne propose aucun outil de dessin.
Certains le regretteront, mais c’est 
très bien ainsi : le logiciel reste simple 

et il n’y a rien de plus aisé que 
de réaliser vos dessins à l’aide 
d’un autre logiciel (ou de plusieurs),
puis de les assembler dans Comic Life.
Et pour peu que vous travailliez 
les photos pour leur donner un certain
style, vous réaliserez des choses très
intéressantes. En tout cas, Comic Life
stimule indéniablement l’inspiration.

3

2

1

+ Un logiciel très bien conçu, tant pour la mise en page que pour 
les outils spécifiques à la BD ; des fonctions d’export intéressantes ; 
très intuitif et très riche en possibilités de personnalisation.

- Il pourrait être optimisé pour mieux supporter les G4 (ralentissements 
à prévoir) ; pas encore traduit en français.

PRIX : 21 €
ÉDITEUR : Plasq (www.plasq.com)
DISTRIBUTION : Internet
CONFIGURATION MINIMALE : Power Mac G4 et G5, 
Mac OS X 10.3

Une planche de montage complète

1

2

C
omic Life n’est pas un logiciel de dessin, c’est un banc de mon-
tage. Il vous faut donc rassembler du «matériel» illustratif: des
photos, des graphiques, des dessins… Je suis sûr qu’il y en a plein

vos disques durs ! Bien sûr, il vous faut aussi une histoire à racon-
ter, et donc un peu d’imagination. Rassurez-vous, Comic Life n’at-
tend pas de vous que vous «pondiez» du premier coup une BD de
soixante pages ni un roman-photo.Non, avec quatre ou six illustra-
tions, vous pouvez bricoler facilement une petite histoire qui tienne
la route et sur une seule planche. Prêt? Alors, Comic Life est la
meilleure solution! Il est remarquable tant pour les fonctions et les
astuces proposées que pour l’aisance dans le choix des sources et

pour la diversité des formats de sortie. Tout cela a un prix, pas ce-
lui du logiciel, très raisonnable, mais celui de la puissance. Sur un G4,
des ralentissements se font sentir dès qu’on travaillera sur plusieurs
pages consommant beaucoup d’effets – même avec une bonne carte
graphique. Mieux vaut œuvrer sur un G5 (même un iMac). Cela
dit, j’ai noté que les effets sur les images utilisant le Core Image de
Tiger sont bien moins réactifs que sous d’autres logiciels. Ce qui me
laisse à penser que l’application pourrait encore être optimisée. Ne
boudons toutefois pas notre plaisir, car Comic Life est réellement bien
conçu pour la mise en page de bandes dessinées (ou romans-pho-
tos) et leur exploitation sur divers supports. n Jean-Jacques Ardoino

3
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iDive 1.5
www.idive.fr

Dans cette version, les fonctions de catalogage vidéo – qui restent 
le cœur du logiciel – n’évoluent pas, mais un nouveau «module» fait 
son apparition: Mosaic. Un outil surprenant, mais encore en devenir.

Petits clips et petites histoires

L’utilisation des blocs n’est pas indispensable : 
vous pouvez disposer vos images directement sur 

la page. Si vous souhaitez donner des formes 
irrégulières à vos images, vous avez intérêt à utiliser
les blocs : les images elles-mêmes ne peuvent être 
modifiées qu’en taille et en orientation et c’est la forme
du bloc qui contient l’image qui est déterminante.
Chaque élément (bloc, bulle, encadré, onomatopée…)
peut prendre un style grâce au pop-up Style en haut 
de la fenêtre. Ici aussi, les presets (ensembles de préré-
glages) sont intéressants et souvent adaptés 
aux styles courants. Certains des styles de bulles ou
d’encadrés forcent les majuscules, d’autres respectent
la casse choisie. À vous de les essayer les uns après 
les autres. Si vous utilisez Mac OS X 10.4, des styles
pourront également être attribués aux images, ce qui
vous permet d’utiliser des filtres donnant un aspect
plus «dessiné» à vos photos, par exemple. 

Vous pouvez aller encore plus loin : la partie droite 
de la fenêtre de travail, montrant habituellement 
les bibliothèques, peut basculer sur un panneau Détails

qui permet de personnaliser un peu plus 
un élément à partir du style choisi. Vous pouvez fixer 
le nombre de côtés d’un bloc avec l’option Irrégulier,
d’autres choix de couleur, d’ombre, de taille et de style
de texte… Une fois l’histoire réalisée, il faut la publier.
Comic Life offre la possibilité d’imprimer en divers 
formats de page. On disposera donc d’une sortie papier
ou d’un PDF. On peut aussi exporter en HTML (c’est 
un peu comme un catalogue, sauf qu’un «lanceur» 
affichant une vignette de la page de départ remplace
l’index habituel), ou bien en images individuelles 
(une image par page) ou encore vers iPhoto, 
vers un film QuickTime… Comic Life peut même publier 
la bande dessinée sur .Mac (en utilisant les thèmes 
Métal ou iPod déjà disponibles pour l’export HTML).

5

4

Formes et styles 5

J
e rappellerai très brièvement qu’iDive (lire Vous et Votre Mac
N°8) est le catalogueur de vidéos le plus sophistiqué du marché.
Il ne se contente pas de concevoir des listes de séquences à la iTu-

nes, mais il « indexe» vos films sous forme d’images-clés qui vous
permettent de vous y retrouver facilement parmi vos centaines de
cassettes DV et autres fichiers vidéo qui s’entassent sur vos disques
durs, CD et DVD. Il s’agit d’un outil semi-professionnel qui s’adresse
à ceux et celles qui filment beaucoup et «collectionnent». La version
1.5, sortie pour Noël, nous offre Mosaic. L’idée derrière ce «mo-
dule» fonctionnel est que toutes ces images-clés de la base d’iDive
constituent en elles-mêmes une ressource différente des films dans
laquelle Mosaic puise pour créer de petites histoires animées.
Lorsque j’ai utilisé Mosaic la première fois, je n’ai pas très bien com-
pris à quoi cela pouvait servir. J’avais sélectionné simplement une
cassette, basculé dans Mosaic, puis ouvert au hasard une des dix com-
positions fournies. Résultat: des images qui s’affichent un peu comme
dans les menus animés d’iDVD. Joli, mais bon… Il faut s’y pren-
dre autrement. Grâce à l’indexation d’iDive et ses fonctions de re-
cherche, je sélectionne dans ma base toutes les images-clés de films
concernant mon petit-neveu Loulou, entre 1992, date de sa nais-
sance, et 2003, son départ aux États-Unis. Puis, dans Mosaic, je choi-
sis la composition Ray qui me fabrique une narration visuelle avec
des sauts «graphiques» dans le temps plus ou moins longs selon l’in-
tervalle entre chaque film (des textes s’affichent également à l’écran).
Ces données sont fournies par les métadonnées enregistrées dans
la base iDive. Voilà, elle est bien là ma petite histoire : les premiè-
res années de mon petit-neveu… Je peux même exporter cette pré-
sentation sous la forme d’un petit film, directement pour mon iPod 5G!
Les dix compositions proposées ne vont pas très loin pour l’ins-

tant, mais l’idée est de proposer des compositions qui tirent encore
davantage parti des métadonnées pour créer automatiquement des
histoires qui ont de plus en plus de «sens». Autre exemple: prenez
la composition Muséum où chaque image-clé est présentée comme
un tableau accroché à un mur. Je navigue dans le « musée», je fige
la présentation sur un des « tableaux » et je lance alors la vidéo
correspondante. Non, ce n’est pas aujourd’hui, mais dans une pro-
chaine version ! Les développeurs ont aussi pour projet de créer
des compositions basées sur les métadonnées géographiques. 
Mosaic est un projet génial qu’aimeront ceux qui n’ont pas le temps
de faire du montage avec iMovie ouFinal Cut Express. Bravo Aqua-
fadas, un des éditeurs français les plus inventifs. n Bernard Le Du

4
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La Terre vue du ciel

G
oogle Earth est basé sur des photos sa-
tellites ou prises depuis un avion. Ces
images ne sont donc pas mises à jour en

temps réel. Elles ont été prises ces trois der-
nières années et proviennent de différentes
sources. Par exemple, une même ville peut
être composée de vues prises à diverses pé-
riodes, mais le monde entier n’a pas encore
été couvert en haute résolution. Dans Goo-
gle Earth, «haute résolution» signifie que
vous pouvez compter les voitures sur un par-
king, par exemple. Les grandes villes sont sou-
vent couvertes, surtout celles des États-Unis,
de l’Europe et du Golfe… L’Inde, la Chine,
l’Afrique et l’Amérique du Sud en sont encore
à leurs débuts. Cela dit, la haute résolution
n’est pas toujours nécessaire hors des villes. 

Tapis magique!
Vous «volez» donc au-dessus du globe com-
me au-dessus d’une carte ou dans un logi-
ciel graphique. Utilisez la main pour vous dé-
placer ainsi que le zoom avant/arrière. Goo-
gle Earth gère ses images dans les différentes
résolutions sans que vous ne vous en rendiez
compte. Pour vous, c’est exactement comme
si vous étiez perché sur le satellite avec une
puissante longue-vue. Ou sur un tapis ma-
gique! Le zoom et les déplacements sont tel-
lement lissés qu’il est impossible de s’aper-
cevoir des changements d’images. Mieux, il
suffit de donner une petite impulsion et vous
partez dans une direction à vitesse constante.

J’ai ainsi remonté le Rhône, de la Méditer-
ranée à Lyon, plus vite que le TGV, avec tout
de même quelques petites impulsions à droite
et à gauche pour ajuster la direction Nord. Et
c’est là que Google Earth introduit une fonc-
tion assez étonnante: au lieu de voir le pay-
sage en étant au-dessus, comme avec une carte,
on peut descendre sur la ligne d’horizon et
obtenir ainsi une «vue d’avion»! Les images
sont recalculées en se servant de l’altitude pour
rendre le relief. Cette possibilité fonctionne
très bien en montagne ou dans les sites val-
lonnés. Je navigue ainsi dans les vallées et je
joue au saute-montagnes enneigées. En ville,
l’effet est cependant moins spectaculaire.

Une base de données mondiale
Les noms de villes et de certains sites appa-
raissent par ailleurs sur les photos détaillées.
C’est l’autre face de Google Earth, encore
peu développée, mais au potentiel énorme :
une base de données touristiques et commer-
ciales mondiale. Les hôtels, les restaurants,

les immeubles remarquables, les routes, les
frontières, etc., tout cela va venir peu à peu
enrichir Google Earth qui deviendra LE sys-
tème de référence de localisation sur carte.
Un vrai nouveau défi pour l’Europe et les au-
tres grandes Nations (Google est Nord-Amé-
ricain). Google a également prévu que les uti-
lisateurs puissent eux-mêmes ajouter des in-
formations basées sur les images via le Fo-
rum Google Earth Community. 
Bien entendu, Google Earth est un logiciel to-
talement Internet. Les photos sont téléchar-
gées en temps réel. Elles ne sont pas sur votre
disque, hormis dans un cache disque qui n’est
pas directement exploitable. Google Earth ne
tournera pas sur tous les Mac: il y a des res-
trictions sur le moteur graphique, notamment.
Dans sa version de base, il sera gratuit, mais
on n’en sait guère plus pour les versions avan-
cées. D’abord disponible en bêta «privée»,
Google Earth a été offert au téléchargement
public le 10 janvier, à l’ouverture de Mac-
world Expo. n Alain Lalisse

PRIX : gratuit 
ÉDITEUR : Google (http://earth.google.com)
DISTRIBUTION : par Internet
CONFIGURATION MINIMALE : Mac OS X 10.4

+ Des images impressionnantes de précision ; un potentiel très important 
avec les informations commerciales ; une interface fluide, élégante, avec des outils 
de gestion (favoris, calcul d’un voyage…).

- Il manque encore beaucoup de zones en haute définition ; les États-Unis sont servis 
les premiers. 

Google Earth
Google met notre monde (et bientôt les autres) à portée de souris. Mieux
qu’un programme de télévision, ce logiciel nous fait voyager de par 
le monde en quelques secondes, sans bouger de chez nous. Avant-première!

PRISE EN MAIN
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À la fois téléphone-répondeur, fax, imprimante couleur, scanner 
et photocopieur, il est bien intégré à l’environnement Mac. 
Il s’utilise depuis vos applications ou le Centre de contrôle Brother.

Brother MFC-640CW

Multifonction… avec ou sans fil

C
e multifonction est avant tout destiné au secrétariat de petites
structures et aux indépendants, réunissant
dans une seule et même machine tous

les appareils de la bureautique moderne.
L’ensemble est plutôt compact avec une dis-
position très classique : l’imprimante sert
de socle, et sur le dessus se trouvent
le scanner, un lecteur de cartes mé-
moires intégré, un tableau de bord
bien fourni qui permet de se pas-
ser complètement d’un ordinateur
et un combiné téléphonique sur le
côté. L’imprimante est une jet
d’encre à quatre cartouches, fa-
ciles à changer. Le bac contient
100 feuilles de papier ordinaire, mais on peut aussi l’utiliser avec
du papier couché ou glacé pour des travaux moins bureautiques.
La partie fax est très classique (jusqu’à 480 pages en mémoire, rap-
pel sur occupation…). Le scanner couleur offre une résolution de 600
x 2400 dpi largement suffisante pour la plupart des travaux. Seul
bémol, le pilote n’effectue aucun détramage. Les bonnes surprises vien-
nent de la connexion : USB, Ethernet, Wifi via une borne AirPort,
par exemple, mais aussi réseau ad hoc. L’installation prend en compte
ces différentes configurations réseau, ce qui n’est pas toujours sim-
ple à comprendre. Je vous conseille donc de suivre pas à pas la docu-
mentation qui se trouve sur le CD Mac. N’essayez pas d’improvi-
ser! Pour ce test, je l’ai installé en mode réseau sans fil ad hoc.
Pour utiliser cette multifonction, le constructeur Brother propose une
application dite Centre de contrôle à laquelle on accède via une icône
dans la barre des menus. Cela dit, rien ne vous oblige à passer par

elle. Une fois installée, la Bro-
ther MFC-640CW s’utilise
comme toutes les autres impri-
mantes. Vous avez en plus,
dans la boîte de dialogue, les
paramètres d’impression et la
gestion des couleurs. C’est à
cet endroit que vous indique-
rez le type de papier, la qualité
d’impression, ou la possibilité
d’imprimer en niveaux de gris.
De la même manière, le Con-
trôle des couleurspropose un
préréglage pour vos documents
graphiques, vos photos, ainsi

qu’un réglage fin de vos préférences personnelles. Pour envoyer
des fax, c’est presque aussi simple. Il suffit de sélectionner, toujours

dans les options d’impression, Envoi Fax dans le pop-
up local. Vous entrez ponctuellement le nu-

méro de fax ou vous consultez votre Car-
net d’adresses. Pour scanner un do-
cument, Brother installe un pilote
Twain que l’on utilise dans les me-
nus d’acquisition de GraphicConver-
ter ou de Photoshop. Ceux qui pré-
fèrent avoir des fonctions toutes faites
sur des boutons utiliseront le Centre de

contrôle (Control Center 2.1.3) que Brother ins-
talle dans la barre des menus. Les fonctions y sont regroupées par
thème. Dans la partie numérisation, on numérise le document et
on le transforme en un fichier qui s’ouvre dans Aperçu, qu’on envoie
par email ou qu’on stocke dans un dossier. Cela dit, je n’ai pas

réussi à faire fonctionner l’OCR… Très pratique, Brother a permis
la personnalisation de chaque bouton. Vous pouvez, par exemple,
créer un bouton pour numériser à 100 dpi, en noir & blanc, avec
un fort contraste, ou encore avec conversion au format PDF suivie
d’un envoi par Mail. Je renomme ainsi le bouton Mailing N&B,
et un clic suffit à lancer l’opération. Ce même principe de boutons
personnalisés s’applique pour les fonctions de photocopieur et de
fax. Le Centre de contrôle vous servira également à configurer la
MFC-640CW sans que vous ayez à pianoter sur le tableau de bord
de la machine – la configuration sur un petit écran LCD n’est ja-
mais vraiment pratique. De même, entrer des numéros abrégés de-
vient un jeu d’enfant avec le Centre de contrôle. Dernière option (tou-
jours avec un souci pratique), la surveillance du niveau des cartou-
ches d’encre. Bref, ce tout-en-un fonctionne parfaitement sous Mac
OS X 10.4.3, sauf l’OCR. Il dispose aussi des pilotes pour Mac OS
9.2. À 259 €, c’est un bon investissement. n Alain Lalisse
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PRIX : 259 €
FABRICANT : Brother (www.brother.fr)
DISTRIBUTION : Distributeurs de matériel informatique 
CONFIGURATION : Mac OS 9 et X

+ Une intégration à Mac OS X plutôt réussie ; chaque fonction est d’un bon niveau, 
largement suffisant pour une utilisation courante de type bureautique.

- La configuration réseau requiert quelques compétences ; la connexion «Wifi ad hoc»
n’est plus opérationnelle si l’on ajoute un autre port réseau (il est donc 
préférable d’utiliser une borne AirPort ou un routeur Wifi) ; j’ai été bien incapable 
de faire fonctionner le logiciel d’OCR livré avec la machine.
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Du petit caboteur de bord de côte au voilier de course en passant par le yacht de haute
mer, pour voguer sur la Grande bleue nombre d’embarcations vous sont proposées. 
Eh bien, pour naviguer sur I
OS X, vous avez ainsi plus d’une dizaine de modèles de navigateurs Web! Toujours plus
racés, puissants, rapides, plus fonctionnels et presque tous gratuits. Je me propose 
de vous aider à choisir le ou les navigateurs que vous placerez en bonne position 
dans votre Dock. Si vous optez pour Safari ou Firefox, je vous propose des conseils, 
astuces et petits utilitaires pour tirer le meilleur de ces deux logiciels

Surfez sur le WebSurfez sur le Web
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E Safari, Firefox, Opera et OmniWeb:
quatre navigateurs en vedette

E Optimisez Safari

E Musclez Firefox

en toute sérénité
et efficacité

ord de côte au voilier de course en passant par le yacht de haute
Grande bleue nombre d’embarcations vous sont proposées. 

sur Internet, c’est un peu la même chose. Dans la «classe» Mac
us d’une dizaine de modèles de navigateurs Web! Toujours plus

es, plus fonctionnels et presque tous gratuits. Je me propose 
e ou les navigateurs que vous placerez en bonne position 
s optez pour Safari ou Firefox, je vous propose des conseils, 

aires pour tirer le meilleur de ces deux logiciels. n Frédéric Blaison
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ez sur le Webez sur le Web
en toute sérénité
et efficacité
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De pages en pages, naviguez

avec plaisir et efficacité

S
i pendant longtemps, nous n’eûmes le choix qu’en-
tre Microsoft Explorer et Netscape Navigator, l’of-
fre en navigateurs Web est aujourd’hui importante:

on compte une bonne dizaine de solutions crédibles.
Ainsi, dès la sortie de Mac OS X, les initiatives se sont
multipliées avec un OmniWeb issu du monde NeXT ou
encore iCab et Chimera. Il y a quatre ans, plus d’une di-
zaine de navigateurs étaient déjà proposés sur Mac OS X,
puis il y eut le lancement de Safari d’Apple. Simplicité
de l’interface utilisateur et innovations ont fait école et
Apple a bien entendu imposé Safari comme navigateur
par défaut du Mac. En réplique, Microsoft a cessé d’amé-
liorer la version Mac d’Internet Explorer, mais l’arrivée
de Safari n’a nullement tué les autres développements.
Pourquoi une telle vivacité? En fait, le «navigateur uni-
versel», celui qui répondrait à toutes les situations, ou-
vrirait infailliblement toutes les pages, saurait tout de
toutes les technologies utilisées sur Internet et intégrerait
tous les services imaginables (email, blog, gestion d’ima-
ges…), ce navigateur-là n’existe pas aujourd’hui… Et il
n’existera probablement pas demain.

Un univers de plus en plus complexe
Des années durant, les pages Web n’ont proposé que du
texte avec de petites images, parfois animées, mais plus
de publics différents ont eu accès à Internet, et plus leurs

demandes ont suscité la distribution de contenus riches
et complexes. Parallèlement, l’infrastructure d’Internet
a connu une évolution considérable et les particuliers ont
ainsi bénéficié d’un accroissement non négligeable des
débits grâce au câble ou à l’ADSL. 
Aujourd’hui, les pages d’un site Web ressemblent davan-
tage à des performances multimédia live qu’à de simples
brochures illustrées. Pour parvenir à un tel résultat, les
concepteurs font appel à des technologies de plus en plus
nombreuses et complexes.
Si le HTML et ses améliorations comme le XHTML cons-
tituent toujours le noyau dur d’une page, on fait au-
jourd’hui également appel à l’ASP de Microsoft, au cou-
ple PHP/MySQL, à WebObject d’Apple, aux feuilles de
style CSS, aux scripts JavaScript et aux mini-applications
Java… De plus en plus de sites utilisent désormais le lan-
gage XML – une révolution dans la façon de penser une
page Web. Il convient aussi d’intégrer tous les fichiers
multimédia, et encore d’offrir les services les plus divers…
Cette complexité influence bien évidemment les naviga-
teurs qui se doivent de «suivre» le rythme. Certes, tout
le monde s’aligne peu ou prou sur les standards du W3C,
mais les standards sont toujours en retard d’une lune.
Les évolutions technologiques, toujours rapides et inces-
santes, ne laissent droit à aucune pose. Certains moteurs
implémentent donc plus ou moins bien telles ou telles

Les navigateurs Internet sont nombreux sur Mac OS X et on ne va pas s’en plaindre! D’autant que l’univers
du Web est en constante évolution, les concepteurs de sites expérimentant rapidement la moindre 
nouvelle technologie, sans trop se soucier de standards forcément à la traîne. Les navigateurs doivent 
donc eux aussi s’améliorer en permanence. Mieux vaut en avoir plusieurs à portée de souris et les mettre 
à jour dès que de nouvelles versions sortent. Toutefois, quatre logiciels sortent vraiment du lot.
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Le navigateur d’Apple, désormais le seul installé par défaut sur tous
les Mac (Microsoft Explorer n’est pas fourni avec Mac OS X 10.4), a
bien mûri depuis sa sortie. La version livrée avec Mac OS X Tiger
offre ainsi plusieurs fonctions majeures sans alourdir en rien le lo-
giciel dont j’admire toujours l’ergonomie et l’intelligence de l’inter-
face. D’ailleurs, il fait école et bon nombre des nouveautés introdui-
tes par Safari ont été désormais implémentées par les concurrents.
L’ouverture des fenêtres sous forme d’onglets n’a pas été une inven-
tion de Safari, mais il a réussi à l’intégrer avec une rare élégance 
dont tout le monde s’est inspiré par la suite.

Respect des standards du Web
Safari est construit au-dessus du moteur de rendu WebCore qui est
désormais capable de comprendre et afficher la plupart des pages
que vous rencontrez sur le Web sans trop de souci et avec célérité.
Subsistent encore certains sites commerciaux (essentiellement des
sites bancaires et marchands) ou des sites «expérimentaux» sur
lesquels il n’est pas facile de mener sa barque avec Safari. Mais c’est
moins la faute de ce dernier que des concepteurs de ces sites qui
utilisent des techniques non standardisées. D’ailleurs, la dernière
mise à jour en date du navigateur d’Apple passe le fameux Acid2
Test, prouvant une compatibilité accrue avec de grands standards
comme le HTML 4, les CSS ou le format PNG.

Un lecteur RSS intégré
Au rang des services complémentaires apportés par le navigateur,
le principal est dans Safari RSS l’intégration de l’agrégation de flux
RSS, avec brio ! Cela ne fait en aucun cas «pièce rapportée». Avec
Safari, vous accédez très facilement aux flux RSS des sites visités
et vous les gérez de la même manière que les autres adresses.
Lorsqu’un site dispose d’un flux RSS, une icône bleue RSS s’af-
fiche dans la barre d’adresses. Si vous cliquez dessus, la liste des in-
formations proposées s’affiche dans la fenêtre de Safari, mais avec
une interface spécifique offrant une fonction de recherche ainsi que
des options de tri et de classement . Vous pouvez raccourcir un
article, ne conserver que le titre, classer les articles par date, etc.
Safari intègre également bon nombre de technologies Tiger, comme
la recherche Spotlight au niveau des signets et de l’historique, ou

encore le contrôle parental (afin de maîtriser la liste des sites
que vos enfants peuvent visiter). Les plus paranoïaques d’en-
tre vous apprécieront la possibilité d’activer une navigation
privée, où l’historique des visites restera vide. Enfin, Safari est
capable de lire de lui-même les fichiers PDF grâce à de nou-
velles fonctions du Web Kit, et de les ouvrir directement dans
l’application Aperçu. 
J’utilise chaque jour Safari, car il répond parfaitement à mes
attentes. Il est ergonomique et suffisamment rapide à mon
goût. J’apprécie les fonctions de remplissage automatique et
de gestion des mots de passe. Safari gère parfaitement les
certificats SSL. Je regrette en revanche que le système de té-
léchargement des fichiers soit encore trop simpliste. Malgré
le respect des standards et les fonctions intégrées, je suis
parfois obligé de faire appel à un autre navigateur…

3

2

1

Safari RSS 2.02

technologies (il s’agit même parfois d’un choix « politi-
que»). Aussi, afficher une page Web au plus juste de ce
qu’a imaginé le concepteur du site, et ceci le plus rapide-
ment possible, reste le principal défi pour un navigateur.
Actuellement, deux moteurs dominent sur Mac OS X. On
les retrouve dans presque tous les navigateurs disponi -
bles. D’abord WebCore, le moteur de rendu du Web Kit,
est développé pour Safari et Mac OS X par Apple. Il est
basé d’origine sur le moteur open source KHTML de
l’environnement KDE (Linux). Gecko est quant à lui issu
du programme Mozilla, également développé en open
source et utilisé par Netscape, Firefox ou Camino. 

Le moteur de rendu constitue sans aucun doute le point
central d’un navigateur, mais comme ces moteurs devien-
nent toujours davantage plus performants et prennent
en compte un nombre croissant de technologies, les pages
s’affichent de plus en plus uniformément d’un moteur à
l’autre, et grosso modo à la même vitesse. Désormais, les
développeurs doivent produire leurs efforts sur l’interfa-
ce, l’expérience utilisateur et les fonctions connexes of-
fertes par le navigateur. Entre navigateurs utilisant le
même moteur, le choix de l’utilisateur se fera aussi sur la
présentation (le fameux look and feel, expression diffi-
cile à traduire) et l’éventail des fonctions intégrées.

Prix : Gratuit 

Éditeur : Apple 

Distribution : Fourni uniquement avec Mac OS X Tiger 

Configuration : Mac OS X 10.4.x 
www.apple.com/fr/macosx/features/safari/
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Firefox est un navigateur qui gagne à être connu et qui a déjà conquis
de nombreux utilisateurs de Mac OS X. J’en ai fait mon navigateur
d’appoint, car je reste encore trop attaché aux technologies Apple
et particulièrement à Safari pour l’adopter complètement. Cela dit,
Firefox me permet d’accéder à certains sites que n’ouvre pas Safari,
sauf à passer par certaines manipulations rocambolesques… 

Un moteur de rendu performant
Tout d’abord, il est aussi simple à utiliser qu’efficace et rapide en na-
vigation. Il s’appuie sur la dernière version du moteur de rendu Gecko
développé par le groupe Mozilla. Gecko est également utilisé par le
navigateur Mozilla (toujours disponible au téléchargement par ail-
leurs) ou encore Camino – toutefois, ce dernier est toujours en re-
tard d’une évolution. La barre d’outils reprend les standards du mo-
ment avec un outil de recherche plus flexible que celui de Safari
puisque vous pouvez choisir entre plusieurs sites de recherche .
La gestion des signets, ici dénommés marque-pages, s’effectue dans
une fenêtre indépendante de celle qui affiche les pages Web.
Certains trouveront cela plus souple que dans Safari. Quoique… Avec
ce dernier, il suffit d’ouvrir le gestionnaire de signets dans un on-
glet pour retrouver un fonctionnement proche.

Firefox reconnaît les flux RSS, mais ne propose pas d’agrégateur.
Soit il lance un lecteur externe que vous lui désignez, soit vous fai-
tes appel à un plug-in qui implémente un véritable agrégateur comme
dans Safari. Toutefois, Firefox place une icône orange à côté du nom
d’un marque-page d’un flux RSS (fonction Marque-pages dynami-
ques) à partir duquel vous pouvez dérouler la liste des news : il
suffit de sélectionner un des titres pour l’afficher dans la page. 

Une architecture ouverte
Au niveau de la vie privée et de la sécurité, Firefox offre des solu-
tions classiques, comme la gestion des certificats SSL ou l’enregis-
trement protégé des mots de passe. La dernière version apporte le
mode furtif, comme dans Safari. Personnellement, j’apprécie beau-
coup la gestion des cookies, très flexible. Une case de recherche per-
met de retrouver un cookie et de l’éliminer individuellement .
Firefox présente une architecture ouverte, vous pouvez donc lui gref-
fer des modules externes, soit des extensions (modules fonction-
nels), soit des thèmes (modules d’interface). 
L’installation est vraiment très facile, puisque prévue par le naviga-
teur . Vous êtes guidé de bout en bout . Il faut cependant
faire attention à ce que le module que vous convoitez soit disponi-
ble pour la version Mac OS X, ce qui n’est pas le cas de tous. Cette
ouverture est sans conteste le point fort de Firefox. Il existe bien

quelques extensions pour Safari, comme vous le verrez dans la suite
de ce dossier, mais leur développement est plus complexe, car Apple
n’a (comme d’habitude) rien fait pour faciliter les choses! Avec cette
version 1.5, vous pouvez sans risque adopter Firefox comme votre
navigateur principal en lieu et place de Safari.
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Firefox 1.5 Prix : Gratuit 

Éditeur : Mozilla 

Distribution : Internet (en coffret sur commande)

Configuration : Mac OS X v10.2 et suivants
www.mozilla-europe.org/fr/products/firefox/

1

5

6

4

2 3

DOS Navigateurs JLOK.qxd  13/01/06  19:08  Page 44

http://www.mozilla-europe.org/fr/products/firefox


N°12 février 2006 45Vous et Votre Mac

Non, OmniWeb n’est pas basé sur le Web Kit, mais s’appuie sur une
version personnalisée de WebCore, le moteur de rendu d’Apple dé-
veloppé à partir de KHTML du navigateur Konqueror et disponible
en open source. Selon ses concepteurs, cela donne davantage de
marge pour son développement. Surtout, ne pas faire un Safari bis !
Contrepartie, ils doivent toujours se tenir informés des évolutions
de WebCore et effectuer un travail d’implémentation que l’utilisa-
tion du WebKit aurait évité. C’est pour cela qu’il y a toujours un dé-
calage entre les nouvelles versions de Safari et d’OmniWeb. De plus,
en raison de différences d’implémentation, la vitesse d’affichage est

différente entre le Web Kit de Sa-
fari et le moteur personnalisé
d’OmniWeb basé sur le WebCore.
Toutefois n’exagérons rien : si
OmniWeb est effectivement plus
lent, ses performances demeu-
rent tout à fait acceptables. 

Richesse fonctionnelle
En revanche, grâce à cette indé-
pendance vis-à-vis d’Apple, Om-
niWeb marque sa différence 
dans la richesse des fonctions
qu’il propose. Comme tout le
monde, il offre une gestion mul-
tipage, mais au lieu d’onglets
« texte », il nous propose des
aperçus des pages, dans un ti-
roir . Ce sont des instanta-
nés des pages que vous organi-
sez comme vous le voulez. Il est
possible de glisser un lien direc-
tement depuis une page dans le
tiroir : un onglet est généré au-
tomatiquement. Vous pouvez
même y lire le contenu des pa-
ges directement si vous avez un
grand écran et que vous élargis-
sez le tiroir. Vous pouvez encore
échanger des onglets entre dif-
férentes fenêtres.

Espaces de navigation et préférences par site !
OmniWeb offre une gestion des espaces de navigation. En clair, vous
pouvez configurer des «jeux» de sites (par exemple, des sites d’ac-
tualité informatique) et basculer de l’un à l’autre ou même réunir
dans un espace plusieurs fenêtres correspondant elles-mêmes à dif-
férents jeux de sites. La fonction Instantané permet de « pho-
tographier», ou plus exactement de conserver, les préférences d’af-
fichage et l’organisation des fenêtres et des onglets. Au prochain
redémarrage d’OmniWeb, nul besoin de relancer manuellement le
chargement de pages que vous aviez mis des heures à découvrir : il
gère cela pour vous, tout comme la récupération en l’état des espa-
ces de navigation suite à un incident inopiné – comme on dit.
OmniWeb gère partiellement les flux RSS, comme le fait Firefox. Vous
ne disposez pas d’un agrégateur, mais vous pouvez vous abonner à
un flux en bas et à droite de la page grâce à une petite icône bien
discrète . OmniWeb crée un marque-page avec lequel vous ac-

cédez aux articles comme dans Firefox. Le nombre des nou-
veaux articles non lus est indiqué sur l’icône d’OmniWeb dans le
Dock. Enfin, cerise sur le gâteau, ce logiciel est le seul à ma connais-
sance à proposer une gestion des informations et des préférences
pour chaque site. Par exemple, il est possible de bloquer des fenê-
tres pop-up pour une page précise, mais pas l’ensemble des sites

comme c’est le cas avec Safari et d’autres.
Si vous n’attendez pas vos pages au millième de seconde, essayez
donc ce navigateur original, aux fonctions inédites. OmniWeb a ce
qu’il faut pour vous séduire. Pour ma part, je le trouve un peu lourd
et son implémentation de WebCore n’est pas optimale.
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OmniWeb 5.13 Prix : 30 $

Éditeur : Omnigroup 

Distribution : Internet

Configuration : Mac OS X v10.2.8 et suivants
www.omnigroup.com/applications/omniweb/
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Voici un navigateur multi-plateforme vraiment surprenant. Il plaira
à celles et ceux qui sont en quête d’un logiciel qui allie une vraie ra-
pidité d’affichage à une large palette de fonctions. Désormais, avec
cette version 8.5, Opera est gratuit pour tous, et sans publicité. Il est
beaucoup plus connu sur Windows que sur Mac et il est également
omniprésent sur les PDA et autres smartphones (bien qu’il ait perdu
la bataille chez Nokia contre le Web Kit d’Apple).
Opera est basé sur un moteur de rendu propriétaire dénommé Presto,
un nom qui lui va comme un gant, car sa lecture des pages est très
rapide! Par ailleurs, je n’ai pas rencontré de problèmes lors de mes
navigations : tout s’est ouvert correctement. 

Une ergonomie complexe
L’interface utilisateur d’Opera est foisonnante (nombreuses barres
horizontales et latérales, boutons multiples…) et atypique. Par exem-
ple, la barre d’outils se situe sous celle des onglets (c’est l’in-
verse chez les autres). L’apparence globale est modifiable à l’aide
de skins… À la droite des onglets des pages, une corbeille garde en
mémoire les adresses visitées précédemment. Pratique pour rou-
vrir des pages rapidement… Et comme toute corbeille, vous la videz
quand vous voulez. La barre d’outils est très bien fournie. Vous re-
trouvez sur la gauche les boutons de navigation standard (retour,
page suivante, recharger…), et au centre un large champ de saisie

pour les adresses. Ce dernier cache
un menu local qui permet d’ac-
céder directement à la page d’accueil
par défaut, à un Top 10 de vos visites
et à vos signets (Opera récupère sans
rien demander les signets de Safari
lors de son premier lancement). Acces-
soirement, il offre un champ de re-
cherche Google, également disponi-
ble à droite de la case de saisie.

Des outils inédits
L’icône sous forme de lunettes de la barre d’outils est très intéres-
sante. Elle ouvre une autre barre d’outils spécifiques à l’affichage.
Fonction inédite : le zoom de 20 à 1000 % dans une page Web .
C’est là aussi que vous désactivez le téléchargement des images,
fonction appréciée des personnes utilisant un modem RTC (il y en a
encore beaucoup hors des agglomérations) ou le modem GPRS d’un
téléphone portable (les forfaits sont facturés aux kilo-octets)… 

Opera vous permet de naviguer en plein
écran et même en mode kiosque (pour
les bornes Internet). Surtout, un sédui-
sant lecteur d’emails est proposé ,
qui sert aussi pour les news et les flux
RSS . Comme dans Safari, vous dis-
posez d’une icône bleue dans le champ
des adresses afin de vous abonner à un
flux RSS et le lire dans l’agrégateur.
Opera offre enfin de bonnes fonctions
dans le domaine de la sécurité (certifi-
cats SSL, mots de passe sécurisés…). 
Globalement, j’ai été assez séduit par
ce navigateur méconnu sur Mac. Tou-
tefois, en parcourant le forum de la
communauté Opera, je me suis aperçu
qu’il existe encore de nombreux bogues
dans le rendu des pages – du moins
dans la version pour Mac OS X. 

5

4

3

2

1

Opera 8.5.1
Prix : 30 $

Éditeur : Opera Software 

Distribution : Internet

Configuration : Mac OS X v10.2 et suivants
www.opera.com/download/

2
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Quelques outsiders

Safari a apporté une interface épurée, la fonction
SnapBack, le blocage des fenêtres pop-up 
de publicité, l’outil Google et une rapidité d’affichage
des pages Web… Que des bonnes choses que les 
autres navigateurs ont vite reprises à leur compte.
Pour les développeurs, Apple propose quelque chose
de plus intéressant encore: le Web Kit, 
un jeu d’API au cœur de Mac OS X sur lequel Safari est
bâti. Dans le Web Kit, on trouve le moteur de rendu
WebCore. Le Web Kit, fruit d’une collaboration entre
les ingénieurs d’Apple et les créateurs du moteur
KHTML du navigateur Konqueror de l’environnement
KDE sur Linux, est aussi sophistiqué que robuste. 
Un programme open source existe par ailleurs pour

le développement du Web Kit, si bien
que vous pourrez même y participer
(http://Web Kit.opendarwin.org/). 
Aujourd’hui, le Web Kit s’impose comme 
le principal choix pour tout ce qui touche
au rendu de pages Web dans les applications
de Mac OS X. Car comme de nombreuses 
technologies Apple, il est totalement documenté
et tout développeur peut en tirer parti. 
Je me souviens d’une conférence où un ingénieur
d’Apple avait mis en œuvre en quelques minutes, 
par simple glisser-déposer d’éléments, des fonctions
de lecture de pages Web dans une application… 
Grâce au Web Kit, tout logiciel Mac OS X développé

avec XCode peut afficher 
des pages HTML. On retrouve
ainsi le Web Kit dans Mail 

pour le rendu des messages HTML,
dans Dashboard pour l’affichage 
des widgets, ou dans certains logiciels

comme DevonThink, DevonNote, 
le navigateur Shiira ainsi que les browsers spécialisés 
de l’éditeur App4Mac.
Vous utilisez le Web Kit au quotidien dans Safari, 
et même bientôt sur votre téléphone Nokia: 
le nouveau navigateur fourni sur les téléphones 
avec système d’exploitation S60 a en effet été 
développé avec le Web kit d’Apple!

Vive le Web Kit !

Camino 1.0 b1 (www.caminobrowser.org, Mac OS X 10.2 et suivants, gratuit)
a longtemps été porteur d’espoir pour les multiples utilisateurs qui recherchent
une alternative crédible à Internet Explorer sur Mac OS X avant que Safari n’ap-
paraisse. Connu précédemment sous le nom de Chimera, ce navigateur basé sur
le moteur Gecko de Mozilla propose une interface utilisateur développée dans
l’environnement Cocoa. Camino est toujours en phase de développement, suit

avec retard les améliorations de Firefox et fait un peu du surplace depuis que Sa-
fari est présent, car il n’apporte pas vraiment plus de fonctionnalités. Certains le
jugent cependant plus rapide. Uniquement disponible en anglais, Camino est dé-
sormais assez anecdotique, mais tout de même à surveiller !

iCab 3.0.1 (www.icab.de, Mac OS X 10.1 et suivants, gratuit, version française dis-
ponible). Lui aussi a été conçu bien avant que Safari soit disponible et il a souffert
de l’initiative d’Apple. D’autant plus que ses auteurs ont eu à un certain moment
l’idée de vendre des licences. C’est un petit navigateur rapide et efficace, trop mé-

connu. Il supporte bien entendu les langages courants du Web (HTML 4, Java, Ja-
vaScript) et offre des fonctions intéressantes. On notera les possibilités de filtrage
des images ainsi qu’un mode de navigation hors ligne.

Mozilla 1.7.2 (www.mozilla-europe.org/fr/products/mozilla1x, Mac OS X 10.1 et
suivants, gratuit, version française disponible). Ce logiciel, héritier du Netscape
Communicator «historique» (à ne pas confondre avec le Netscape actuel qui n’est
qu’une pâle photocopie de Mozilla) et cousin germain de Firefox, est un tout-en-un
du Web qui va bien au-delà du simple navigateur. 
Mozilla regroupe des fonctions de navigation Web (basées sur le moteur Gecko,
bien entendu, un lecteur de courriers électroniques et de news, mais également
un éditeur HTML). Un véritable couteau suisse pour les utilisateurs très exigeants.
Pour la partie Web, on retiendra les fonctions courantes comme la navigation par

onglets, le blocage des fenêtres pop-up ainsi que la saisie automatique bien pra-
tique. Mozilla ne souffre plus (trop) des lenteurs du passé.

Shiira 1.1 (http://hmdt-web.net/shiira/en, Mac OS X 10.3.9 et suivants, gratuit,
version française disponible). Les développeurs de Shiira veulent faire de leur na-
vigateur un outil plus performant encore que Safari. Il est écrit en Cocoa comme
Camino, mais il est en revanche basé sur le Web Kit d’Apple comme Safari et tire
donc profit de toute la richesse de ce jeu d’API et de WebCore pour le rendu des
pages. Pour l’instant, soyons juste, vous ne noterez guère de différences entre
Shiira et son homologue Safari. Il est même systématiquement en retard. Ainsi,
ce n’est que la toute dernière version qui met en œuvre la navigation par onglets.
Les signets, ainsi que l’historique et les téléchargements, sont gérés dans une fe-

nêtre tiroir de chaque fenêtre de Shiira. Vous pouvez télécharger Shiira 1.1 sur le
site du projet ainsi qu’un jeu de ressources pour franciser le navigateur. Une ver-
sion moins récente, intitulée Shiira FR, est également disponible sur le site Free-
warePub Software (www.freewarepub.c.la).

wKiosk Browser Pro 4.0.2 (www.app4mac.com, Mac OS X 10.3.9 et sui-
vants, 56 €, version française disponible). Ce navigateur basé sur le Web Kit d’Ap-
ple est une solution professionnelle de type «borne» à déployer dans les lieux pu-
blics. L’éditeur français spécialisé dans les navigateurs dédiés propose également
KidsBrowser (26 €) pour les jeunes enfants.

Surfez sur le Web en toute sérénité et efficacité
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Des conseils et des utilitaires pour

aller plus loin avec Safari

T
el qu’il est proposé, Safari est un navigateur com-
plet. Il remplit à merveille son job en offrant de
bonnes réponses aux besoins des utilisateurs, et
même avec talent. En outre, Safari embarque de

nombreuses fonctions attrayantes, pas toujours connues
de la plupart des utilisateurs. De plus, des utilitaires en
nombre se proposent de l’améliorer en y ajoutant – par-
fois – des fonctions dont nous ne saurions plus nous pas-
ser. Je vous propose de (re)découvrir ensemble notre na-
vigateur et d’en étendre les possibilités en quelques clics.

RSS, vous avez dit RSS?
Avant de penser à modifier les capacités de Safari, il me
semble important de bien comprendre son fonctionne-
ment à la base, et surtout ses fonctions majeures. Ainsi,
si nous savons tous saisir l’adresse d’un site et y navi-
guer, tout le monde n’est pas forcément à l’aise avec les
flux RSS. Et pourtant, Safari propose sans nul doute la
meilleure expérience utilisateur dans ce domaine. 
Qu’est-ce qu’un flux RSS? Cette terminologie trouve (es-
sentiellement) sa source dans l’univers des blogs, ces sites
personnels où tout-un-chacun peut s’exprimer librement
sans avoir à créer un site Web. À la base de ces sites, il
est possible de partager le contenu des articles postés
entre les différents blogs. Je simplifie, bien sûr, mais il

n’en demeure pas moins vrai que cette technique s’est
répandue si bien sur le Web que désormais la plupart des
sites offrent une « syndication» de leur contenu. C’est-
à-dire qu’il est possible de partager du contenu sans être
le site émetteur. Vous vous abonnez généralement à un
flux en cliquant sur un lien et vous exploitez son contenu
dans un logiciel dédié comme NetNewsWire, par exem-
ple. Un flux propose ainsi une liste d’articles sous une
forme réduite au minimum (le titre, le début du texte ou
un résumé, la date et un lien vers la page Web de l’arti-
cle, parfois même une image).
Apple apporte une réponse qualitative à l’utilisation de
ces flux par le biais de Safari qui se transforme en un vé-
ritable lecteur RSS sophistiqué. C’est aussi un «agréga-
teur», au sens où il sait prendre en charge autant de flux
différents que vous le souhaitez. Simple et efficace!
Tapez dans la barre d’adresses l’URL du site du journal
Le Monde (www.lemonde.fr). Une fois que la page d’ac-
cueil du site est chargée, vous apercevez à droite de l’adres-
se une icône bleue avec l’inscription RSS. Cliquez des-
sus pour ouvrir dans la fenêtre du navigateur Safari, par
un effet de glissement du haut vers le bas, l’agrégateur
RSS de Safari . À quelques indices, vous savez très
bien lorsque vous êtes en lecture de pages Web classi-
ques ou bien dans l’agrégateur. Tout d’abord, l’adresse
d’un flux RSS ne commence pas par «http:// », mais par
«feed:// ». Ensuite, la page affichée par l’agrégateur res-
semble beaucoup plus à celle de Spotlight qu’à une page
Web habituelle. En haut, vous trouvez le titre du flux,
qui permet d’accéder à la page d’accueil du site par un
simple clic, et une liste d’articles sur la partie centrale.

1

Le navigateur d’Apple s’est très vite imposé auprès des utilisateurs de Mac OS X, non seulement 
parce qu’il est désormais le seul installé par défaut sur les Mac, mais surtout parce qu’il offre un vrai
confort de navigation. En creusant, il est même possible de le rendre encore plus efficace.

[DOSSIER]

Le champ de recherche Google
de Safari ne recherche que 
sur… Google.com. AcidSearch est
un add-on qui élargit le choix 
des moteurs de recherche.
Les canaux peuvent être 
personnalisés sans limites, aussi
bien avec des moteurs de recher-
che sur le Web qu’avec ceux 
des sites Web que vous visitez 
au quotidien! Le contenu 
des canaux s’organise hiérarchi-
quement avec des dossiers. 
AcidSearch permet également
d’utiliser des raccourcis 
clavier pour choisir un canal 
de recherche. Un petit exemple 

pratique? Dans les préférences
d’AcidSearch (accessibles via 
le menu déroulant du champ 
de recherche), créez un nouveau
canal, nommez-le Base VVMac,
puis entrez «www.vvmac.com/
sweet/archives/search_by_
article.php?SearchString2=»
dans le champ de la colonne 
Préfixe. Refermez les préférences
puis choisissez Base VVMac dans
le menu déroulant du champ 
de recherche et tapez «Tiger».
Validez. Safari ouvre une page 
du site compagnon de VVMac
avec une liste d’articles relatifs 
à Mac OS X Tiger!

Recherche tous azimuts

Robin Hamilton-Pennell (www.pozytron.com/acidsearch)
AcidSearch 0.61. Freeware. Nécessite Safari 2.02 et Mac OS X 10.4.3.

1
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La colonne de gauche permet d’effectuer des recherches
dans le contenu du flux, de paramétrer la longueur des
articles et d’effectuer des tris et classements. La section
Actions permet même d’envoyer un lien par courrier élec-
tronique ou de conserver le flux dans les signets.
Justement, cliquez sur Ajouter aux signets… Une fenê-
tre vous propose de donner un titre au flux et de l’enre-
gistrer dans la bibliothèque des signets. Optez pour la
barre des signets et faites Ajouter. Vous venez, le plus
simplement du monde, de vous abonner à un flux! Dé-
sormais, lorsque du contenu sera ajouté à ce flux, un
chiffre indiquera à droite du nom du signet, et entre pa-
renthèses le nombre d’articles nouveaux… 
Pour afficher ensemble des articles proposés par plusieurs
flux différents, créez un dossier dans la barre des signets
dans votre bibliothèque, puis placez-y les signets des flux
que vous voulez agréger. Ces flux restent accessibles indé-
pendamment, mais aussi réunis en choisissant l’option
Présenter tous les articles RSS du menu contextuel ou de-
puis le menu Signets . Plus simple encore, si vous avez
créé le dossier dans la barre des signets, cochez la case
Clic auto ; l’agrégation sera dès lors automatique. Vous
pouvez suivre un des liens proposés par les articles ou
revenir à l’affichage de la page Web en cliquant à nou-
veau sur le bouton RSS dans la barre d’adresses. 
Dernier détail : pour vous désabonner à un flux, effacez
simplement son signet de la bibliothèque. Vous retrou-
vez d’ailleurs tous les signets des flux RSS, quelle que
soit la façon dont vous les avez organisés, dans la sec-
tion spécifique Tous les flux RSS de la bibliothèque.

Bien sûr, l’agrégateur
de Safari est paramé-
trable via l’onglet RSS
des préférences (menu
Safari > Préférences).
Vous pouvez notam-

ment définir un autre lecteur par défaut si vous avez déjà
l’habitude d’utiliser un autre logiciel (dans ce cas, les flux
ne seront pas ouverts dans Safari), de contrôler les mises
à jour des flux et la périodicité des recherches .
Astuce : SafariDockStatus (http://software.burntout.
net/sds/) permet d’afficher sur l’icône du Dock le nom-
bre de nouveaux articles, comme l’icône de Mial le fait
avec les nouveaux messages. Pratique.

Ouvrez et enregistrez un fichier PDF
Jusqu’à la sortie de la version 2, Safari ne gérait pas les
PDF. Pourtant, de nombreux manuels, brochures, for-
mulaires, etc., sont de plus en plus diffusés sur le Web
dans ce format. Désormais, Safari ouvre directement les
documents PDF. Par exemple, visitez le site compagnon
de VVMac à l’adresse www.vvmac.com. Sur la droite,
cliquez sur Commandez le hors-série (ou sur Je m’abonne
dans la barre d’outils du site) : vous devriez trouver sur
l’une de ces pages un bouton Téléchargez le formulaire,

3

2
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De nombreux sites Web fonctionnent avec
des cookies, ces petits programmes 
aux fonctions pas toujours très claires,
pour stocker des mots de passe, 
des durées de connexion ou autres infos
concernant vos habitudes de navigation. 
La plupart des forums créent un cookie
avec vos mot de passe et login. Pratique
pour vous connecter plus facilement. 
Des sites commerçants peuvent placer 
un cookie à votre insu et analyser 
votre mode de vie sur le Web. Il est donc 
intéressant de pouvoir faire régulièrement
le ménage! Si Safari n’offre qu’une gestion

très limitée de ces petits programmes,
avec Cocoa Cookies, vous pourrez les gérer 
efficacement. Le logiciel offre des fonctions
de recherche avancée pour effacer 
les éléments douteux. Si vous supprimez 
par erreur un cookie, vous pourrez même
faire machine arrière avec une fonction 
Rétablir efficace. La règle de base que 
je vous conseille d’appliquer est d’effacer
tout cookie autre que ceux des sites 
généralistes que vous visitez ou de vos 
forums. Enlevez même ceux des sites 
de vente par correspondance. Cocoa 
Cookies est un petit logiciel indispensable.

Safaricon vous offre l’occasion d’installer
de nouvelles icônes dans les barres d’outils
de Safari, et même de modifier certaines
ressources du logiciel. Safaricon est très
simple à mettre en œuvre et vous propose

de télécharger les dernières ressources
disponibles lors du lancement du logiciel.
Vous visualisez le résultat de vos 
manipulations dans un bien maigre aperçu
avant d’appliquer les changements.

Gérez les cookies

Modifiez l’interface

Todd Ditchendorf (http://ditchnet.org/wp/)
Cocoa Cookies0.7. Freeware. Mac OS X 10.4 et Safari 2

Reinhold Panner (via www.versiontracker.com)
Safaricon 2.6. Freeware. Mac OS X 10.4 et Safari 2.0.2
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derrière lequel il existe en fait un fichier PDF: Safari va
l’ouvrir automatiquement dans la fenêtre . Vous voilà
bien avancé : que faire ? Le menu contextuel vous
offre de Zoomer sur le document, mais aussi de l’ou-
vrir avec Aperçu, seul moyen de l’enregistrer sur votre
disque dur (menu Fichier > Enregistrer sous dans Aper-
çu). Je regrette personnellement qu’Apple n’ait pas pensé
(ou voulu) inclure une option d’enregistrement directe-
ment dans le menu contextuel de Safari… Il est cepen-
dant toujours possible d’enregistrer directement le fi-

chier à partir du lien affiché sur la page d’un site, via
l’article Enregistrez le fichier lié du menu contextuel de
Safari. Reste que les fonctions du navigateur en matière
de PDF sont des plus limitées pour l’instant.
Si vous recherchez une solution plus élaborée, téléchar-
gez donc PDF Browser Plugin (Manfred Schubert, www.
schubert-it.com/pluginpdf/), un module à placer dans
le dossier Internet Plug-Ins de la bibliothèque de votre
compte ou de votre système. Ce module, disponible en
anglais uniquement, offre toutes les fonctions nécessai-
res pour exploiter un fichier PDF directement dans Sa-
fari. Il est gratuit pour une utilisation à la maison ou en
milieu éducatif, pour des activités non commerciales.
Sinon, sa licence est fixée à 69 $. Adobe Reader 7 ins-
talle lui aussi un lecteur PDF pour Safari, mais il est plus
lent et lourd que PDF Browser Plugin. 

Mots de passe et formulaires automatiques
Si le Web d’aujourd’hui demeure très largement gratuit,
on vous demande en revanche de plus en plus souvent
d’en passer par des procédures de login et/ou de rem -
plissage de formulaires. Vous êtes ainsi invité à vous
identifier pour vous connecter à des forums ou pour ac-
céder à votre compte .Mac. Au quotidien, vous êtes ainsi
souvent appelé à répéter ces saisies. Safari garde toutes
ces informations en sécurité et vous laisse vous connec-
ter de manière automatique.
Dans les préférences de Safari, choisissez la section Rem-
plissage automatique (que vous trouvez sous l’intitulé
Rempl. auto.). Vous activez ici les fonctions de remplis-
sage pour les noms, mots de passe et les divers formu-
laires. Personnellement, je ne coche pas l’option qui per-

5

4

4

5

Beaucoup de fonctions de Safari restent
cachées et d’autres n’emportent pas
l’adhésion, telle la lecture automatique 
des fichiers PDF. Safari Enhancer est 
une sorte de couteau suisse pour activer
ou désactiver des fonctions cachées 
du navigateur. Parmi le flot des possibilités

offertes par ce logiciel, on peut retenir 
l’activation du menu Debug, la gestion 
des fonctions de cache, la désactivation 
du plug-in PDF pour revenir au télécharge-
ment des fichiers, ou encore la possibilité
d’importer des signets depuis d’autres 
navigateurs comme Internet Explorer.

Fonctions cachées

Gordon Byrnes (www.lordofthecows.com/safari_enhancer.php)
Safari Enhancer 3.02. Freeware. Mac OS X 10.4 et Safari 2.0.2

Saft est une grosse boîte à outils qui 
s’insère très bien à Safari, mais des nom-
breuses fonctions qu’il propose, beaucoup
n’ont pas grand intérêt pour l’utilisateur
moyen. Saft présente tout de même 
un gros plus : il permet d’activer un mode

plein écran et un mode kiosque sécurisé.
Ces fonctions devraient satisfaire 
les utilisateurs, surtout les pros, car 
elles permettent la mise en place de 
«bornes Internet», dans un cadre scolaire
ou sur une exposition, par exemple.

Mode kiosque

Hao Li (http://haoli.dnsalias.com/Saft/)
Saft 8.21. 12 $. Mac OS X 10.4.3 et Safari 2.0.2
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met d’utiliser les informations de mon Carnet d’adres-
ses. Safari va conserver ainsi en mémoire les informa-
tions des formulaires (les mots de passe sont stockés dans
le Trousseau d’accès de l’utilisateur, bien à l’abri des re-
gards indiscrets). Les boutons Modifier permettent d’ef-
facer les données liées à un site et déjà stockées .

Envoyez une page Web par email
Il existe plusieurs manières de partager une page qui vous
plaît avec vos proches. La plus basique consiste à copier
l’adresse et à l’envoyer par email ou via une messagerie
instantanée comme iChat. Safari RSS va un peu plus loin
en proposant un raccourci pour transmettre une page
dans un courrier électronique via Mail. Cette technique
est d’ailleurs un bon procédé pour créer des messages

HTML sophistiqués avec Mail depuis Safari RSS. Créez,
par exemple, une page Web qui fera office de message
(un faire-part, une annonce, une carte de visite…) avec
votre outil de prédilection, qui peut être Contribute, Free-
way, Nvu… La page Web doit être stockée sur un ser-
veur Web et non en local sur votre ordinateur. Ensuite,
ouvrez la page dans Safari. Choisissez le menu Fichier >
Envoyer le contenu de cette page par courrier électroni-
que (ou [Cmd I]). Safari ouvre alors la page dans un nou-
veau message de Mail. Tout cela ne prend ainsi que quel-

ques secondes. Si votre page comprend des liens, ils se-
ront conservés dans la page créée dans le message de
Mail, et il est possible de les utiliser pour les ouvrir dans
un navigateur. Votre correspondant pourra ainsi les con-
sulter chez lui avec son navigateur préféré .7

6

De nombreux navigateurs permettent 
de garder en mémoire des jeux, mais ce
n’est pas le cas de Safari. Safari Extender
(en anglais uniquement) comble cette 
lacune du navigateur d’Apple. Disponible
sous la forme d’options du menu contex-

tuel de Safari, Extender offre de sauvegar-
der des jeux d’onglets ainsi que de réarran-
ger leur ordre (menu Tabs). Vous dispose-
rez aussi de fonctions pour envoyer 
par email l’adresse d’une page ou encore
une sélection de textes (menu Extender).

Jeux d’onglets

Ricardo Batista (http://batista.org/extender.html)
Safari Extender 1.46. 10 $. Mac OS X 10.3

SafariStand vous offre une version très limitée d’une 
des fonctions clés d’OmniWeb: mettre en réserve 
les pages visitées sous forme de vignettes dans 
un tiroir. Ici, l’intérêt est réduit car on ne peut pas faire
grand-chose des vignettes. SafariStand propose 
toutefois d’autres fonctions comme une fenêtre 
séparée pour gérer des signets, l’historique et les flux
RSS ou encore la gestion d’espaces de navigation. 
Et bien d‘autres options, plus ou moins intéressantes…

Onglets vignettes

Hetima (http://hetima.com/safari/stand-e.html)
SafariStand 2.0b12. Mac OS X 10.4.x

Si Safari est le navigateur que vous utilisez au quotidien, il peut arriver que vous ayez 
besoin de recourir à un autre logiciel, ou bien tout simplement envie de découvrir d’autres 
expériences de navigation sur le Web avec un autre navigateur. Vous avez sans aucun
doute déjà collecté des dizaines de signets durant vos sessions de surf. Plusieurs 
navigateurs savent désormais reprendre automatiquement les signets de Safari. Toutefois,
Safari Bookmark Exporter demeure utile car il existe des logiciels qui ne gèrent pas encore
cela. Il est aussi capable de procéder à destination de plusieurs navigateurs d’un seul coup.
Assurez-vous que vos navigateurs ne sont pas ouverts, et éventuellement, sauvegardez
une copie de leurs différents jeux de signets, bookmarks et autres marque-pages. 
Lancez Safari Bookmark Exporter, puis cochez Open Safari Bookmarks from Default 
Location et cliquez sur le bouton Analyse Bookmarks. Choisissez un (ou plusieurs) 
navigateur(s) cible(s), puis cliquez sur Export Bookmarks. Enfin, enregistrez les nouveaux
réglages de signets pour chaque navigateur en cliquant sur le bouton Save (une fenêtre
vous demandera de remplacer les anciens réglages, cliquez sur le bouton Replace).

Exportez des signets

Ellipsis Productions (http://homepage.mac.com/simx/)
Safari Bookmark Exporter 1.1. Freeware. Mac OS X 10.3
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Grâce aux extensions et thèmes, créez

un Firefox sur mesure!

F
irefox est un navigateur surprenant à plus d’un
point de vue. Nous le verrons, il propose un sys-
tème de skins sympathique, mais la force de ce na-
vigateur – qui n’a rien de très spécial à la base –

réside dans son système d’extensions et de plug-in. Vous
allez pouvoir enrichir l’éventail de fonctions de votre na-
vigateur avec de petites pépites logicielles, souvent gra-
tuites! Mieux, le système est totalement transparent. 
Pour installer une extension, qu’on appelle ici add-on,
vous n’avez qu’à cliquer sur un lien dans une page Web.
Firefox la télécharge et propose de l’installer en quelques
clics. Comme Firefox propose des fonctions de sécurité
élevées, vous devrez dans la plupart des cas autoriser le
site pour que le navigateur puisse installer l’extension.
Les add-on peuvent bien sûr être désinstallés ou être mis
à jour aussi facilement via le menu Outils > Extensions
de Firefox. Vous trouverez un nombre important d’add-
on sur le site https://addons.mozilla.org/ (en anglais) ainsi
que sur le site communautaire http://extensions.gecko
zone.org/ (en français). 

Passez à Firefox en douceur
C’est fait, votre décision est prise : vous souhaitez faire
de Firefox votre navigateur au quotidien. Oui mais voilà,
quand on change de logement, il faut déménager mobi-
lier et effets personnels. C’est la même chose lorsqu’on
quitte un navigateur pour un autre. Comment faire pour
que ce soit le plus indolore possible? Si vous utilisez Sa-
fari, pourquoi ne pas recourir à Safari Bookmark Ex-
porter que j’ai évoqué dans la partie de ce dossier consa-
crée à Safari? Cela ne sera pas suffisant! En effet, ce petit
freeware se contentera de convertir vos signets pour les

rendre compatibles avec Firefox. Or, vous avez accumulé
d’autres informations non moins importantes : mots de
passe, cookies… Vous vous voyez déjà recommencer de
zéro? Pas moi! Heureusement, les développeurs de Fi-
refox ont intégré des fonctions d’import très performan-
tes. Choisissez le menu Fichier > Importer. Dans l’assis-
tant d’importation, désignez votre navigateur actuel 
parmi les quatre proposés (Safari, Microsoft Internet Ex-
plorer, Netscape 6 et 7/Mozilla 1.x, et Opera), puis cli-
quez sur Continuer. Sélectionnez ensuite les éléments que
vous souhaitez « faire suivre» et cliquez sur Conti-
nuer. Le tour est joué. Désormais, votre navigation dans
Firefox devrait être sensiblement la même qu’avec votre
ancien navigateur : vous disposez déjà de vos signets et
de vos cookies. Néanmoins, vous serez parfois amené à
ressaisir certains mots de passe. 

Et les signets RSS de Safari?
Tout s’est donc bien passé, sauf que vous ne r etrouvez
pas les signets RSS que vous aviez dans Safari ! L’assis-
tant d’importation de Firefox ne les gère pas. Des heu-
res de navigation réduites à néant ? Heureusement, il
existe une solution. Téléchargez un module pour Auto-
mator à cette adresse : http://dcostanet.net/wordpress/
2005/06/13/export-safari-rss-feeds-via-opml/. Cliquez
sur le lien Click here to download the Automator Ap-
plication. Vous téléchargez une image disque dans la-
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Firefox est très flexible car il gère des extensions de manière très transparente, c’est aussi simple 
que d’ajouter un widget à Dashboard. Il offre en sus un système de skins bien pensé. Vous voulez faire 
de Firefox votre navigateur au quotidien? Voici quelques clés pour bien le maîtriser.

[DOSSIER]

Vous écoutez de la musique lorsque vous
surfez ou travaillez sur le Web, et parfois
vous visitez des pages contenant, par 
exemple, des séquences QuickTime… Pas
très évident de jongler entre la fenêtre 
d’iTunes pour baisser le son ou stopper 
un titre et celle de Firefox pour visualiser 
un film. Installez donc Foxytunes qui place
en bas de chaque fenêtre de Firefox un petit
lecteur multimédia qui, par défaut, pilote

iTunes (mais que vous pouvez adapter 
à un autre lecteur multimédia comme 
RealPlayer). Une extension ludique dont
vous ne saurez plus vous passer…

Pilotez iTunes

http://extensions.geckozone.org/Foxytunes

1
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quelle vous rencontrerez une petite application intitulée
SafariOPML que je vous propose de copier dans le dos-
sier Utilitaires du dossier Applications de Mac OS X.
Ensuite, vous n’avez plus qu’à le lancer. 
Vous pouvez suivre le déroulement du script dans la barre
de menus du Finder. L’utilitaire crée un fichier nommé
Safari.opml sur votre Bureau. Dans Firefox, ouvrez le
panneau latéral de Sage (lire l’encadré ci-dessus consa-
cré à cette extension majeure pour ce navigateur) et dans

le menu local Options, choisissez Import/Export OPML.
Dans la fenêtre qui s’affiche, cochez l’option Importer
une liste OPML et cliquez sur le bouton Continuer.
Dans le panneau suivant, cliquez sur Parcourir afin de
retrouver et sélectionner le fichier Safari.opml. Cliquez
dès lors sur Continuer pour que Sage importe vos fils
RSS. Voilà, c’est tout! 
Un dossier intitulé OPML Import-Safari OPML Export
s’inscrit dans la liste des fils du panneau latéral de Sage.
Dans ce dossier, un sous-dossier Safari feeds contient
l’organisation de vos anciens signets RSS .
Vous pouvez réorganiser ces fils grâce au menu localOp-
tions > Gérer la liste des fils, ou utiliser le menu contex-
tuel pour organiser vos fils. Il propose entre autres de
créer un nouveau marque-pages pour vous abonner à un
fil, un nouveau dossier, et de supprimer un fil. Cela dit,
vous devrez toujours ouvrir la fenêtre de gestion des fils. 

Oh, le beau panneau latéral !
L’un des aspects intéressants de l’interface utilisateur de
Firefox est son panneau latéral très fonctionnel. Il peut
être comparé à la barre latérale des fenêtr es du Finder.

4

3
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Firefox n’offre qu’une gestion très basique des flux RSS. Même si vous pouvez
vous abonner, vous ne saurez afficher les titres d’un fil qu’au travers 
d’un marque-pages. Pour la plupart des utilisateurs, cette fonction est suffi-
sante, même s’il n’est pas toujours évident de déduire le sujet d’un article 
de son seul titre. C’est là qu’un lecteur de flux prend tout son sens puisqu’il 
propose, outre des fonctions de classement et de recherche, un aperçu (ou 
un résumé selon le fil) des articles. Heureusement, il y a Sage, une extension
gratuite qui étend les capacités de lecture RSS du navigateur Firefox.
Téléchargez l’extension Sage avec Firefox sur le site du projet. Cliquez sur 
Install dans le menu de la page d’accueil, puis sur Click here to Install.
Un message d’alerte apparaît en haut de la page, vous informant que Firefox 
a empêché ce site d’installer le logiciel sur votre ordinateur. Cliquez 
sur le bouton Modifier les options pour ouvrir la fenêtre de gestion des sites
autorisés à installer des extensions. Cliquez sur le bouton Autoriser. Le site 
est ajouté dans la liste, vous pouvez fermer la fenêtre et recommencer 
l’installation en cliquant sur Click here to Install. Ensuite, autorisez l’installation
de Sage (bouton Installer maintenant). Relancez le navigateur pour que
l’installation soit prise en compte. Une fois Firefox à nouveau ouvert, affichez 
le lecteur Sage via le menu Affichage > Panneau latéral > Sage.
Vous disposez de la liste des fils auxquels vous êtes abonné , et lorsque
vous en sélectionnez un, les articles apparaissent dans une liste placée dans 
le panneau latéral et sous forme de vignettes dans la partie réservée 
aux pages Web du navigateur . Pour accéder à la page Web d’un article,
vous le sélectionnez dans la liste ou vous cliquez sur le titre de sa vignette.
Lorsque de nouveaux articles non lus sont disponibles pour un fil, une petite
étoile rouge apparaît sur l’icône fil. 

Sélectionnez dans le panneau 
latéral le menu local Options
et choisissez Gérer la liste des fils.
Vous disposez alors d’une fenêtre
similaire à celle disponible pour 
la gestion des marque-pages. 
Créez des dossiers pour organiser
vos fils par thèmes. Depuis 
ce même menu Options, affichez 

la barre de recherche des fils dans le panneau latéral et tapez un mot-clé, 
par exemple «Mac». Sage va interroger le moteur de recherche du site 
Feedster.com et vous propose une liste d’articles sous forme de vignettes. Ainsi,
vous recherchez sur le Web dans les fils du monde entier comme vous le feriez
via Google pour rechercher un terme dans le contenu des sites ! 
Bien entendu, vous pouvez ajouter un fil dans Sage, soit en créant un nouveau
marque-pages dans la fenêtre de gestion de la liste des fils, ou lors de vos visites
sur les sites. Lorsque vous êtes sur une page disposant d’un (ou plusieurs) fil(s),
une icône orange apparaît dans la barre d’adresse de Firefox. Choisissez le fil qui
vous intéresse, puis le dossier dans lequel vous souhaitez le classer. Recherchez
dans le dossier Marque-pages le dossier Sage Feeds et cliquez sur le bouton
Ajouter. Il existe une deuxième méthode pour s’abonner encore plus facilement
à un fil. Lorsque vous visitez une page Web, cliquez sur l’icône loupe dans 
le panneau latéral de Sage. Une fenêtre s’affiche listant le(s) fil(s) de la page.
Vous en choisissez un et vous cliquez sur le bouton Ajouter le fil pour qu’il soit
greffé à la liste du panneau latéral de Sage. Vous renouvelez l’opération 
autant de fois qu’il y a de fils que vous voulez «suivre». Sage est donc un lecteur
complet pour la gestion et la lecture des fils RSS, simple et fonctionnel. 
Vous pouvez affiner ses préférences dans le menu Outils > Extensions.

http://sage.mozdev.org/
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Un lecteur RSS pour Firefox
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Ce panneau vous donne accès à l’orga-
nisation des marque-pages et des exten-
sions (Sage l’utilise également). Faites 
Affichage > Panneau latéral > Marque-
Pages pour afficher ou masquer le pan-
neau des marque-pages (ou encore la
combinaison [Cmd B]). 
Les dossiers et marque-pages, accessibles
depuis la barre personnelle (équivalent à
la barre des signets de Safari) de chaque
fenêtre de Firefox, sont stockés dans le
dossier Toolbar Bookmarks . 
Vous créez autant de dossiers que vous
voulez en sus du dossier Toolbar Book-
marks. Ces dossiers et ce qu’ils contien-
nent seront alors accessibles dans le pan-
neau latéral s’il est visible, mais aussi par
le menu Marque-pages. Nous retrouvons
ici une organisation similaire à celle de
Safari où vous disposez d’une section pour
gérer la barre des signets et une autre pour
le menu des signets. D’ailleurs, après im-
portation, les signets de Safari sont conver-
tis en marque-pages. Les signets de la
barre des signets du navigateur Safari sont
rangés pour leur part dans le dossier Tool-
bar Bookmarks de Firefox, et les signets
du menu des signets dans un dossier inti-
tulé Importé depuis Safari . 
Vous pouvez gérer l’organisation des mar-
que-pages au travers de la fenêtre du ges-
tionnaire des marque-pages (menu Mar-

que-pages > Gérer les marque-pages). Sinon, utilisez le
menu contextuel du panneau latéral pour effectuer les
principales opérations de gestion. 
Pour vous retrouver plus facilement dans votre collec-
tion de marque-pages, vous disposez d’un champ Re-
cherche : tapez un ou des mots-clés pour afficher la
liste des marque-pages correspondant à votre requête.
Petite astuce bien pratique: si vous êtes amené à utiliser
en duo Safari et Firefox, sachez que vous pouvez ouvrir
des pages dans chacun des navigateurs en glissant la fa-
vicon (l’icône à gauche de l’adresse d’un site) d’une page
directement sur l’icône du navigateur dans le Dock, ou
en glissant la favicon d’une fenêtre depuis un navigateur
à l’autre. Ce processus fonctionne dans les deux sens.

Recherchez dans une page Web
Lorsque vous visitez une page pour trouver une info pré-
cise, le plus rapidement possible et que vous tombez sur
un texte imposant, cela peut prendre parfois un peu de
temps… Firefox offre une recherche intégrée bluffante.
Sur une page de votre choix, utilisez la combinaison
[Cmd F]. N’attendez pas la fenêtre de recherche habi-
tuelle de Mac OS X, regardez en bas de la page: dans le
champ, tapez un ou plusieurs mots et ils apparaissent
instantanément surlignés dans le texte . Efficace!8
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Vous l’avez sans doute remarqué, de plus en plus de sites
proposent des publicités au format Flash, vite pénibles, 
surtout si, comme moi, vous écoutez de la musique tout en
travaillant. Pour bien d’autres raisons, le blocage du contenu
Flash peut être intéressant. Grâce à l’extension FlashBlock,
lorsque vous chargez une page contenant du contenu Flash,
ce dernier n’est plus joué; vous retrouvez en lieu et place 
le logo de Flash. Si vous voulez lire l’animation, vous cliquez
sur le logo tout simplement. Vous pouvez autoriser 
des sites dont Flashblock ne bloquera pas le contenu Flash.
Choisissez le menu Outils > Extensions, sélectionnez
FlashBlock dans la liste des extensions, puis cliquez sur 

le boutons Préférences. Vous disposez d’une section Liste 
de sites autorisés. Si vous recherchez des fonctions encore
plus précises pour limiter la publicité lors de vos visites, 
essayez AddBlock, une extension redoutable !

Firefox offre un champ de recherche intégrant
par défaut plusieurs plug-in pour Google 
ou Yahoo. Vous pouvez par ailleurs télécharger
une multitude d’autres plug-in sur le site Sher-
lock Cherche. C’est facile : vous recherchez 

un plug-in dans les rubriques, puis vous l’instal-
lez directement en cliquant sur une petite
icône verte (deux flèches), généralement située
à droite du nom du plug-in. Firefox vous alerte
avant de procéder à l’installation .
Vous pouvez optimiser vos recherches sur 
le Web à l’aide de l’extension Advanced Search
Sidebar qui installe un nouveau panneau latéral
(menu Affichage > Panneau latéral > Advanced
Search) depuis lequel vous pouvez choisir 
un ou plusieurs moteurs de recherche . 
Le résultat apparaît sous la forme d’une liste
dans le panneau latéral et dans un onglet.

http://sherlock-cherche.org/
https://addons.mozilla.org/extensions/
moreinfo.php?id=1271&application=firefox
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Halte au Flash Recherche poussée

http://flashblock.mozdev.org/)
http://extensions.geckozone.org/Adblock/)
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Effacez vos traces
Firefox offre de très bonnes
fonctions pour assurer votre
vie privée. Vous n’êtes pas
sans savoir que vous laissez
beaucoup de traces lorsque
vous vous déplacez sur In-
ternet. Un historique de vos
visites, par exemple, ou des
éléments dans différents ca-
ches enregistrés sur le disque
dur. Si vous travaillez dans
un environnement ouvert, en
entreprise, dans un Web
café…, ou si vous êtes un
tantinet paranoïaque, Fire-
fox a de quoi vous rassurer.
Ouvrez les préférences du
navigateur (menu Firefox >
Préférences). Choisissez la
section Vie privée . Vous
retrouvez une organisation
sous forme d’onglets avec
comme principaux thèmes
l’historique, les mots de

passe… Cliquez sur le bouton Paramètres en bas de cette
fenêtre . Dans la fenêtre qui s’affiche, choisissez les
éléments à supprimer lorsque vous utiliserez la fonction
d’effacement de Firefox . Dans la section Paramètres
d’effacement , cochez les deux options. Vous aurez
ainsi une fenêtre d’avertissement lorsque vous lancerez
la fonction d’effacement. Surtout, cette fonction se met-
tra en route à chaque fois que vous quitterez le naviga-
teur. Pourquoi n’ai-je pas coché deux des options de la
liste des éléments: les mots de passe et les cookies? Parce
que si je choisis de les effacer, je serais obligé de retaper
beaucoup d’informations à l’avenir. Je préfère en outre
gérer séparément ces paramètres au travers des préféren-
ces du navigateur Firefox. 
Toutefois, dans un milieu ouvert, comme un open space
en entreprise, il est plus prudent de cocher également ces
deux options! Vous pouvez activer à tout moment l’ef-
facement en utilisant le menu Outils > Effacer mes tra-
ces. Vous serez toujours appelé à confirmer vos choix. 

Protégez les mots de passe enregistrés
Comme avec Safari, lorsque vous renseignez un formu-
laire sur une page Web, Firefox vous propose de s’en
souvenir. Le mécanisme est par contre ici différent, car
le navigateur d’Apple inscrit le mot de passe dans le 
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Même si Firefox jouit désormais d’un look plus proche 
de l’atmosphère graphique habituelle de Mac OS X, 
vous pourriez avoir envie de le transformer. Le logiciel 
vous offre donc un système de thèmes à la fois simple 
et efficace. Le mécanisme est très proche de celui 
des extensions, il suffit de cliquer sur un lien. 
Je passe par le menu Outils > Thèmes. Firefox ouvre 
la fenêtre de gestion des thèmes. C’est ici le centre 
de contrôle et d’activation d’un thème. Nous allons le voir, 
le basculement d’une interface à l’autre s’effectue de façon
transparente. Au départ, on ne dispose que du seul thème 
par défaut . Je clique sur le lien Obtenir d’autres thèmes
(en bas à droite) pour accéder au site de téléchargement 
de Mozilla. Je choisis par exemple iFox, un thème très pur 
et bien plus proche des applications d’Apple, avec les mêmes
icônes d’outils que celles de Safari. 
Sur la page de présentation du thème , je clique sur 
le lien Install Now. Une fenêtre me demande de confirmer 
le téléchargement. Si vous n’avez jamais téléchargé 
d’extension ni même de thème, vous serez sans doute amené
à autoriser le site pour que Firefox puisse procéder au télé-
chargement. Firefox inscrit toujours une information en haut
de la page où le téléchargement a été bloqué et un bouton
Modifier les options est disponible pour autoriser le site. 
In fine, il y a un nouveau thème dans la fenêtre de gestion
idoine . Pour basculer sur iFox, je clique sur le bouton Uti-
liser le thème. Il est nécessaire de relancer Firefox comme
dans le cas d’une extension pour que les modifications soient
prises en compte. Et voilà le nouveau look ! Comparez
avec la copie d’écran au-dessus, avec le skin par défaut.
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Jouez avec les skins
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trousseau d’accès de Mac OS X. Firefox
gère lui sa propre base de mots de passe,
mais si vous ne réglez pas une option, tout
le monde pourra les lire! 
Lancez les préférences de Firefox (menu
Firefox > Préférences) et choisissez la sec-

tion Vie privée. Cliquez sur le bouton
Définir le mot de passe principal pour
vous mettre à l’abri des regards indis-
crets. Désormais, pour afficher un mot
de passe enregistré, vous devrez four-
nir le mot de passe principal.

Téléchargements automatiques

Vive la navigation par onglets !

Lorsque Firefox ne reconnaît pas automatiquement
un type de fichier, il vous invite à enregistrer le fichier
sur disque, ou à l’ouvrir avec une application par 
défaut. Il est possible de modifier ces actions dans
les préférences, mais ce n’est pas très ouvert. Vous
ne pouvez ajouter vos propres actions… L’extension
Mime Type Editor apporte plus de souplesse. 
Installez-la. Si vous téléchargez une image disque
(.dmg) avec Safari, le volume est automatiquement
monté sur votre Bureau. Ce n’est pas le cas avec 
Firefox. On va y remédier. Déroulez le menu Outils >

Mime Types. Une fenêtre d’édition
des Mime Types apparaît. Dans 
la liste de la colonne File types,
cliquez sur le bouton New Type.
Remplissez les différents champs
comme ci-contre . Cochez la case Open it with,
puis cliquez sur le bouton Choose. Retrouvez dans 
le dossier Système/Bibliothèque/CoreServices 
l’application DiskImageMounter et cliquez sur 
le bouton Ouvrir. Ne cochez pas la case Always ask
me. Refermez la fenêtre en cliquant sur OK, puis 
la fenêtre d’édition des Mime Types avec OK.
Désormais, lorsque vous cliquez sur un lien .dmg
(versiontracker.com, par exemple), l’image disque est
téléchargée et montée automatiquement.
Vous ajouterez d’autres Mime Types pour ouvrir 
directement une séquence dans QuickTime, par
exemple. Vous trouverez une liste des principaux Mime
Types à cette adresse: http://filext.com/index.php.
Pour lire directement les documents PDF, PDF Brow-
ser Plugin (www.schubert-it.com/pluginpdf/) s’avère

compatible avec Firefox. Vous pouvez faire appel 
à PDF Download pour choisir si le fichier sera 
téléchargé sur le disque ou lu dans le navigateur.
Firefox ne se démarque pas beaucoup de Safari pour
le suivi des téléchargements. Lorsque vous downloa-
dez un fichier, vous pouvez surveiller l’avancement
de l’opération dans une fenêtre indépendante (menu
Outils > Téléchargement). Bref, vous devez jongler
entre deux fenêtres. Avec l’extension Download 
Statusbar, vous installez un système complet de suivi
directement dans la fenêtre de la page Web .
Vous ne serez plus obligé d’en passer par la fenêtre
des téléchargements pour révéler un fichier dans 
le Finder ou arrêter un téléchargement. Notez que 
les préférences de l’extension Download Statusbar
sont accessibles via le menu Outils > Extensions.
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Comme Safari, Firefox propose la navigation par 
onglets, avec quelques fonctions bien pratiques dans
ce domaine. Vous pouvez naturellement déplacer 
les onglets pour les organiser. En utilisant la fonction
Exposé de Mac OS X, vous pouvez même déplacer 
un onglet d’une fenêtre Firefox à une autre. 
Le menu contextuel sur un onglet propose plusieurs
options comme la création d’un nouvel onglet
ou la possibilité de marquer la page. Pour enregistrer
un jeu de plusieurs onglets afin de les ouvrir 
plus tard en une seule fois, choisissez le menu 
Marque-pages > Marquer tous les onglets. Firefox 
enregistre alors un dossier dans lequel il stocke 

les marque-pages de chacune des pages ouvertes
dans chaque onglet. Pour rouvrir toutes ces pages 
à la fois, vous choisissez le dossier dans 
votre barre des marque-pages, et dans le menu 
contextuel, vous choisissez l’option Ouvrir dans 
des onglets . Ces fonctions restent toutefois 
relativement basiques. Avec l’extension SessionSaver

, la version la plus complète non seulement 
recharge les onglets ouverts lors de la dernière fer-
meture du navigateur, mais elle récupère les onglets
et fenêtres ouverts lors d’un crash ou lorsque vous
forcez Firefox à quitter. Vous retrouvez le navigateur
dans l’état dans lequel il se trouvait avant l’incident!

Cela permet même de reprendre au-
tomatiquement un téléchargement!
Avec Session Saver, vous enregistrez
des sessions pour charger 
automatiquement des jeux d’onglets,
ou vous définissez un jeu à ouvrir 

au lancement de Firefox. N’hésitez pas à installer
aussi l’extension Tab X: elle ajoute à chaque onglet
un bouton pour le fermer, même s’il n’est pas 
au premier plan (dans Firefox, on ne ferme un onglet
qu’au moyen d’un seul bouton situé à l’extrémité
droite de la barre des onglets).

http://extensions.geckozone.org/SessionSaver
http://extensionroom.mozdev.org/more-info/tabx
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http://extensionroom.mozdev.org/more-info/mimetype-editor 
https://addons.mozilla.org/extensions/moreinfo.php?application=firefox&id=636
http://extensions.geckozone.org/DownloadStatusbar
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MAC OS X

Apple a fait le maximum pour 
rendre Mac OS X utilisable par tous.
Toutefois, dans certains cas, 
des fonctions du système n’ont pas
eu l’honneur de recevoir – encore –
une interface graphique. Aussi,
pour les mettre en œuvre, faut-il
recourir au Terminal et aux lignes
de commandes Unix. Certes, 
cette autre face de Mac OS X est
plus austère, mais toujours 
pratique, voire indispensable.
Je vous propose de voir ensemble
quel est l’intérêt d’utiliser 
ces drôles de commandes, et
surtout comment les décrypter
pour mieux les exploiter.

Quelques notions de base

Pour approfondir votre maîtrise de Mac OS X,

jouez sa partition Unix

A
u détour d’un forum ou en lisant Vous et Vo-
tre Mac, vous avez sûrement vu apparaître
les termes « ligne de commande », «shell»

ou «Terminal». Vous l’aurez sans doute compris,
ces termes sont liés à l’environnement Unix qui
est au cœur de Mac OS X. Le Terminal est un interpréteur de com-
mandes permettant de dialoguer avec le noyau Unix du système. Le
shell, ou «la coquille entourant le noyau», est le langage utilisé pour
dialoguer via le Terminal avec la couche Unix. Enfin, les comman-
des sont ces instructions que vous tapez dans le Terminal et dont le
vocabulaire et la syntaxe varient en fonction du shell que vous avez

choisi d’utiliser. Ces commandes correspondent aux « ordres» que
vous allez donner à votre Mac via la couche Unix. Le décor étant
sommairement posé, je vous invite à découvrir plus en profondeur
l’utilisation de cet environnement et, par des exemples, de compren-
dre pourquoi il est parfois utile, même pour un utilisateur Mac «stan-
dard», d’apprendre à jouer aussi cette partition! n Franck Méréo

Le Terminal est un environnement plutôt
spartiate. Un terminal est constitué 

d’une seule fenêtre correspondant à un shell 
précis . Vous pouvez ouvrir autant 
de fenêtres du Terminal que vous voulez,
et donc autant de shells différents,
ce qui permet de dialoguer avec le noyau
Unix en plusieurs «langues». Ainsi, si un shell
ne connaît pas une instruction particulière,
vous en utilisez un autre différent qui, lui, 
possède cette instruction dans son langage.

Chaque fenêtre du Terminal agissant 
de manière indépendante, un shell 
n’interagit pas avec un autre – sauf dans 
des cas très précis, comme lorsque 
vous demandez à un shell de lister tous 
les logiciels lancés sur votre Mac et que vous
forcez un de ces logiciels à quitter, à partir 
d’un autre shell : il est évident que le premier
shell se mettra à jour de manière dynamique.
On peut donc parler de lien entre les shells,
mais pas de réelle interaction entre eux.

1

1

3

2
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e Dans le Terminal, vous tapez des commandes
précises, comme par exemple, «déplace-moi 
ce fichier à tel endroit.» Vous pouvez préférer 
l’utilisation de logiciels intégrés comme pico ou
emacs, des éditeurs de texte puissants. Ne pensez
pas vous en sortir plus facilement! Ils ne proposent
aucune interface utilisateur graphique. Il existe 
bien un manuel en ligne qui indique les raccourcis
clavier à utiliser pour insérer une ligne 
ou en supprimer une autre, par exemple, mais 
on est très loin de la convivialité d’un traitement 
de texte Mac OS X, même de l’austère TextEdit. 

e Je l’ai dit, il existe plusieurs shells sous Unix. Bien
entendu, les shells propriétaires utilisés sur des Unix
propriétaires comme celui que Sillicon Graphics 
développe pour ses stations d’imagerie 3D haut 
de gamme. Il existe aussi des Unix «libres». Apple 
a fait le choix d’en utiliser un: FreeBSD, supporté par
une communauté de développeurs et de testeurs
conséquente. Cela permet également de réduire 
les coûts de développement du noyau qui est 
le cœur d’Unix. Plusieurs shells basés sur le Bourne
shell (sh) sont disponibles sous OS X: le Bourne shell
(bsh ou bash) qui est le shell par défaut de Mac OS X;
le Korn shell (ksh) ; le C-shell (tcsh) ou encore 
le zsh qui reprend les caractéristiques du C-shell,
mais utilise pour sa part la syntaxe du Bourne shell.

e Dès qu’une fenêtre du Terminal est ouverte, 
vous vous trouvez dans un shell – par défaut, 
le Bourne Shell (bash) depuis Panther. Son nom 
est indiqué dans la barre de titre des fenêtres
du Terminal. Il est important de connaître le shell
dans lequel vous travaillez, car la syntaxe 
des commandes s’en trouve bien entendu affectée.
Pour changer de shell, il suffit de taper son acro-
nyme. Par exemple, tcsh, puis la touche [Entrée]
pour activer le C-shell. La barre de titre de la fenê-
tre change, indiquant que le nouveau shell est actif.

e Autre terme à connaître : le prompt. C’est 
le «point d’insertion» ou «point de saisie» 
dans le Terminal. Symbolisé par un carré noir 
plein, il indique que le Terminal est prêt à recevoir
une nouvelle commande.

e La ligne de commande se décompose 
en plusieurs parties : l’instruction à proprement 
parler (l’ordre de copier un élément, par exemple) ;
ensuite, les différentes options associées 
à cette instruction (par exemple, ne copier que 
les éléments visibles). Suivent la désignation 
de l’élément sur lequel va s’appliquer l’instruction
(tels le nom et l’emplacement du dossier 
à copier) et les options associées (le nouveau 
nom et le nouvel emplacement du dossier à copier).
Enfin, la commande indique quoi faire du résultat
(par exemple, le nombre de fichiers copiés 
avec les éventuelles erreurs rapportées est 
répertorié dans un fichier texte).
Au plan syntaxique, la ligne de commande 
se décompose donc de la manière suivante :
Instruction[espace]-options[espace]élément_
concerné[espace]Que_faire_du_résultat[entrée].
Il est indispensable de taper un espace entre 
chaque commande/option afin que la ligne 
de commande soit correctement interprétée.
Devant les options, un tiret simple indique que 
l’option – ou les options (et dans ce cas un seul tiret
devant la première option suffit) – s’applique 
à l’instruction précédente.

e Il existe un nombre colossal de commandes
(sans compter les différentes options possibles 
pour chacune). Il est donc évident qu’un manuel 
s’avère indispensable. Il existe des milliers de livres 
et manuels sur Unix et ses commandes, certains 
étant d’ailleurs spécialement écrits pour Mac OS X.
Mais le plus simple est de vous référer au manuel
en ligne directement disponible à tout moment
dans le Terminal. Pour consulter ce manuel, tapez
man[espace]nom_de_la_commande_qui_vous_
intéresse[entrée]. Le manuel va s’afficher . 
Là encore, pas d’interface graphique. Pour 
faire défiler le texte, faites [Entrée] ; pour sortir 
du manuel avant la fin de la page, faites [Q].

e Le manuel est par défaut en anglais, mais il est
possible (merci à la communauté open source!) 
de le franciser en téléchargeant les ressources 
nécessaires. Les forums de Mac Bidouille (http://
forum.macbidouille.com/index.php?showtopic=
34256) donnent les différents liens et procédures
d’installation pour franciser le manuel Unix 
disponible en ligne… Il suffit, une fois l’installation
effectuée, de taper man_f[espace]commande
pour accéder au manuel francisé de la commande.

4

3

2

Détaillons un exemple : la commande ls

eee

La commande ls permet de lister le contenu 
d’un dossier. D’abord, affichez le manuel de 

cette commande en tapant man[espace]ls[entrée].
Le manuel s’affiche. Il est composé de plusieurs 
parties délimitées par des titres de section en gras.
NAME: Le nom de la commande concernée 
par la page du manuel.
SYNOPSIS: La syntaxe de l’utilisation 
de la commande avec les options associées.
DESCRIPTION: Explique l’utilité de la commande,

dans quel cas l’utiliser, et liste ensuite les options
une à une en donnant un descriptif de chacune.
EXEMPLE: Propose un ou plusieurs exemples 
d’utilisation de la commande (associée le plus 
souvent à des options).
DIAGNOSTIC: Indications dans le cas de scripts
(mini-programmes) sur le résultat que renvoie 
la commande.
ENVIRONMENT: Indications complémentaires pour
le programmeur sur la commande.

COMPATIBILITY: Informations de compatibilité 
selon certains standards (normes, shell…).
SEE ALSO: Renvoie à des commandes similaires ou
ayant un lien particulier avec la commande donnée.
STANDARD: Souvent en redondance avec 
COMPATIBILITY.
HISTORY: Bref historique de la commande 
(quand elle est apparue, sur quel type de système…).
BUGS: Les différents bogues que peut occasionner
la commande en certaines circonstances.

4
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e Avant de saisir une commande, il est important
de savoir sur quel dossier elle s’appliquera. 
Par défaut, lorsque vous ouvrez une fenêtre 
du Terminal, vous vous trouvez dans le répertoire
de votre compte utilisateur (votre petite 
maison). Pour changer de dossier (de répertoire), 
il convient d’utiliser la commande cd.

e Dans votre répertoire, tapez ls[entrée] .
Vous allez voir s’afficher la liste du contenu visible
de votre dossier de départ. Pour faire apparaître
également les éléments invisibles (leur nom 
commence par un point), il faut utiliser l’option -a.
Tapez : ls -a[entrée]. Souvenez-vous : le tiret 
précise que l’option s’applique à la commande ls.
Attention à bien mettre un espace entre ls et 
le tiret. Le Terminal va lister le contenu complet
(éléments invisibles compris) de votre dossier 
de départ. Pour inverser la liste (avec les éléments
invisibles), utilisez l’option -r et tapez :
ls -a[espace]-r[entrée] ou ls[espace]-ar .
Ce qui peut se traduire en français courantpar 
« liste les éléments du dossier où je me trouve 
par défaut, y compris les invisibles, et inverse 
cette liste avant de me la donner».

e Maintenant, supposons que vous voulez lister 
le contenu d’un dossier (avec les éléments 
invisibles) autre que votre dossier de départ. Il suffit
pour cela de glisser depuis le Finder le dossier 
à lister et de le déposer à la fin de la commande. 
Le chemin dudit dossier s’inscrira automatiquement,
sans que vous ayez à le saisir. Vous obtiendrez 
donc une ligne de commande de ce type:
ls[espace]-ar[espace]/Users/franckmereo/Desk-
top/articles_VVM

e On appelle l’écran une «sortie», car c’est lui 
qui donne le résultat de la ligne de commande. Cela 
dit, vous pouvez modifier cette sortie pour que 
le résultat soit enregistré sous la forme d’un fichier
au format texte. Pour ce faire, utilisez le symbole 
supérieur, comme ceci : ls[espace]-ar[espace]>test.
Le fichier «test» contenant le résultat de la ligne 
de commande sera créé au premier niveau de votre
compte utilisateur. Attention : à chaque fois que

vous lancerez cette commande, le fichier «test»
précédent sera écrasé par un nouveau. Si vous 
voulez compléter le fichier précédent par le résultat
d’une nouvelle commande, il vous faut doubler 
le symbole supérieur comme ci-dessous:
ls -ar >>test
Si le fichier n’existe pas, il sera créé. S’il existe 
déjà, il sera complété par les nouvelles données
sans que le contenu précédent soit effacé.

e Nous allons maintenant réinjecter le résultat
d’une commande ls dans la commande wc
qui permet de compter le nombre de mots, 
de caractères et de bytes (octets) d’un élément.
Le manuel de la commande wc (man[espace]wc
[entrée]) donne la liste des options possibles, 
notamment celle qui compte le nombre de lignes (-l).
Pour lister le contenu de votre dossier de départ
(sans les fichiers invisibles) et réinjecter 
le résultat dans la commande wc qui vous donnera
le nombre d’éléments visibles présents, il faut 
utiliser le symbole «pipe» obtenu par 
la combinaison [Alt L] (le L majuscule). Voici donc 
la ligne de commande correctement formatée: 
ls[espace]|[espace]wc[espace]-l.
Notez que le contenu des éventuels dossiers 
n’est pas listé, il aurait fallu pour cela utiliser 
la récursivité et donc l’option -R associée 
à la commande ls comme suit : ls -R | wc -l 
(n’oubliez pas les espaces). Vous remarquerez
la puissance d’Unix par sa rapidité à lister et compter
tout le contenu de votre dossier de départ.

7

6
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MAC OS X

Problème de droits

Par défaut, le dossier de départ est celui de 
l’utilisateur connecté. Si vous voulez lancer des

commandes sur des dossiers dont vous ne possédez
pas les droits, vous devez vous identifier en tant 
qu’administrateur. Deux solutions s’offrent 
à vous: ouvrir une session Terminal en tant 
qu’administrateur, ou envoyer une commande 
Terminal en tant qu’administrateur temporaire.

Ouvrir une session Terminal en tant 
qu’administrateur
Saisissez dans le Terminal la commande suivante :
login[entrée] .
Le Terminal va vous demander votre nom (login)
d’administrateur. Une fois celui-ci renseigné, 
le Terminal vous demandera votre mot de passe
(password). Vous ne verrez rien s’afficher à l’écran
par sécurité (un petit malin pourrait tenter de lire
votre mot de passe par-dessus votre épaule). 

Validez. Si les renseignements demandés par le 
Terminal ont été correctement donnés, vous verrez
un message de bienvenue (Welcome to Darwin!)
avec le nom de l’administrateur maintenant connecté
suivi du prompt, en attente de nouvelles commandes.
Pour sortir de l’identification administrateur, 
tapez simplement la commande Exit. Le Terminal
vous signalera par logout que votre session 

vient de s’achever et vous rendra alors la main 
sur la session précédente le cas échéant.

Lancer une commande Terminal temporairement
avec les droits d’administrateur
Vous désirez bénéficier des pouvoirs de l’adminis-
trateur juste pour une commande (donc de manière
très temporaire)? À ce moment-là, s’identifier 

8
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Des utilisations pratiques

Pour finir, voici quelques commandes très simples,
mais utiles. Sachez que vous pourrez trouver 

des scripts (mini-applications) directement sur 
Internet. Certains sont très élaborés et peuvent 
se révéler indispensables. Leur code source étant
souvent disponible, les plus curieux d’entre vous les
adapteront à leurs besoins spécifiques. Notez qu’il
existe de nombreux logiciels sous Unix: par défaut
de langage, on parle souvent de commandes 
alors qu’il s’agit de programmes à part entière.

Trouver tous les MP3 présents dans le dossier
de l’utilisateur connecté
find ~ -name "*.mp3"
Le symbole ~ (appelé le «tilde») s’obtient 
par la combinaison [Alt N]. Il désigne le dossier 
de départ de l’utilisateur connecté.

Trouver tous les MP3 présents sur le disque 
de démarrage
sudo find / -name "*.mp3"
Le mot de passe administrateur sera réclamé 
suite au sudo. Le symbole / (appelé «slash») 
correspond quant à lui au volume de démarrage.

Forcer le Mac à redémarrer 
sudo reboot -n
Il est normal de rentrer son mot de passe 
administrateur pour cette commande étant donné
que le système (et donc tous les utilisateurs 
de cette machine) sera affecté par celle-ci.
Je vous suggère de toujours avoir l’application 
Terminal disponible dans votre Dock au cas 
où vous seriez bloqué par le Finder (le Dock étant
indépendant du Finder).

Obtenir le calendrier pour l’année 2006
cal 2006

Créer une image disque depuis un dossier
hdiutil create -srcfolder [dossier d’origine]
[nom_de_l’image_disque].dmg

Graver une image disque 
hdiutil burn [image disque]

Effacer un CD-RW (ou un DVD-RW)
hdituil burn -erase (pour l’effacement rapide)
hdituil burn -fullerase (pour l’effacement long)

en tant qu’administrateur comme
nous l’avons fait ci-dessus n’a que
très peu d’intérêt (d’autant que vous 
risquez de créer une brèche 
de sécurité si vous laissez votre Mac
sans surveillance). Pour lancer 
une commande Terminal avec 
les droits d’administrateur, il suffit 
de précéder la commande de sudo
comme suit : sudo ls 
Le Terminal rappelle les règles 
élémentaires (respecter la vie privée
des autres et réfléchir avant 
de taper sur son clavier) avant 
de vous inviter à saisir votre mot 

de passe (la saisie ne s’affichera pas,
toujours pour des raisons 
de confidentialité) et exécute
votre commande si le mot de passe
(password) est correctement saisi. 
S’il est erroné, la commande est
refusée et « l’incident» est reporté
dans le journal d’activité .
C’est l’équivalent de ce qui se passe
dans l’interface graphique 
de Mac OS X quand vous souhaitez
faire quelque chose de particulier 
et qu’une fenêtre s’affiche 
pour vous demander d’entrer votre
mot de passe d’administrateur.

10
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Les captures d’écran de l’article ne reflètent
pas forcément la fenêtre par défaut 
du Terminal. Pour personnaliser son affichage,
rendez-vous dans Terminal > Réglage 
de la fenêtre…, article Couleur.
Vous pourrez choisir une couleur pour 
le curseur (le prompt), le texte, le texte mis
en surbrillance (sélection) et le texte 
en gras. Vous fixez aussi la couleur de fond
de la fenêtre (si vous installez une image, 
attention à la lisibilité du texte) et 
son niveau de transparence. Ces préférences
ne s’appliqueront qu’à la fenêtre ouverte, 
à moins que vous ne cliquiez sur le bouton
Utiliser comme réglage par défaut.
Vous pouvez enfin choisir la police 
d’affichage (article Affichage du menu local).

Afficher 
les processus actifs
top
Permet de connaître 
tous les processus lancés
sur votre ordinateur 
(car tous ne sont pas 
affichés dans le Dock!)
ainsi que leur taux 
d’occupation processeur. 
Tapez [q] pour sortir 
de cette commande.

11

Préférences
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MAC OS X

Pour être sûr de tout retrouver, apprenez à

bien utiliser Spotlight

S’il est une fonction de Tiger qui déchaîne les passions, c’est bien Spotlight ! En modifiant 
en profondeur la méthode pour retrouver des informations présentes sur vos disques, 
Mac OS X 10.4 s’est rendu indispensable aux uns et presque insupportable aux autres! Pourtant, 
des astuces existent pour en tirer pleinement parti.

Q
u’il s’agisse de vidéos, de photos, ou même de simples tex-
tes, les disques durs de nos Mac contiennent de plus en plus
de fichiers et de documents. Le prix du stockage baissant

sans arrêt, il n’est plus rare de posséder aujourd’hui un copieux
disque dur externe qui vient compléter un disque de démarrage qui
lui aussi dépasse la plupart du temps les 100, voire les 200 Go.
Nos besoins – ou notre paresse à faire le tri – nous incitent à les
remplir sans trop y regarder. Mais dans ces conditions, remettre
la main sur « la» photo qu’il vous faut envoyer à un client dans
la seconde, ou « le » mail de tante Agathe parmi les milliers que
contient votre base de données, s’apparente assez vite à la recher-
che d’une aiguille dans une meule de foin !
C’est pour répondre à cette problématique que Spotlight a été in-
venté par les ingénieurs d’Apple. La première étape consiste en un
«simple» balayage du disque dur (qui peut prendre plus ou moins
de temps selon sa taille). Au cours de cette étape, Spotlight va ré-
férencer les caractéristiques de chaque fichier qu’il connaît, no-
tamment leurs métadonnées, et en indexer le contenu.Le tout est
placé dans une base de données spécifique qui sera interrogée par
la suite lors de vos recherches. Ce processus est bien plus rapide

que si Spotlight devait parcourir de nouveau le disque en entier à
chaque fois. Cette base de données est mise à jour en permanence
sans que vous vous en rendiez compte. Les informations qu’elle
contient dépendent de chaque fichier. Un fichier MP3, par exem-
ple, contient plus ou moins de métadonnées selon que vous avez
référencé ou non les fameux «tags» ID3 (artiste, compositeur…).
Un document Word offre beaucoup moins de caractéristiques uti-
lisables. Une photo proposera à la fois des données issues de la
prise de vue – et donc « écrites » par l’appareil photo (données
Exif) – et des informations éventuellement entrées ensuite par l’uti-
lisateur dans iPhoto ou iViewMedia Pro.
Avec Spotlight, on peut donc tout retrouver… Mais c’est là aussi
son principal défaut! Si vous recherchez une information présente
à maintes reprises sur votre disque dur, la recherche devient très
vite fastidieuse, ou pire, fait apparaître l’horrible ballon de plage
multicolore. Chez moi, entre les articles, les logs iChat et les emails
envoyés par des correspondants « @mac.com », le mot « Mac »
pose ainsi quelques problèmes à Spotlight! Heureusement, il existe
des solutions pour le domestiquer un peu et l’optimiser. Décou-
vrons-les tout de suite ensemble. n JJeeaann--CChhrriissttoopphhee VViiggnneess
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Spotlight à la loupe
e Diamétralement opposé au menu Pomme, 
la loupe de Spotlight est elle aussi omniprésente: 
il est donc possible de lancer une recherche 
de n’importe où et à tout moment, sans repasser par
le Finder. Il suffit d’un clic sur cette petite loupe 
ou d’un simple raccourci clavier ([Cmd Espace]).
Attention cependant, si vous avez activé le menu
Saisie (celui qui permet de changer de clavier, par
exemple) via le panneau des Préférences système,
puis International, il y aura conflit, le même raccourci
étant prévu pour les deux fonctions! Il faudra donc
le modifier dans les Préférences système, soit 
dans le panneau Souris et clavier, onglet Raccourcis
clavier, soit dans le panneau Spotlight. Par exemple,
choisissez [Ctrl Espace] pour le menu Spotlight 
et [Ctrl Maj Espace] pour la fenêtre Spotlight . 

e Quelle que soit la méthode d’appel utilisée, 
le champ de recherche Spotlight apparaît dans 
le coin supérieur droit de l’écran. La magie opère…
Avant cela – et pour renforcer la pertinence 
de la recherche –, je vous invite à vous rendre dans 
le panneau Spotlight des Préférences système. Outre
le changement des raccourcis clavier, vous pourrez 
y choisir quel type de document sera pris 
en compte lors d’une recherche… Suivant le nombre
de documents que contient votre disque dur et 
le type de recherche que vous faites le plus souvent,
vous accélérerez sans doute vos recherches 
en évitant les fichiers Keynote, par exemple! L’onglet
Confidentialité est également important 
pour exclure certains volumes ou simples dossiers
de l’indexation (ainsi, il ne sert à rien pour la plupart
d’entre nous d’indexer les dossiers système).

e Une fois la recherche effectuée, les résultats
peuvent être affichés de plusieurs manières. 
La plus courante, qui est aussi la moins fine, 
se contente de lister les éléments trouvés sous 
le menu Loupe. Un clic sur Tout montrer affiche 
une fenêtre plus complète qui permet de trier 
les résultats selon plusieurs critères .4

3

2

1

e Les bibliothécaires le savent bien : pour affiner
une recherche informatique, rien de tel 
que les « opérateurs ». En complétant la chaîne 
de caractères à rechercher avec un terme 
« logique », vous pouvez limiter ou orienter 
le champ de résultats. Par exemple, chercher 
«Apple ET Mac» ne retournera que les documents
qui comprennent ces deux termes. «Vous OU Mac» 
proposera l’ensemble des documents contenant
l’un ou l’autre. Il est aussi possible de grouper 
les termes de recherche tandis que «Apple PAS
iPod» omettra, par exemple, les informations 

sur le baladeur MP3 (et rendra toute sa place 
au Mac !). Voilà pour la théorie… Tout serait parfait
si Spotlight respectait les conventions 
internationales les plus connues et reprenait, 
par exemple, la traduction anglaise des opérateurs
classiques (OR, AND, NOT…) Malheureusement, 
la société de Cupertino utilise une convention 
qui lui est propre :
OU | (pipe = [Alt Maj L])
PAS - (tiret simple)
ET Espace
GROUPER ( ) (parenthèses simples)

e En pratique, pour trouver la plupart
des produits Apple, on entrera dans le champ
Spotlight l’expression « iPod | Mac » 
qui retourne tous les éléments qui contiennent 
le mot « iPod » OU le mot « Mac ». Pour focaliser 
la recherche sur les Mac en tant que machines,
sans prendre en compte les informations 
sur Mac OS, la requête sera du type « Mac –OS », 
ce qui signifie rechercher le mot « Mac », sauf 
si la phrase contient aussi « OS »). Curieusement,
l’opérateur ET est l’espace, pas le « + » : 
taper « Apple iPod » retournera seulement 

1

4

2
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Demandez l’opérateur !
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les documents qui contiennent les deux termes ensemble. Par ailleurs, 
au lieu des guillemets auxquels les utilisateurs de mots-clés sont habitués 
pour grouper les termes de recherche, Apple choisit les parenthèses… Dommage
que l’innovation de Spotlight passe par ce bouleversement bien inutile.
Cependant, même si cela semble un peu complexe au premier abord, maîtriser
ces opérateurs permet d’effectuer des recherches complexes beaucoup 
plus précises. Par exemple, «mickey|donald(-disney)» s’intéressera aux deux
personnages connus… mais pas à leur créateur .5

5

Jonglez avec les attributs 
de recherche
e La puissance de Spotlight ne se limite pas à la recherche de fichiers ou dans
le contenu de documents. Apple l’a intégré un peu partout dans Mac OS X 10.4. 
Le premier endroit à connaître est bien entendu le Finder. Les fameux «dossiers
intelligents» reposent ainsi entièrement sur Spotlight. Vous entrez les critères 
de recherche une fois, et l’ensemble des fichiers correspondants est regroupé
dynamiquement dans un dossier intelligent – sous forme d’alias, bien sûr, 
les fichiers eux-mêmes ne bougeant pas. Le principe est séduisant et l’est encore
plus en pratique puisque toutes les applications supportant Spotlight ou les plug-
in d’intégration proposent leur lot d’attributs de recherche supplémentaires 
(auxquels vous accédez dans la zone de composition de la requête grâce 
à l’article Autre… des menus locaux). Vous pouvez ainsi créer un dossier intelli-
gent qui regroupera des photos prises avec flash et avec un diamètre d’ouver-
ture précis . Attention à bien choisir les attributs utilisés dans la requête ; 
je dispose sur mon Mac d’au moins deux Ouverture, l’un se rapporte à l’ouver-
ture d’un fichier, l’autre à l’ouverture de diaphragme d’un appareil photo.

e On peut aller encore plus loin grâce à l’attribut Requête brute (Raw Query,
en anglais). Ainsi, pour regrouper dans un dossier l’ensemble des fichiers 
créés ou modifiés il y a sept jours, il suffit d’écrire la requête suivante : 
kMDItemAttributChangeDate >= $time.today(-7) qui s’explique de la manière
suivante : kMDItemAttributChangeDate est l’attribut «date de modification 
du document», >= est l’opérateur logique qui signifie «supérieur ou égal»,
$time.today est la date d’aujourd’hui telle qu’elle est donnée par l’horloge 
interne du Mac et (-7) signifie «sept jours avant la date d’aujourd’hui». 
Pour calculer en minutes et non plus en jours – afin de trouver les documents 
modifiés il y a quelques instants, par exemple –, on utilisera la fonction
$time.now (NOMBRE), avec NOMBRE qui désigne une durée en secondes. 
Pour trouver les fichiers créés il y a trois heures, on utilise donc la fonction: 
kMDItemContentCreationDate >= $time.now(-10800) (trois heures font 
en effet 10800 secondes!). 

e Pour trouver d’autres attributs (kMD…), le plus simple est d’utiliser 
la commande mdls dans le Terminal. Après le prompt, tapez mdls[Espace] 
et glissez un de vos logiciels ou un fichier (son chemin d’accès s’inscrit automati-
quement) et faites [Entrée]. L’ensemble des attributs de l’élément s’affichent .
Vous pouvez composer des requêtes Spotlight qui en profitent. On découvre ainsi
qu’un fichier MP3 offre, entre autres, les attributs kMDItemAuthors (qui chante?)
et kMDItemAudioBitRate (128, 160 ou 192), et que les attributs d’un fichier 
PDF couvrent aussi bien l’application qui a servi à le créer que sa description
sommaire, son auteur… Une mine d’informations pour qui veut l’exploiter!
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Questionnez par type
e Par défaut, Spotlight cherche tout, absolument tout! Si vous tapez votre nom
de famille, vous risquez ainsi de trouver plusieurs centaines d’éléments 
correspondants. Heureusement, il existe encore une astuce pour encadrer 
vos recherches. C’est la commande type. Attention, le site américain d’Apple 
propose une série d’informations sur le sujet, mais il utilise évidemment 
le mot anglais «kind». Pourtant, sur notre version française de Tiger, seul «type»
est reconnu. La syntaxe est très simple : vous tapez d’abord le mot 
(ou le groupe de mots) à rechercher suivi de «type: » (pas d’espace entre type 
et «:») et le type concerné, comme dans la liste (non exhaustive) ci-dessous.

applications type:application, type:applications, type:app
contacts type:contact, type:contacts
dossier type:dossier, type: dossier
email type:email, type:emails
événements iCal type: événement, type: événements
tâches iCal type:tâche, type:tâches
images type:image, type:images
séquences type:séquence, type:séquences
musique type:musique

audio type:audio
PDF type:pdf, type:pdfs
préférences type:préférences système, type:préférences
signets type:signet, type:signets
polices type:police, type:polices
présentations type:présentations, type:présentation

e Attention, Spotlight est chatouilleux sur l’orthographe. Ainsi, 
«presentation» sans accent ne donnera rien, tout comme «tache», 
alors que «présentation» trouvera sans coup férir vos fichiers Keynote 
et PowerPoint. Il faut aussi bien écrire «musique» et non pas «music».

9

L’utilitaire Spotlight supporte un certain nombre 
de documents génériques et d’applications, 
la plupart du temps créés par Apple, mais pas 
seulement : les documents Word, Excel et Power-
Point, par exemple, sont également pris en charge. 
Malheureusement, Entourage est insensible à toute
recherche – Microsoft a promis d’y travailler, mais
on attend toujours… Reste que de plus en plus 
de logiciels, même créés par de petits éditeurs,
sont fournis aujourd’hui avec un plug-in Spotlight,
qu’on appelle génériquement un « importer ». 
Ou alors, des tiers en ont développé un. L’importer
communique à Spotlight les informations 
nécessaires sur les documents qu’il gère et qui
peuvent ainsi être indexés et retrouvés. 
Apple recense sur son site les applications 
compatibles Spotlight et les plug-in existants.
Cette base de données, qui n’a qu’une cinquantaine 
d’entrées (il existe beaucoup plus d’applications 
compatibles aujourd’hui), se trouve à l’adresse :
www.apple.com/downloads/macosx/spotlight/. 
Vous pouvez aussi effectuer une recherche Google 
sur l’expression « spotlight importer » ou 
« spotlight plugin ». J’apprécie particulièrement
deux plug-in : un non-officiel dédié 
aux enregistrements produits par le magnétoscope
numérique EyeTV (http://aneyetvimporter.
sourceforge.net/) et Ziplight qui déniche 
les fichiers au cœur d’une archive Zip (www.
bartastechnologies.com/products/ziplight/). 

e Il faut remonter à la première version du Dock
pour trouver une technologie Apple autant critiquée
sur Internet. Spotlight: trop lent, trop complexe 
pour les recherches simples… En innovant, Apple 
a bouleversé les habitudes des utilisateurs et, ce qui
est plus grave, parfois compliqué inutilement 
les choses les plus simples. L’exemple le plus 
frappant est la recherche «au fil de la frappe» 
de Spotlight. Lorsque vous commencez à saisir 
un mot dans le champ de recherche, Spotlight 
commence à travailler instantanément, sans que
l’utilisateur ait à appuyer sur [Retour] ou cliquer sur
un quelconque bouton. En théorie, c’est plus rapide…
En pratique, c’est souvent désastreux puisque pour
rechercher (par exemple) «Macaréna», Spotlight 
va d’abord chercher sur M, puis sur Ma, puis Mac…
Une perte de temps considérable si vous n’avez
qu’un ou deux documents concernant la célèbre
danse sur votre gros disque dur! La mise à jour 
en Mac OS X 10.4.3 a apporté une amélioration 
sensible. Avant de commencer, Spotlight vous laisse
le temps de saisir plusieurs lettres (à condition 
que vous ayez une vitesse de frappe normale). 

e Pour créer une requête complexe, mieux vaut 
la composer dans TextEdit, par exemple, puis 
la copier pour la coller dans le champ Spotlight 
qui la prendra bien en compte dès le départ
dans sa globalité. Utilisez la même technique pour
effectuer une recherche sur une expression 
composée de plusieurs mots. Ce n’est certes pas 
très transparent, mais en attendant une solution
plus élégante, avec un peu de pratique et en enchaî-
nant trois raccourcis clavier (maintenez la touche
[Cmd] enfoncée, puis faites [C], [Espace] et [V])
on s’en sort très bien et cela devient une habitude.

e Vous pouvez aussi donner à Spotlight plus 
de «clés» pour trouver des éléments particuliers.
Bonne technique: utilisez le champ Commentaires
Spotlight de la fenêtre Lire les informations.
On peut aussi mettre au travail Automator pour 
le faire automatiquement, ou même des outils 
du domaine public (Batch Apply Spotlight Keywords)
pour ajouter des mots-clés à un groupe de fichiers. 

e Il est également important de profiter au mieux 
de ce qu’offrent les applications existantes. Ainsi 
de bons «tags» saisis dans iTunes (Artiste, Album…)
permettent de trouver beaucoup plus facilement 
les fichiers MP3 tandis qu’iPhoto et ses «mots-clés»
feront merveille pour trouver le bon cliché! 

10
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Contournez certaines limitations
Applications 
et plug-in
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Comment réparer l’outil 
de recherche Spotlight?

S
potlight a beau être un outil de recherche puissant et qui 
se met à jour en temps réel, vous serez peut-être amené 
à reconstruire son index. En effet, il peut arriver que 

sa base de recherche soit corrompue, par exemple si votre Mac
plante au milieu d’une recherche. Pour cela, dans un Terminal,
tapez la commande suivante : sudo mdutil -E /
Le système vous demandera alors le mot de passe de votre compte.
Notez qu’il faut posséder un compte administrateur pour effectuer
cette manipulation. Une fois que vous l’aurez entré et validé, 
l’index actuel sera effacé et Spotlight en recréera un automati-
quement. Soyez patient car cela peut prendre un long moment…

Comment mémoriser des mots de passe?

Nos amis du laboratoire SUPINFO des technologies Apple 
ont réalisé un livre très pratique édité par Eyrolles.
Ce dernier nous fait l’immense plaisir de vous offrir 
quelques questions et réponses puisées dans cet ouvrage 
par la rédaction de Vous et Votre Mac.

Comment copier un CD-Rom 
ou un DVD-Rom?

M
ême si vous ne disposez pas du logiciel Toast sous Mac 
OS X, il vous est toutefois possible de réaliser une copie
conforme d’un CD-Rom ou DVD-Rom de données grâce 

à l’application Utilitaire de disque. Il s’agit de réaliser une image
de votre CD/DVD-Rom original, puis de la graver sur un disque
vierge. Cette méthode s’avère plus complexe que celle proposée
par Toast (où il suffit de cliquer sur un simple bouton), 
mais elle vous garantira néanmoins un résultat sûr et fiable.
Votre CD-Rom copié sera en tout point identique à l’original.

e Attention, nous ne traitons dans cette question que 
des CD-Rom et DVD-Rom de données. Cette méthode ne fonctionne
donc ni pour les DVD de films, ni pour les CD-audio.

LLééggaalliittéé ::
Ne réalisez des copies de CD-Rom ou de DVD-Rom commerciaux
(logiciels, jeux…) que pour votre usage personnel 
afin d’être en conformité avec les licences d’utilisation 
de ces produits. Il s’agit ici uniquement de réaliser des CD-Rom
ou des DVD-Rom de sauvegarde.

Mac OS X Tiger : 300 questions & réponses 
15 € ISBN : 2-212-11750-7
Éditeur : Eyrolles

Comment afficher les mots 
de passe stockés sur votre Mac?

V
otre trousseau par défaut se nomme Session. Pour retrouver tous les mots de passe
qu’il contient, ouvrez l’utilitaire Trousseau d’accès à partir du dossier /Applications/
Utilitaires. Cliquez sur Session dans la liste des trousseaux. Vous verrez que 

ce trousseau est organisé en catégories : Tous les éléments, Mots de passe, Certificats…
Pour visualiser le mot de passe de l’une des entrées de votre trousseau, double-cliquez 
sur son nom dans la liste. Dans la nouvelle fenêtre, cochez la case Afficher le mot 
de passe. Une fenêtre vous demande le mot de passe de votre trousseau avant 
d’accéder à votre requète. Par défaut, le mot de passe de votre trousseau est celui 
de votre compte utilisateur… Vous pouvez choisir de refuser de montrer 
ce mot de passe, d’autoriser une fois ou de toujours autoriser sa visualisation. 
Autorisez une fois (pour vous assurer davantage de sécurité) et votre mot de passe 
apparaît dans le champ prévu à cet effet.

Q
u’il s’agisse d’ouvrir votre session, 
de relever vos emails, de vous
connecter à votre site Internet 

préféré, il vous faut retenir un très grand 
nombre de mots de passe différents. 
Heureusement, sous Mac OS X, le Trousseau
se charge de retenir tous vos mots 
de passe – si vous l’y autorisez – et de les
attribuer à votre session. Ainsi, à chaque
démarrage de votre ordinateur, le système

saura exactement quels mots de passe 
utiliser pour quelles applications, 
et surtout pour quel utilisateur! Si vous 
le souhaitez, lorsqu’une fenêtre vous
demandant si vous désirez conserver 
le mot de passe dans le Trousseau apparaît,
cliquez simplement sur Oui. Le mot 
de passe sera automatiquement ajouté 
à votre Trousseau, ainsi que les informations
liées à son utilisation.
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Comment effacer les langues
inutiles sur votre disque dur?

Comment personnaliser le fond
de vos CD ou DVD-Rom?

V
ous pouvez personnaliser un CD-Rom 
en modifiant le fond de sa fenêtre. 
Insérez votre disque vierge ou créez 

un dossier à graver et ouvrez-le. Utilisez 
l’affichage en icônes et faites un [Ctrl clic] ou
clic droit sur le fond de la fenêtre. Sélectionnez
Afficher les options de présentation. Une palette
apparaît avec davantage d’options. Cochez 
Uniquement cette fenêtre, sinon toutes celles 
du Finder appliqueront la modification. 
À la rubrique Arrière-plan, si vous désirez juste
appliquer une couleur, choisissez Couleur.
Un petit carré blanc s’affiche : cliquez dessus
pour modifier la couleur. Vous pouvez aussi 
installer une image : sélectionnez Image,
puis cliquez sur Choisir. Une fois que vous êtes
satisfait de votre choix, gravez votre disque.

P
ar défaut, Mac OS X s’installe avec de nombreuses langues disponibles.
Vous n’en avez certainement pas l’utilité, alors pourquoi encombrer 
votre disque dur? Pour les effacer, il vous faudra télécharger la version 

de démonstration de l’utilitaire TinkerTool System (en anglais) à l’adresse 
suivante : http://www.bresink.de/osx/TinkerToolSys.html
Installez et lancez TinkerTool System. Cliquez sur le bouton International.
Dans la liste, sélectionnez les langues que vous souhaitez supprimer. 
Notez la présence du bouton Select all qui va cocher toutes les langues ; 
dans ce cas, décochez ensuite la case French. Vous ne pouvez pas supprimer
l’anglais qui apparaît en grisé, car il s’avère nécessaire au système.
Afin d’effacer certaines langues tout en conservant leurs correcteurs 
orthographiques, veillez à bien cocher la case Don’t remove spell checker,
speek, and summary dictionaries. TinkerTool System doit parcourir tout 
votre système pour effacer les fichiers de langues. Dans le champ Remove 

from folder or volume, entrez «/» qui correspond à la racine de votre disque
dur. Appuyez ensuite sur le bouton Delete selected packages… pour effacer 
les langues sélectionnées.

Comment importer une fiche 
dans votre Carnet d’adresses?

D
ans le Carnet d’adresses, rendez-vous dans le menu Fichier > Importer.
Trois types de cartes de visite sont reconnus: le format vCard (des applica-
tions comme Palm Desktop, Entourage et Outlook permettent de créer des

fiches à ce format) ; le format LDIF(Lightweight Directory Interchange Format…
des logiciels comme Netscape génèrent de telles cartes) est un format de fichier
ASCII utilisé entre des serveurs LDAP. Enfin, le format Texte: sont comprises 
dans ce format les fiches au format CSV (Comma Separated Values, générées 
par le Carnet d’adresses d’Outlook Express, par exemple). Choisissez 
le type de cartes correspondant à celui de la fiche à importer, puis parcourez
votre ordinateur jusqu’à celle-ci. Bien sûr, vous avez la possibilité de double-
cliquer directement sur une vCard que vous venez de recevoir 
afin qu’elle soit ajoutée automatiquement à votre Carnet d’adresses.

Comment sauvegarder vos courriels?

P
our éviter la perte de tous vos courriels (les risques sont bien plus nombreux que 
vous ne l’imaginez), la bonne idée consiste à sauvegarder régulièrement le contenu 
de vos comptes Mail. Pour cela, rendez-vous dans le répertoire Bibliothèque 

de votre compte utilisateur, vous y trouverez un dossier Mail qui contient tous les éléments,
notamment les emails de vos différentes boîtes aux lettres. Copiez ce dossier Mail en lieu sûr,
sur un support optique, un disque dur externe, ou sur votre iDisk ou encore un espace FTP. 
N’oubliez pas non plus de sauvegarder le fichier com.apple.mail.plist qui se trouve 
dans Bibliothèque/Préférences de votre compte (il décrit, entre autres, l’architecture 
de vos boîtes aux lettres). Lors d’une réinstallation système, il suffira de recopier le dossier 
et la plist aux bons endroits pour recouvrer une configuration totalement fonctionnelle.
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Savez-vous que http://17.254.0.91/ regorge d’informations 
sur les Mac, mais que les recherches sur http://216.239.59.103 
sont plus complètes que sur http://213.199.159.90? 
Voilà à quoi ressembleraient les liens sans le DNS! Nos ordinateurs
se complaisent à traiter des chiffres, et sur le Net leurs puces 
ne voient qu’adresses IP. Or, nous les humains, nous préférons 
les lettres, www.apple.com se mémorisant mieux que 17.254.0.91.
Comment donc cette «magie» fonctionne-t-elle?

DNS: clé de voûte de

l’Internet

Comment ça marche?

Q
uand fut créé l’Internet, chaque ordi-
nateur possédait un fichier avec le
«nom» du serveur et son adresse IP. À

partir de ce fichier «host» (hôte en français),
on établissait la correspondance entre l’adres-
se IP et le site Web. Ce principe essentiel s’ap-
pelle la «résolution de nom».
Lorsque vous «déposez» un nom, l’autorité
d’enregistrement (par exemple, l’Afnic qui
gère les .fr) affecte une adresse IP à votre nom
de domaine. Cette information pourrait être
pertinente au sein d’un système statique, oui
mais voilà, ce qui est vrai aujourd’hui ne le
sera peut-être plus demain. Les sites dispa-
raissent aussi rapidement qu’ils se créent et
les adresses IP, devenues de plus en plus ra-
res, sont réutilisées. D’où la création de ser-
veurs de résolution de noms dont l’objectif
est de fournir une information à jour afin que
votre Mac puisse obtenir la bonne adresse IP
pour atteindre le site Web voulu.
Votre Mac interroge le serveur DNS de vo-
tre fournisseur d’accès. Si celui-ci ne sait pas

répondre à votre requête, il monte un cran
plus haut et ainsi de suite jusqu’à interroger
in fine un des treize serveurs primaires (DNS
root servers). La liste de tous les serveurs ainsi
que quelques informations complémentaires
peuvent être trouvées à l’adressehttp://www. 
root-servers.org/. La majorité d’entre eux sont
la propriété d’organisations américaines… Si
votre Mac ne sait pas trouver un serveur, vous
obtiendrez dans Safari le message suivant .
Avant d’accéder au site Web www.apple.com,
votre ordinateur doit donc impérativement
trouver l’adresse IP qui correspond à ce site.

Il s’agit là d’un principe de base des commu-
nications sur l’Internet: les ordinateurs com-
muniquent entre eux d’adresse IP à adresse
IP. Sans cette adresse, votre Mac ne peut ac-

céder au serveur sur lequel se trouvent les pa-
ges HTML. Identifier la correspondance en-

tre un site Web et une adresse IP s’appelle la
«résolution d’adresse». Voyons plus préci-
sément comment cela se passe… 

n Henri-Dominique Rapin

1

La résolution d’un nom Internet se fait en plusieurs étapes. D’abord, Mac OS X
consulte son fichier hosts, un document texte qui se trouve à l’emplacement

/etc/hosts. Si le nom du site recherché est présent dans ce fichier, Mac OS 
aura l’adresse IP qu’il devra indiquer pour atteindre le serveur correspondant 
à ce site. Pour voir son contenu, tapez dans le Terminal, après le prompt :
less /etc/hosts. Si aucune référence ne correspond au site recherché, 
Mac OS X passera alors à l’étape suivante. L’OS interroge le premier serveur DNS 
et, sans réponse, le second serveur (dit de backup). Si aucune adresse IP 
ne correspond dans le fichier hosts ou n’a pas été renvoyée par un serveur DNS,
Safari indique que le site n’est pas joignable.

Sur Mac OS X, la résolution des noms est déléguée à un processus 
(un démon), dénommé lookup, qui tourne en tâche de fond; il gère un ensemble
«d’agents». Tous ont une mission claire : exécuter une recherche 
sur une cible bien précise. Il existe ainsi un agent pour lire le fichier hosts, 
un autre pour contacter les serveurs DNS, un autre dédié à la base NetInfo… 
Les agents sont exécutés dans un ordre bien précis. Pour obtenir l’ordre 
dans lequel les agents sont lancés, il est nécessaire d’exécuter la commande 
suivante dans le Terminal : llooookkuuppdd ––ccoonnffiigguurraattiioonn..
Vous obtiendrez immédiatement un résultat similaire à celui-ci (avec un peu 
plus de lignes) .2
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Les lignes qui nous intéressent sont :
LookupOrder: Cache FF DNS NI DS
_config_name: Host Configuration
Elles définissent l’ordre utilisé pour effectuer 
la résolution ou, en termes plus appropriés, l’ordre
dans lequel les agents sont exécutés…
Cache = Zone temporaire où sont stockés les noms
déjà résolus (temporairement).
FF = Flat File (fichier plat : /etc/hosts).
DNS = Serveur DNS.

NI = NetInfo (base d’infos au cœur de Mac OS X). 
DS = Directory Service (LDAP, annuaire 
d’un ensemble d’ordinateurs composant un domaine).
Précision à propos du cache: lorsqu’un nom 
est résolu, en même temps que son adresse IP, 
une «durée de vie» (TTL = Time To Live) est fournie,
qui fixe le temps pendant lequel l’information 
restera présente (par défaut, 12 h). Pour vider 
le cache, utilisez la commande suivante : 
lookupd –flushcache

Fournir de fausses informations 
pour les résolutions

eee

Dans certains cas, il est intéressant de rendre 
un site inaccessible ou de restreindre l’accès 

à une liste de sites.
Pour ce faire, il faut modifier les informations 
recueillies par les agents de la fonction lookupd.

Avant de modifier le fichier hosts, vous devez 
impérativement en faire une copie. 
Tapez dans le Terminal la ligne de commande:
sudo cp /etc/hosts /etc/hosts.old
L’actuel fichier hosts est dupliqué et portera le nom
hosts.old. Si vous ne comprenez pas le sens 
de cette commande, je vous invite à lire dans 
ce même numéro de VVMac un article d’introduction
à la ligne de commande Unix où il est notamment
question de la commande sudo.

Désactivez l’accès à un site 
via le fichier hosts
Pour quoi faire? Il existe des sites indésirables et
vous souhaitez éviter que vos enfants y accèdent.
Modifier le fichier hosts peut vous venir en aide. 
Autre exemple, le spam. Il n’est pas rare qu’un email
contienne un fichier Gif blanc (donc invisible) : si cet
email est ouvert, le fichier caché sera «récupéré»
sur le site du spameur qui sera ainsi certain 
que votre adresse est valide. Bannissez ce site et
plus aucune information ne lui sera envoyée.
En pratique, vous avez besoin du(des) nom(s) 
de site(s) et vous devez éditer le fichier hosts.
Tout accès ou modification sur des fichiers 
de configuration nécessitent un accès root (super
administrateur). La commande sudo va nous 
le fournir. Soit vous le faites sous Unix et tapez 
dans le Terminal la ligne de commande:
sudo pico /etc/hosts
(pico est un éditeur de texte Unix ; sauf à bien 
le maîtriser, préférez la méthode suivante).
Soit vous le faites sous Mac OS X et tapez dans 
le Terminal :
sudo /Applications/TextEdit.app/Contents/ 
MacOS/Textedit /etc/hosts (en une seule ligne 

et en respectant l’espace). Le fichier hosts 
s’ouvrira alors dans TextEdit et vous pourrez 
le modifier facilement.

La modification consiste à ajouter la ligne suivante
en fin de fichier : 
0.0.0.0 www.nom_du_site.com 
(avec un espace entre l’adresse IP et le nom du site) 
Bien sûr, vous précisez le nom du site à bannir.
Enregistrez et fermez. À compter de cet instant, 
toutes les requêtes vers le site www.nom_du_site.
com pointeront vers l’adresse IP 0.0.0.0. Comme 
celle-ci n’existe pas, le site devient inaccessible.
Répétez cette opération pour tous les sites 
que vous souhaitez rendre injoignables.

Redirigez l’URL d’un site 
vers un autre via le fichier hosts
On peut imaginer que vous avez besoin 
de «tromper» votre navigateur en lui fournissant
une mauvaise adresse IP.
Procédez de la même manière que précédemment 
et ajoutez une ligne au fichier hosts :
17.254.0.91 www.microsoft.com 
(cet exemple est bien sûr dénué de tout parti pris !).

Autorisez l’accès à une liste de sites 
via le fichier hosts et Config DNS
Inversement, vous souhaitez que vos enfants 
n’accèdent qu’à certains sites bien définis. 
Là encore, la modification du fichier hosts peut 
garantir vos desiderata!
C’est un peu plus compliqué: il faut désactiver 
la résolution par DNS. Dans les Préférences 
système, panneau Réseau, retirez les adresses 
IP des serveurs DNS. Plus aucun site ne sera 
accessible (pas même le site de mise à jour d’Apple
swscan.apple.com)!
Ensuite, enregistrez la liste des serveurs autorisés
et leurs adresses IP dans le fichier hosts. 
Seuls (et uniquement) les sites listés dans le fichier
hosts seront visibles par vos enfants !
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Ajoutez un enregistrement dans la base NetInfo
Nous savons comment obtenir l’ordre utilisé par lookupd pour effectuer 
ces recherches. Il est possible de le modifier. Nous pourrions envisager d’utiliser
une recherche sur la base NetInfo avant d’envoyer une requête 
sur un serveur DNS. Dans ce cas, l’ordre serait le suivant : CACHE FF NI DNS.
Si vous souhaitez ajouter un enregistrement dans la base NetInfo, il faut utiliser
l’utilitaire Gestionnaire NetInfo, puis ajouter une nouvelle propriété à la rubrique
«machines» avec les propriétés «IP_addresses» et «name» correspondant 
au site à bannir. Toutefois, je vous déconseille fortement de jouer avec NetInfo…

Vérifiez les modifications
Lancez simplement Safari et saisissez l’URL d’un site précis. Si vous avez 
décidé de le rendre inaccessible, Safari ne pourra pas atteindre l’adresse IP
0.0.0.0 et vous obtiendrez donc un message d’erreur.
Une autre méthode consiste à interroger lookupd. Pour ce faire, il faut 
«dialoguer avec lui» via le Terminal. Lancez la commande:
lookupd -d
Vous obtenez :
lookupd version 365 (root 2005.03.21 00:20:06 UTC)
Enter command name, "help", or "quit" to exit
>
Tapez? pour obtenir toutes les commandes acceptées par lookupd
Pour demander quelle est l’adresse d’un site, la commande est : 
Hostwithname
Tapez «Ho» (respectez bien la casse), puis appuyez sur la touche [Tab] :
la commande devrait s’autocompléter. À la suite de la commande, entrez
l’adresse du site visé, www.apple.com par exemple, ce qui donne:
> hostWithName: www.apple.com

Voici les résultats que vous obtiendrez . Le site d’Apple est accessible 
à l’adresse IP 17.254.0.91, et cette réponse est donnée par l’agent DNS 
sur le serveur DNS 192.168.1.251.
Vous pourriez aussi utiliser la commande hostwithInternetAddress
pour découvrir qui se cache derrière une adresse IP. Lancez la commande:

> hostWithInternetAddress: 17.254.0.91
(tapez «quit» pour sortir de lookupd).
Le programme lookupd est bien plus qu’un simple « inspecteur d’adresses».
Pour en savoir plus sur lookupd, rendez-vous à l’adresse : http://developer.
apple.com/documentation/Darwin/Reference/ManPages/man8/lookupd.8.html.
Ou encore, lancez la commande man lookupd pour accéder à la documentation 
de cette commande.

3

Hostal, le shareware à utiliser avec prudence…

Le logiciel Hostal permet d’éditer le fichier hosts et de bannir (ou bloquer) 
des sites Web en les ajoutant au fichier hosts avec l’adresse IP 0.0.0.0. Vous 

le téléchargez depuis l’adresse http://www.northernsoftworks.com/hostal.html.
Attention, si vous n’y prenez pas garde, lors de la première utilisation, 
tous les sites listés seront bloqués par défaut et vous risquez de vous retrouver 
avec une pléthore de lignes ajoutées dans le fichier hosts.
Vous pouvez cependant créer votre liste et ajouter (ou non) des sites.
Le premier onglet Mapped Hosts permet de créer une redirection d’IP 

avec l’option TTL. Dans ce cas, une ligne sera créée dans votre fichier hosts 
avec 17.254.0.91 comme adresse IP pour le site www.microsoft.com. Attention,
avec un TTL de dix jours, l’enregistrement restera autant de temps en cache.
Les onglets Blocked Hosts et Ad Filters ajoutent des lignes 
avec, comme adresse IP, 0.0.0.0 pour tous les sites. 

Voilà, vous en savez beaucoup maintenant sur la résolution d’adresses sous 
Mac OS X. Il ne vous reste plus qu’à prendre de bonnes résolutions…
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S’il existe un domaine qui devient très vite passionnant, c’est bien celui de la sécurité informatique. 
Pas un jour ne s’écoule sans qu’un nouvel «exploit» ne soit porté à la connaissance 
de la communauté informatique (www.frsirt.com). Face à ces attaques, vous pouvez choisir 
d’ignorer la menace ou vous informer et apprendre à vous protéger.

Identifiez les ports et les services

Sécurité: identifiez les ports ouverts et

les services actifs

C
ertes, il y a les experts de la sécurité, mais ils ne sont pas tou-
jours disponibles – surtout chez soi –, et le vieil adage «un
homme informé en vaut deux» s’applique très bien aux utili-

sateurs de nouvelles technologies que nous sommes. Le prérequis
à toute démarche de protection informatique passe donc par un in-
ventaire de ce que l’on souhaite défendre. Une fois la liste établie
de tous les matériels présents sur un réseau, il faut définir quels sont
les services qu’ils fournissent. Il y a bien sûr ceux qui s’imposent.
Un service Web, c’est un serveur de pages HTML, présent le plus
souvent sur un serveur. Un service Mail, c’est un programme qui
fonctionne sur un ordinateur et qui répond à un protocole de com-
munication POP ou IMAP, et qui échange des informations avec un
client comme Mail ou Entourage sous Mac OS X. Cela dit, il existe
bien d’autres types de services qui utilisent le réseau et Internet!
Les failles de sécurité des systèmes résultent le plus souvent d’une
mauvaise programmation ou d’erreurs bien humaines dans la réa-
lisation des applications. L’objectif principal du pirate (ou «hacker»)
est de découvrir ces défauts de programmation, puis de les utiliser

à distance afin de prendre le contrôle ou paralyser votre  système
(c’est ce que l’on appelle le déni de service, ou «denial of service»
en anglais). Il n’existe pas d’applications qui n’aient connu une
faille à un moment ou à un autre.Une fois celle-ci découverte, puis
utilisée lors de ce qui est appelé un «exploit» (cherchez dans Goo-
gle«exploit apache» ou le nom du service qui vous intéresse), les
applications prises à défaut sont corrigées par un patch ou une nou-
velle version. Vous trouverez une liste de failles pour Mac OS X à
cette adresse : www.frsirt.com/english/vuln.php?search=apple
Bien souvent, les systèmes ou applications ne sont pas mis à jour
par leur propriétaire ou administrateur, par manque d’information
ou de temps. Dans d’autres cas, l’éditeur ne corrige même pas la
faille. C’est pourquoi certains systèmes continuent à être «piratés»,
et pour un spécialiste mal intentionné, rien de plus simple que de
«scanner» tous les serveurs en cherchant un moyen d’accès sur la
cible avec l’espoir d’y trouver une application comportant une faille.
Je vous propose dans cet article de voir comment s’en protéger.

n Henri-Dominique Rapin

Plusieurs services peuvent être hébergés sur 
un même serveur. Pour que chacun puisse 

maintenir une communication avec son «client», 
il utilise un «canal», autrement appelé «port».
Un service écoute sur un port précis, et 
le client qui souhaite l’utiliser doit dès lors engager 
le dialogue via ce canal.

e Certains ports sont bien connus : le port 80 pour
le Web (HTTP) ; le port 21 pour le service FTP; le port
443 pour le Web crypté (HTTPS). Le protocole TCP/IP
a prévu un maximum de 65 535 ports. Certains sont
normalisés, c’est-à-dire connus pour être utilisés 
par un service sur Internet (du port 0 à 1023), mais 
la plupart sont libres (de 1024 à 65535).
La liste est présente dans votre Mac (ouvrez 
le Terminal et tapez more /etc/services). Si vous
préférez une liste officielle à jour, rendez-vous 
à l’adresse www.iana.org/assignments/port-numbers
(gérée par l’IANA, ou Internet Assigned Numbers 
Authority). Notez que tout cela est une convention,

et rien ne vous interdit d’utiliser le port 21 
(service FTP) pour y placer votre service Web, mais
assurez-vous que votre client utilise le même 
«numéro», sans quoi pas de dialogue possible !

e Les ports sont donc des «portes ouvertes» sur 
les ordinateurs qui les hébergent. La plupart 
des tentatives d’intrusion ou les attaques de «déni

de service» passent par des failles de ces services.
Les ports les plus scannés et les services ciblés sont
référencés à l’adresse http://isc.sans.org/trends.php,
tandis que le site www.mynetwatchman.com/tp.asp
donne le classement des ports attaqués. Il est 
important de connaître la liste des ports ouverts sur
votre ordinateur. Pour la déterminer, nous avons 
plusieurs outils. Certains sont livrés avec Mac OS X.

$ netstat –a

Active Internet connections (including servers)
Proto Recv-Q Send-Q  Local Address                             Foreign Address                        (state)
tcp4     407      0         localhost.62683                          localhost.49204                       CLOSE_WAIT
tcp4       0        0         *.3880                                         *.*                                             LISTEN
tcp4       0        0         iris.bubble-fish.55842                anubis.bubble-fi.netbi              ESTABLISHED
tcp4       0        0         iris.bubble-fish.55721                 idisk.mac.com.http                   CLOSE_WAIT
tcp4       0        0         iris.bubble-fish.55421                 mail.mac.com.imap                  ESTABLISHED
tcp4       0        0         iris.bubble-fish.55030                anubis.bubble-fi.afpov             ESTABLISHED
tcp4       0        0         iris.bubble-fish.54703                mail.mac.com.imap                  ESTABLISHED
tcp4       0        0         localhost.ipp                               *.*                                             LISTEN
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Par exemple, vous pouvez très facilement ouvrir
une fenêtre du Terminal et taper une commande
comme netstat .
Un peu compliqué pour un début? Pour aller plus
loin avec netstat, saisissez les commandes suivantes:
$ netstat -an | grep 'listen' –i retourne la liste 
(en chiffres) des ports qui sont en «écoute». 
$ netstat -a | grep 'listen' –i (sans le «n») retourne
la liste avec le nom des services.

e Apple nous facilite la tâche avec le logiciel 
Utilitaire de réseau qui va nous permettre 
de «scanner» un Mac et d’identifier ses ports 
ouverts. Il se trouve dans le dossier Applications/
Utilitaires. Comme bon nombre d’outils fournis 
par Apple avec Mac OS X, Utilitaire de réseau 
n’est pas autre chose qu’une interface graphique
au-dessus de commandes Unix. Chaque onglet 
de l’utilitaire correspond à une commande Unix,
sauf Port Scan pour lequel Apple a développé 
son propre scanner ou renifleur (sniffer en anglais)
de ports, dénommé Stroke. Pour le trouver, il faut
parcourir le contenu de l’application (le package)
d’Utilitaire de réseau. Comme toute commande
Unix, Stroke peut être lancé dans le Terminal .
Vous indiquez l’adresse IP du Mac que vous souhaitez
scanner (127.0.0.1 dans l’exemple montré ci-dessus, 
ce qui équivaut à votre propre ordinateur), puis 
le port de début et le port de fin (soit 1 et 35000
dans notre exemple).

e Comme il s’agit d’une commande Shell, 
elle est utilisable par Apple Script. Vous pourriez
écrire un script pour scanner plusieurs Mac .

e Plus simple : ouvrez Utilitaire de réseau, passez
sur l’onglet Port Scan , indiquez localhost et 
cliquez sur Scanner. Voici la liste des ports ouverts

sur le Mac que j’utilise. Les ports inférieurs 
à 1024 sont dits «connus». Nous trouvons le port 22
et en déduisons que ce Mac accepte les connections
entrantes sur le service SSH (le Shell sécurisé).
Le port 80 indique qu’un serveur Web (HTTP) est 
exécuté sur cette machine. Quant au port 631, 
il correspond à CUPS, un service d’impression sous
Mac OS X. Pour identifier un service (pour autant
qu’il soit listé dans le fichier «/etc/services»), 
utilisez la ligne de commande suivante (ici pour 

le port 631 en exemple) : $ grep –w 631 /etc/services
Vous allez obtenir en retour les lignes contenant 
les caractères «631» .

e La complication apparaît au-delà des ports situés
après 1024. Ils sont dits « libres», donc utilisables
par n’importe quelle application. Par exemple, 
le port 5679 correspond au service Missing Sync 
sur IP qui me permet de synchroniser mon PDA 
via le réseau avec mon G5. Je l’ai découvert 
parce qu’au moment de «scanner», ce port Missing
Sync se lance… Un autre moyen d’identifier quel 
service utilise un port est d’utiliser la commande

lsof (List Open file) qui liste les fichiers ouverts, 
ce qui inclut sous Unix un flux ou un fichier réseau,
aussi appelé Socket Internet.
$ lsof –i -n |egrep ‘COMMAND|LISTEN’
(la page en français de lsof : www.delafond.org/
traducmanfr/man/man8/lsof.8.html). 
Difficile cela dit d’en savoir plus sur les autres ports.
Reconnaissons que «dccm» n’est pas très 
explicite et identifier l’application (service) derrière
ce port est plutôt ardu. Il existe toutefois une base
qui tente de référencer les services par ports. 
Elle est disponible à cette adresse : www.insecure.
org/nmap/data/nmap-services.
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Nmap, pour mieux voir ce qui se passe…

$ /Applications/Utilities/Network\ Utility.app/Contents/Resources/stroke 127.0.0.1 1 35000

ipp             631/udp     # IPP (Internet Printing Protocol)
ipp             631/tcp  # IPP (Internet Printing Protocol)

set shell_result to do shell script "/Applications/Utilities/Network\\ 
Utility.app/Contents/Resources/stroke 127.0.0.1 1 80"
display dialog shell_result

eee

Insecure, l’organisme qui présente cette liste, 
propose le programme Nmap (www.insecure.org/

nmap/), bien connu de la communauté des hackers
et qui fait partie de la trousse à outils de toute 
personne travaillant dans la sécurité des réseaux.
Nmap est un scanner tout comme Stroke d’Apple,
mais avec beaucoup plus de fonctions. Sa renommée
s’est construite entre autre parce qu’il peut scanner 

un PC sans se faire repérer. Il est capable de vous 
indiquer quel est le système d’exploitation 
hébergeant les services, de vous fournir le nom 
des applications derrière les ports et leur version,
de vérifier si une faille de sécurité peut être 
utilisée contre l’ordinateur. Nmap est devenu 
un outil universel, disponible sur la plupart 
des systèmes d’exploitation, dont Mac OS X.

e Pour l’installer sur votre ordinateur, plusieurs
possibilités sont désormais à votre portée.
Les connaisseurs utiliseront Fink (http://fink.
sourceforge.net/index.php) ou Darwin Port
(http://darwinports.opendarwin.org/fr/),
mais la majorité d’entre nous téléchargera 
un utilitaire prêt à l’emploi, doté d’une interface 
graphique: NmapFE Launcher (http://faktory.org/m/
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software/nmap/). Vous pouvez enfin décider de faire
une installation avec compilation des binaires.
Pour cela, téléchargez les sources de Nmap 
à l’adresse http://freshmeat.net/redir/nmap/7202/
url_tgz/nmap-3.93.tgz, puis décompressez 
cette archive sur votre Bureau. Dans le Terminal, 
exécutez les commandes suivantes :
– Pour vous placer dans le répertoire décompressé :
$ cd /Users/<votre nom>/Desktop/nmap-3.93
– Pour créer l’install et la compilation de Nmap:
$ ./configure
$ make
$ sudo -s
$ make install
Ces commandes engendrent beaucoup de lignes 
de texte dans le Terminal, ayez de la patience… 
La compilation des binaires peut en effet paraître
«barbare». Dans le cas de Nmap, il y a peu 
de dépendances qui sont souvent à l’origine 
d’erreurs dans la compilation ; vous ne devriez pas
rencontrer de difficultés. Pourquoi récupérer 
des sources, puis les compiler? Cela vous assure
d’avoir toujours la dernière version alors que 
des outils avec interface graphique comme NmapFe
peuvent ne pas être réactualisés aussi souvent 
que le programme sur lequel ils sont basés. 

e Voyons désormais comment utiliser l’application
Nmap sur votre réseau privé… Tout d’abord, utilisons
le Terminal. Pour lancer un scan de ce réseau, 
tapez la commande: $ sudo nmap -vr 192.168.1/16.

L’option v analyse tous les ports TCP réservés 
sur la machine. L’option –v active le mode verbeux.
L’option r demande à Nmap de ne pas 
changer aléatoirement l’ordre dans lequel les ports
seront analysés, ce qui rend votre détection 
d’autant plus complexe.

e Si vous préférez vous servir de NmapFE, c’est 
la même chose si ce n’est que vous sélectionnez 
les options via l’interface graphique . Notez que
la transcription en option de ligne de commande
apparaît en bas de la fenêtre de NmapFE. Vous 
y retrouvez l’équivalent de ce que vous auriez 
dû saisir en utilisant la ligne de commande .

e Voyons ce que le scan donne sur deux bornes
AirPort . La première borne est 
une AirPort Extreme et la seconde une AirPort
Express. La détermination de l’ordinateur 
se faisant au travers d’une requête sur l’adresse
MAC, vous constatez qu’un port supplémentaire 
est présent sur la borne Express. 

e Voici le scan de mon G5 . 
Les résultats parlent d’eux-mêmes :
les ports, les services et le système
d’exploitation ainsi que sa version sont
accessibles. L’analyse de ces résultats
indique que ce Mac est géré par 
Apple Remote Desktop sur le port 59,
qu’iTunes 6.0.1 est ouvert et partage
sa librairie sur le port 3689, 
que CUPS est en fonction 
et qu’un port 5679 est utilisé par 
Active Sync. Bref, il y a là beaucoup
d’informations pour qui souhaite 
s’attaquer à cet ordinateur.
Je vous conseille fortement de lire 
la page MAN très complète et traduite.
Vous y trouverez des exemples 
pratiques et des explications sur des
termes comme Xmas Tree ou Stealth
FIN (www.insecure.org/nmap/data/
nmap_manpage-fr.html).

e Si vous possédez Microsoft Word,
ouvrez-le et faites un scan 
de votre Mac, puis fermez Word.
Exécutez maintenant un autre scan.
Vous verrez immédiatement qu’un
port apparaît, puis disparaît : MS Word
écoute le réseau! Je présume 
que c’est afin de vérifier que le même

numéro de série n’est pas utilisé sur différentes 
machines. Le port semble changer aléatoirement.
Pour être certain qu’il s’agit bien de Microsoft, 
tapez dans le Terminal la commande suivante : 
$ lsof -i -n | egrep 'COMMAND|LISTEN'.
Parmi la liste des ports ouverts, vous trouverez 
une ligne indiquant qu’un service Microsoft 
est en écoute sur le port 3916 :
Microsoft  9890 UserX 22u  IPv4 0x0337cb70  0t0
TCP *:3916 (LISTEN)
D’autres logiciels en font tout autant à votre insu.

e Certains d’entre vous ont certainement dû 
activer sur leur Mac le pare-feu livré par Apple, 
ce que je vous conseille fortement. Pourtant, 
si vous avez effectué nos diverses manipulations, 
vos ports apparaissent toujours ouverts ! 

En effet, il n’est pas possible d’empêcher un service
ou une application d’ouvrir un port. En revanche, 
le coupe-feu lui, interdit à des communications 
de joindre ces ports ouverts.
Lorsque vous utilisez « localhost» ou 127.0.0.1, 
ou encore votre propre adresse IP, et qu’à partir 
de votre Mac vous vous scannez, vous vous trouvez
derrière le pare-feu. Pour obtenir une véritable 
«vue» sur les ports ouverts, réalisez toujours 
vos scans à partir d’un autre Mac (ou d’un PC).

e En résumé, maîtrisez votre environnement! 
Identifiez les ports ouverts et pour quels services.
Mettez toujours à jour votre système et activez un
pare-feu. Surtout, ne scannez pas tous les serveurs
du monde! Il fut un temps où l’on pouvait le faire 
de façon cachée, mais les systèmes de détection
d’intrusion ont évolué et sont maintenant capables
de détecter la source d’un «reniflage» de ports 
indélicat. Gare à vous si votre IP est bannie !

13

12

1110

9

8

9

8

Host 192.168.1.1 appears to be up ... good.
Interesting ports on 192.168.1.1:
(The 1666 ports scanned but not shown below are in state: closed)
PORT STATE SERVICE
53/tcp    open  domain
10000/tcp open  snet-sensor-mgmt
MAC Address: 00:0D:93:22:20:20 (Apple Computer)

Host 192.168.1.2 appears to be up ... good.
Interesting ports on 192.168.1.2:
(The 1665 ports scanned but not shown below are in state: closed)
PORT      STATE SERVICE
53/tcp    open  domain
5000/tcp  open  UPnP
10000/tcp open  snet-sensor-mgmt
MAC Address: 00:11:24:02:3A:3A (Apple Computer)

10
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Vous n’avez pas l’intention de repasser sous Mac OS 9 et d’apprendre à utiliser Resedit 
pour modifier la disposition des touches de votre clavier ? André a débusqué sur Internet 
le logiciel Ukulele qui vous aidera à le faire très simplement sous Mac OS X !

Personnalisez votre clavier
directement sous Mac OSX(2)

1 La première chose à faire – vous vous en doutez – consiste à récupérer les fichiers 
de l’application Ukelele. Le plus simple est d’aller directement sur le site du développeur

: http://scripts.sil.org/cms/scripts/page.php?site_id=nrsi&id=ukelele. La version
actuelle est la 1.6.5, datée fin décembre 2005.

Une fois que vous avez ouvert l’image disque , faites 
un glisser-déposer tout en maintenant la touche [Alt] enfoncée : 
le Finder procédera à la création d’un dossier sur votre Bureau 
et à la copie du contenu de l’image . Il ne reste plus qu’à double-
cliquer sur l’icône d’Ukelele.

3

2

1

2 Une fois dans Ukelele, ne faites pas New
(nouveau), mais Open (ouvrir). Ensuite,
dans le dialogue d’ouverture des fichiers, 
naviguez dans l’arborescence jusqu’au
fichier French.keylayout (Ukelele/
System Keyboards/Roman/French.keylayout). 
Une fois ce fichier ouvert, il est prudent 
de l’enregistrer tout de suite sous un autre
nom explicite (FrenchModifiekeylayout, 
dans le cas présent), par exemple dans 
votre dossier Documents.

4

1

2

3

4

J
e vous avais expliqué dans VVMac N°10 comment personna-
liser les touches de votre clavier. Nous avions ainsi inversé le
point simple et le point-virgule, mais la procédure imposait un

détour par Mac OS 9, ou Classic, afin de travailler dans l’éditeur
de ressources ResEdit. Certains lecteurs qui n’ont jamais connu l’an-
cien Mac OS et ne l’ont pas installé sur leur Mac m’ont demandé s’il
n’y avait vraiment aucune solution sous Mac OS X. Eh bien oui, il
y en a au moins une : le logiciel Ukelele. Sa toute dernière version,
disponible depuis le 30 décembre 2005 (et même la 1.6.4 de septem-

bre), permet de travailler directement sous Mac OS X et sur des
claviers romans. En effet, Ukelele est à l’origine un «éditeur de cla-
vier Unicode». Or, la majorité d’entre nous emploie un clavier roman.
Heureusement, les dernières versions de cet outil très bien réalisé sont
fournies avec une série de fichiers claviers dont le clavier français
roman, facilement modifiable. Attention, il n’est pas sûr que tous vos
logiciels apprécieront d’avoir un clavier qui leur parle en Unicode.
Mais ce n’est pas grave: en cas de problème, il suffira de vous replier
vers un clavier courant, via le menu Saisie. n André Sterpin
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3 Vous pouvez éventuellement vérifier la configuration du clavier, si elle 
ne correspond pas, dans le menu Keyboard Type . Il faut parfois tâtonner
un peu. Par exemple, mon clavier Macally USB correspond à Extended ADB 
.

6

5

4 Pour modifier une touche, il faut 
double-cliquer sur sa représentation 
à l’écran. Ici, je double-clique sur 
le point-virgule. Ukelele affiche 
une fenêtre qui autorise 
la modification. Je remplace le point-
virgule par un point simple . Faites
OK pour activer la modification .

Attention, n’oubliez pas de modifier 
ce qui était le point simple en point-
virgule : en maintenant la touche [Maj],
double-cliquez sur la touche affichant
le point et attribuez-lui le point-virgule.
Vérifiez enfin, dans les différents
layouts de clavier, que la modification
est bien effective .109

8

7

5 C’est aussi une bonne idée que de changer le nom du clavier
tel qu’il s’affichera dans le menu Saisie. Utilisez l’article 
de menu Keyboard > Set Keyboard Name… Optez pour quelque
chose de simple, court et explicite (ici, French Modifie) .11

6 Le nouveau clavier enregistré
doit être placé dans 

~/Bibliothèque/Keyboard Layouts/ 
s’il ne doit servir qu’à vous («~» 
correspondant à votre dossier 
utilisateur), ou dans /Bibliothèque/
Keyboard Layouts/ (dossier Bibliothè-
que de la racine) pour être accessible
à tous les usagers de votre Mac.
Contentez-vous de relancer la session
en cas d’ajout dans votre répertoire,
sinon redémarrez pour pouvoir 
activer le nouveau clavier dans 
les Préférences système, panneau
International, onglet Menu Saisie .
Le clavier est disponible dans le menu
Saisie de la barre des menus.
L’utilisation de ce logiciel n’est pas
limitée au déplacement d’une lettre 
ou d’un point. Vous pouvez créer 
un clavier particulier, pour un jeu 
par exemple, sans avoir à passer 
par ResEdit et Classic!
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Trucs et astuces pour progresser dans la

pratique d’iPhoto 5

Conservez le zoom sur 
un effet Ken Burns

Un meilleur export HTML

D
ans le menu Partager, l’article Exporter… permet, entre autres choses, de générer
un export Web de la photothèque, d’un album… Cela dit, cet export est plutôt 
sommaire. Heureusement, iPhoto supporte l’installation de modules externes, et

vous apprécierez peut-être Better HTML Export (shareware à 20 $). Une fois ce module
d’export installé, l’article Exporter… vous offre désormais, à côté du choix standard
d’iPhoto Page Web, l’option Better Web Page , elle-même subdivisée en plusieurs
panneaux qui rassemblent ses options d’export. Des thèmes peuvent être utilisés 
pour obtenir sans peine des présentations agréables. Le site de l’auteur de ce shareware
propose en sus Template Manager , une application gratuite qui peut rechercher 
des thèmes sur Internet et les installer. Sans concurrencer certaines applications
dédiées qui offrent un export très complet, Better HTML va à l’essentiel (images, 
vignettes et liens), mais utilise également les noms d’images et les commentaires 
ajoutés aux photos. Son export, relativement simple à mettre en œuvre, 
donne des résultats plus intéressants que la fonction intégrée de votre iPhoto.
www.droolingcat.com/software/betterhtmlexport/

2

1

L
orsque vous définissez un diaporama, vous pouvez utiliser l’effet
Ken Burns. Mais, si vous voulez, par exemple, effectuer 
un déplacement en conservant la même valeur de zoom pour 

le début et la fin de l’effet, ce n’est apparemment pas facile. 
Certes, vous pouvez remettre zoom et position à zéro (touche [1]
du pavé numérique), mais si vous avez déjà choisi une valeur de zoom
pour le début et souhaitez la même valeur pour la fin, 
ou l’inverse… Il suffit alors de basculer de l’un à l’autre en utilisant 
la touche [Alt] : toutes les valeurs de zoom et de position 
seront copiées sur le point sur lequel vous basculez. Vous êtes sûr
d’avoir la même valeur de zoom tout au long de l’effet et vous pouvez
vous concentrer sur la position.

Nous connaissons tous iPhoto et nous en apprécions le côté pratique, mais il est parfois mal-aimé.
Peut-être parce que nous n’en percevons trop souvent que la partie visible, oublieux de certaines 
fonctions plus discrètes, de combinaisons avec d’autres utilitaires, d’astuces de recherche… 
Voici quelques-unes de nos propres découvertes. n Jean-Jacques Ardoino

1
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Le Raw du Canon EOS 350D

À
l’instar d’Aperçu, iPhoto supporte le format Raw de divers appareils, 
dont celui de l’EOS Digital Rebel XT (US), mais pas celui du 350D
(Europe). Et pourtant, il s’agit bien du même appareil ! Simplement, 

ce dernier n’est pas répertorié dans les listes XML de Mac OS X 10.4.3. Pour
corriger cela, il suffit que le fichier Raw.plist, sis dans Système/Bibliothèque/
Frameworks/ApplicationServices.framework/Versions/A/Frameworks/
ImageIO.framework/Versions/A/Resources/, contienne la mention du Raw 
du Canon 350D et ses spécifications. Vous éditez le fichier avec TextEdit 
(mode Texte seul) et y ajoutez le code que vous trouverez sur le site 
Minimal (www.minimal.cx, et plus exactement sur la page www.minimal.cx/
2005/11/01/make-os-x-1043-understand-canon-eos-350d-raw-files/). Cela dit, 
le plus simple est de télécharger le fichier Raw.plist, disponible à partir 
de cette même page, qu’il suffira de substituer au fichier Raw.plist d’origine
(un mot de passe administrateur vous sera demandé). iPhoto et Aperçu
reconnaîtront et afficheront le format Raw du 350D sans aucun problème.
Attention : Ian, l’auteur de cette astuce, recommande de n’effectuer 
la modification ou la substitution que si vous travaillez sous Mac OS X 10.4.3.
Sous 10.4.2, le fichier d’origine est en effet assez différent et il n’est pas 
certain que l’exemplaire modifié soit supporté.

2

3

Changez de photothèque

Avant sa version 4, iPhoto n’offrait pas la possibilité de jongler avec 
plusieurs photothèques. Il fallait «bidouiller». C’est pourquoi Nick Neil a

réalisé iPhoto Buddy, une application très pratique et gratuite de surcroît.
iPhoto 4 et 5 permettent de choisir une autre photothèque ou d’en créer 
une nouvelle en utilisant la touche [Alt] juste après leur lancement. 
Une possibilité certes bienvenue, mais un peu austère (il faudra simplement
naviguer dans un dialogue d’ouverture). iPhoto Buddy, quant à lui, offre 
une gestion claire et lisible des diverses photothèques disponibles, et reste
donc encore d’actualité. Son interface permet de choisir une collection 
aisément reconnaissable et se charge de paramétrer les préférences
d’iPhoto pour que celle-ci soit définie comme photothèque par défaut. 
www.nofences.net/iphotoBuddy/

i
Photo recèle de nombreuses petites fonctions auxquelles on ne prête pas 
forcément attention. Par exemple, pourquoi importez-vous vos photos 
en «automatique» alors qu’iPhoto permet d’ajouter des informations comme

le nom du rouleau ou une description lors de l’import? Gain de temps garanti !
Itou, savez-vous que le logiciel Transfert d’images (dossier Applications) 
permet de choisir les photos à importer depuis l’appareil ? C’est aussi
dans les Préférences de Transfert d’images que vous déterminez l’application 
qui s’ouvre lorsqu’un appareil photo numérique est reconnu par Mac OS X.

En jetant un œil sur les nombreux raccourcis (menu Aide), vous découvrirez 
une foule de commodités. Certaines étant peu documentées, en voici quelques
exemples. En gérant vos photos, vous serez souvent amené à effectuer 
des rotations (portrait ou paysage) : si les Préférences définissent le sens 
de rotation prioritaire, l’utilisation de la touche [Alt] permet d’inverser ce sens 
à la volée sans avoir à repasser par les Préférences. En bas et à droite, 
un curseur permet de modifier la taille des vignettes en mode Organisation et 
de zoomer lorsque vous êtes en mode Édition dans la même fenêtre (via le menu
contextuel). Les icônes placées de chaque côté de ce curseur permettent d’obtenir
d’un clic la taille minimale ou maximale. Mieux encore, les touches [0], [1] et [2]
du pavé numérique peuvent être utilisées si une image est sélectionnée. 
En mode Organisation, [0] donne la taille minimale, [1] agrandit l’image afin
qu’elle tienne dans la fenêtre, tandis que [2] propose une taille intermédiaire et
confortable de navigation. En mode Édition, [0] donne le plan le plus large, 
[2] offre le zoom maximum et [1] propose une taille intermédiaire.
Si vous utilisez le panneau des mots-clés en bas à gauche , vous regretterez
peut-être, quand tous les boutons de mots-clés ne sont pas affichés, que 
le défilement sur ce panneau à l’aide des deux petits boutons triangulaires 
soit peu aisé. Cela dit, si votre souris a une molette de défilement, vous ne serez
pas gêné et naviguerez naturellement dans les mots-clés.
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Osez Core Image!

D
ans les préférences d’iPhoto, vous pouvez choisir qu’un double-clic sur une
photo l’ouvre avec un éditeur externe, et il est probable que vous penserez
à une application comme Photoshop Elements ou GraphicConverter.

Pourquoi limiter votre choix? Si votre Mac dispose d’une carte graphique qui 
supporte les librairies Core Image de Tiger, désignez donc – ne serait-ce que tem-
porairement –, une application comme iMaginator de Stone Studio ou Image
Tricks de BeLight Software. Le second est gratuit alors qu’iMaginator 
est un shareware plutôt cher (42 € environ), mais plus flexible. Avec Image Tricks,
vous puisez dans la fabuleuse boîte à effets de Core Image, mais vous ne pouvez
pas enchaîner les effets. Surtout, vous ne pouvez pas revenir en arrière, car toute
modification affecte l’image. Avec iMaginator, vous avez aussi accès à une multi- tude de filtres de transformation et de déformation temps réel que vous pouvez

enchaîner les uns aux autres. Vous pouvez désactiver à volonté tel ou tel effet
déjà appliqué. Beaucoup de ces effets peuvent être perçus comme ludiques 
(d’autant plus que les transformations en temps réel sont un réel plaisir), mais
iMaginator permet d’obtenir des compositions très exploitables. Question 
de talent… Vous pourrez modeler de façon très personnelle vos images et, pour
peu qu’elles s’y prêtent et que vous fassiez preuve de goût, vous pourrez 
disposer de créations fixes ou animées à intégrer à un site, un album ou 
un montage vidéo. Quoi de plus naturel que de vous laisser inspirer par l’examen
de votre photothèque et de basculer sous iMaginator ou Image Tricks chaque fois
que vous sentez que de bonnes idées pourraient émerger? À d’autres moments,
rien ne vous interdit de retourner dans les préférences pour y désigner 
un éditeur plus classique. Notez que les ressources de Core Image et les mêmes
possibilités qu’iMaginator (ou presque) sont accessibles sans bourse délier grâce
à Core Image Fun House, un utilitaire fourni par Apple en standard (il se trouve
dans les outils développeurs de Mac OS X qu’il vous faudra installer).
www.stone.com
www.belightsoft.com/products/imagetricks/overview.php 

2

1

Placez-vous dans un album classique et tapez une lettre dans 
le champ de recherche . Sélectionnez à nouveau 

ce même album dans la liste à gauche et affichez les informations.
À votre grande surprise, le dialogue des albums intelligents
s’ouvrira à la place de la fenêtre classique… Un filtrage 
temporaire qui fonctionne bien comme une recherche étendue.
Quand un bogue d’iPhoto 5 offre des fonctions supplémentaires,
nous n’allons certainement pas nous plaindre ! 

2
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Critères multiples

Il est logique d’utiliser les mots-clés et 
d’en attribuer à vos images (rappelons que

l’ajout de nouveaux mots-clés s’effectue 
dans les préférences). Une fois le panneau
des mots-clés affiché (icône Clé en bas 
de la fenêtre), vous pouvez filtrer 
le contenu de l’album en cours en cliquant
sur un ou plusieurs boutons de mots-clés.
Avant la version 5.0.2, l’action de plusieurs
boutons associés obéissait à la règle 
du «OU» logique. Ainsi, une requête 
combinant «Paris» et «Lumière artificielle»
trouvait toutes les photos répondant à l’un
OU l’autre des deux critères. Pour ne trouver
que les photos répondant à ces deux 
critères en même temps, il aurait fallu utiliser
un «ET» logique, ce qui n’était pas le cas.
Les choses ont changé depuis la version 5.0.2.
Si on active deux boutons de mots-clés, c’est
maintenant le « ET» qui est utilisé et seules
les photos répondant aux deux critères 
sont trouvées. Le «OU» sera obtenu avec 
le clic associé à la touche [Maj] . Il existe

même une troisième possibilité qui peut être
combinée avec l’une ou l’autre des solutions
précédentes: l’exclusion. Vous l’obtenez 
par le clic associé à la touche [Alt] .
Il est donc possible de rechercher des photos
répondant à la combinaison de plusieurs
mots-clés et en excluant d’autres.

2
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Jonglez avec les mots-clés

1

1
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2

2
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Peut-être auriez-vous besoin d’utiliser des graphismes de certaines 
applications. Évidemment, on pensera aux jeux, mais récupérer 

le logo d’un utilitaire ou certaines de ses images (une corbeille, un pointeur
de souris, des boutons…) peut avoir autant de sens. Sous Mac OS X, 
la plupart des applications sont en fait des dossiers portant l’extension .app.
Vous avez dû au moins une fois « ouvrir le paquet » d’une application… 
et découvert qu’il contenait une hiérarchie de dossiers.
Lorsque vous glissez une application sur Aperçu, vous pouvez voir tous 
ces graphismes. C’est également possible avec iPhoto ! Il suffit de glisser
une application sur l’icône d’iPhoto ou sur la fenêtre de la photothèque.
C’est comme si vous glissiez un dossier de photos, et tout ce que 
cette application contient de graphismes pouvant être gérés par iPhoto sera
importé. En fin d’importation, iPhoto affiche une liste d’erreurs 
qui regroupe les fichiers non gérés. Fermez cette liste sans vous en soucier 
– ce sont des textes et d’autres ressources… Mieux encore, si vous glissez
l’application sur la partie de la fenêtre d’iPhoto qui liste les albums, 
livres, diaporamas, etc., un nouvel album sera automatiquement généré, 
qui portera le nom de l’application et regroupera tous ses graphismes.

Récupérez en album 
les graphismes d’un logiciel

Présentations en poche

Exportez sur Palm

Avec The Missing Sync for Palm, Mark/Space (www.markspace.com)
offrait un bon complément à la synchro d’origine, notamment 

l’installation d’un module pour iPhoto qui permettait d’exporter des photos
à la bonne taille pour le Palm. Aujourd’hui, The Missing Sync concerne tous
les PDA et smartphones sous Palm OS et prend lui-même en charge 
la synchro. Il remplace donc intégralement HotSync. La fonction d’export
depuis iPhoto a évidemment été conservée (ainsi que l’intégration avec
iTunes ou l’accès direct à la carte mémoire sous le Finder…). Si vous utilisez
un Palm et avez choisi d’installer une version quelconque de Missing Sync,
rien de plus simple que de rassembler les photos que vous souhaitez
exporter dans un album puis, dans le menu Partager, de faire Exporter.
Vous pouvez alors choisir le format et la taille, le dialogue d’export 
trouvera directement l’emplacement où les photos doivent être stockées
sur la carte mémoire. Si vous passez sur Tiger, il est nécessaire 
de mettre The Missing Sync à jour en version 5 (la version 4 n’est plus 
distribuée, mais fonctionne), car la version 2 n’est plus supportée.

Vous réalisez des présentations avec Keynote, PowerPoint, ou encore 
en PDF? Si vous utilisez un iPod gérant la photo (4 et 5G), il n’est pas

forcément nécessaire de vous déplacer avec votre PowerBook. 
En effet, grâce à un petit shareware d’environ 15 €, iPresent It , 
vos présentations seront converties en diaporamas et projetées depuis 
un iPod et sa sortie vidéo. iPresent It est très simple : vous glissez une pré-
sentation sur sa fenêtre et cliquez sur le bouton Create Slideshows. Il va
créer un album iPhoto contenant toutes les vues de la présentation. Reste
à faire un diaporama avec les réglages appropriés. iPresent It peut traiter
plusieurs présentations en même temps. Cela ne sera pas adapté 
aux situations où la synchronisation précise des changements de vue 
est nécessaire, mais cela peut tout à fait convenir dans bien d’autres cas.
wwwwww..zzaapppptteekk..ccoomm

Vous n’avez pas d’iPod? Emportez donc seulement un DVD! 
Votre présentation convertie avec iPresent It et/ou votre diaporama 
entièrement réalisé avec iPhoto tiendront suffisamment la route pour être
projetés tels quels (sans rajouter de synchronisation complexe avec 
un accompagnement sonore). Surtout avec iPhoto 5 qui offre des choix
beaucoup plus souples pour les durées d’affichage et les transitions.
Une fois le diaporama prêt à être joué, vous pouvez l’exporter en film
QuickTime, mais il y a éventuellement mieux : dans le menu Partager, 
utilisez l’option Transférer vers iDVD. Vous pourrez ainsi graver rapidement
votre diaporama sans multiplier les étapes intermédiaires.

1

1
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Pour mener à bien un détourage, le choix de l’outil
est primordial. Suivant qu’il s’agit de sélectionner

une plage de couleurs, une forme géométrique 
ou une autre imprécise, vous n’utiliserez pas 
les mêmes outils. Cela dit, il existe également 
une question d’affinité avec ces derniers. Certains 
ne jurent ainsi que par le lasso alors que d’autres 
ne travaillent qu’avec les masques. Tout est possible
(ou presque)! Cependant, vous devez retenir un point
important : une sélection s’effectue rarement 
à l’aide d’un outil unique. On commence par exemple

avec la baguette magique, puis on poursuit avec 
le lasso avant d’affiner à l’aide du pinceau.

e Voyons donc de quels outils nous disposons. 
La palette Outils propose quatre outils de sélection :
Rectangle (et l’outil Ellipse qui lui est associé), 
Lasso et sa déclinaison, Baguette magique et Forme
de sélection. Passons chacun d’eux en revue…

e Rectangle permet de sélectionner rapidement
des zones rectangulaires (petites ou grandes). 

Il pourra vous être utile pour dégrossir la sélection
ou pour récupérer des «pétouilles» qui auraient été
ignorées par une sélection à la baguette.

e L’outil Lasso et sa déclinaison font une sélection
basée sur le contour de l’objet. Dans sa version
standard, il permet de suivre les contours les plus
complexes, mais sa mise en œuvre requiert 
une certaine dextérité à la souris ou au stylet. 
Le Lasso polygonal est plus souple d’emploi puisqu’il
ne vous oblige pas à suivre le contour de l’objet,

Choisissez les bons outils
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Si vous travaillez vos images, une de vos fonctions favorites est sans nul doute celle de détourage.
Celle-ci consiste à « capturer» finement un élément de la photo afin d’appliquer certains 
traitements à lui seul ou le dégager d’un fond, par exemple. Le détourage est donc indispensable 
au photomontage, mais pas toujours facile à produire, sauf si vous suivez les conseils de VVMac.

C
ertains passent leur week-end à construire une tour Eiffel en
allumettes, d’autres à reproduire la tapisserie de la Dame à
la licorne au point de croix… D’autres encore font du dé-

tourage de photos. Quel rapport, me demanderez-vous? Dans tous
les cas, il s’agit d’un travail de longue haleine qui demande à la fois
patience et méticulosité. Vous qui pensiez qu’avec les outils de Pho-
toshop Elements, le détourage du portrait de belle-maman ne pren-
drait pas plus de cinq minutes, vous voilà donc déçu. Je vous ras-

sure, comme nous allons le voir, en choisissant les outils et la tech-
nique appropriés, un beau détourage ne vous prendra pas plus de…
quelques heures. 
Pour illustrer cet article, j’ai choisi une photo qui ne semble pas po-
ser de problème, mais nous allons voir que le détourage de la sta-
tue est moins facile qu’il n’y paraît. Pour corser un peu le jeu, nous
travaillerons comme les pros en préservant l’intégrité de l’image, ce
qui exclut d’entrée l’usage de l’outil Gomme… n Mathieu Lavant

Avec Photoshop Elements, réussissez

de beaux détourages

ATELIER
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Bien démarrer…

bouton de la souris enfoncé. En revanche, 
impossible de suivre les courbes. Nous pourrions
l’utiliser pour dégrossir rapidement le travail. Enfin,
le Lasso magnétique propose un quasi-détourage
automatique sur un objet aux contours nets 
et contrastés. De plus, il s’utilise simplement 
en suivant le contour de l’objet, bouton de la souris
relevé. Si vous maniez bien cette dernière, c’est 
l’outil idéal pour notre détourage.

e La Baguette magique sert à effectuer 
une sélection basée sur une plage de couleurs que
vous définissez à l’aide du Réglage de tolérance.
C’est l’outil idéal pour faire une sélection sur un ciel,
comme celui de notre photo exemple. Voici l’outil
que nous utiliserons pour débuter notre détourage.

e L’outil Forme de sélection s’utilise comme 
un pinceau, mais génère une sélection sur les zones

de l’image où il est appliqué. En théorie, c’est l’outil
parfait pour pratiquer des sélections de formes
complexes ou de petits détails. En pratique, 
il est d’une utilisation assez peu commode. 
Il a cependant un atout : son second mode de travail,
le mode Masque, qui permet de retoucher 
une sélection en travaillant sur un masque. Vous 
allez en voir l’application ici, car nous l’utiliserons 
au moment de la finalisation du détourage.

Pour des raisons de facilité, j’ai choisi de démarrer le détourage avec 
la Baguette magique. Cet outil permet de sélectionner très rapidement 

le ciel bleu de notre arrière-plan.

e Après avoir activé l’outil Baguette magique, rendez-vous dans la barre 
d’options (sise dans la partie supérieure de la fenêtre de travail) et ajustez 
le réglage de la tolérance à 32 – de ce réglage dépend l’étendue de la plage 
de couleurs prise en compte par la baguette. Plus la tolérance est élevée, 
plus large sera la plage de couleurs.

e Cliquez au milieu du ciel pour créer une première sélection. Vous constaterez
qu’un seul «coup» de baguette suffit pour sélectionner la quasi-totalité du ciel
et que cette sélection s’arrête net sur le contour de la statue . Remarquez
également que les portions de ciel qui apparaissent dans les vides de la statue
sont elles aussi choisies. Si tel n’était pas le cas, retournez dans la barre 
d’options de l’outil et décochez l’option Pixels contigus, puis refaites la sélection.

e À présent, nous allons nous occuper des feuillages qui occupent la partie
gauche de l’image et son angle inférieur droit. Ils n’ont pas été pris 
en compte par la sélection à la baguette, mais cette dernière ne nous sera plus
d’une grande utilité. Nous allons en effet poursuivre avec l’outil Rectangle.

e Après avoir activé l’outil Rectangle,
rendez-vous dans la barre d’options 
et sélectionnez le mode Ajouter à la sélection,

en cliquant sur l’icône adéquate . Ce mode va créer une sélection qui viendra
s’ajouter à celle déjà existante.

e Revenez sur l’image. Par des cliquer-glisser, sélectionnez le feuillage pour 
l’inclure dans la sélection d’ensemble. Avec cette technique, vous choisissez 
la totalité du massif de feuillages de droite et une grande partie du massif 
de gauche. Tout d’abord, un rectangle de sélection est tracé sur le feuillage 
afin de l’inclure dans la sélection d’ensemble , puis les deux masses
de feuillages sont sélectionnées à l’aide de l’outil Rectangle (pour une meilleure
lisibilité, j’ai temporairement supprimé le contenu de la sélection ).4

3

2
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Il nous reste encore quelques broutilles à corriger 
dans la partie droite de l’image, et surtout 

le côté gauche de la statue à traiter. 
À ce stade, deux techniques sont envisageables :
utiliser le Lasso magnétique pour découper 
le feuillage qui colle à la partie droite de la statue,
puis finaliser le reste en mode Masque, ou alors
traiter l’ensemble avec le mode Masque. J’utiliserai
ici cette dernière technique.

e Avant de passer à l’action, je vais vous dire deux
mots du mode Masque. Lorsque l’outil Forme 
de sélection est activé, la barre d’options affiche 
le réglage Mode et son menu local qui propose
Sélection et Masque. Avec le mode Sélection, l’outil
Pinceau produit une sélection comme les autres 
outils ; avec le mode Masque, la sélection active est
convertie en masque semi-opaque et l’outil Pinceau
se comporte alors comme un ustensile de retouche 
à l’aide duquel on modifiera le masque .

e Pour afficher le mode
Masque, commencez 
par activer l’outil Forme 
de sélection, puis rendez-
vous dans la barre d’options
et optez pour l’option 
Masque du réglage Mode.
Le masque s’affiche alors 
en rouge sur les zones 
non sélectionnées 
de notre image exemple.

e Revenez dans la barre
d’options afin de choisir 
une forme de pinceau et 
régler le diamètre de l’outil.
Vous voilà prêt à utiliser 
cet outil un peu particulier…
Si vous donnez un coup de pinceau sur une zone 
de l’image qui n’est pas recouverte par le masque,

vous générez un nouveau morceau de masque 
qui correspond à un trou dans la sélection . 
Si vous donnez un coup de pinceau sur une zone 
de l’image déjà masquée avec la touche [Alt]
enfoncée, vous créez un trou dans le masque qui
correspond à une nouvelle zone de sélection .

e Nous allons donc exploiter ce principe pour
affiner notre détourage. Dans le cas de la photo 
sur laquelle nous travaillons, il s’agit de gommer 
certaines portions du masque qui débordent 
au-delà du contour de la statue. Nous utiliserons
donc le pinceau avec la touche [Alt] enfoncée.

e Les corrections sur le masque achevées, 
basculez en mode Sélection en cliquant 
sur l’un des outils de sélection de la barre d’outils :
les zones non masquées sont converties 
en sélection et les zones masquées sont converties
en zones hors sélection.

9

8

7

Enregistrez la sélection

Travaillez au pinceau

Nous avons déjà effectué la plus grosse partie
du travail, mais avant de poursuivre, 

il serait peut-être plus prudent d’enregistrer 
la sélection. Ainsi, en cas de fausse manœuvre,
vous ne serez pas forcé de repartir de zéro. 
De plus, en enregistrant la sélection, vous 
la conserverez dans votre fichier (enregistré 
en PSD) et vous pourrez la réutiliser plus tard.

e Pour l’enregistrement, choisissez l’article 
du menu Sélection > Mémoriser la sélection.
Photoshop Elements affiche alors la boîte 
de dialogue de la commande . Tapez le nom

de votre sélection et validez. Celle-ci est alors
enregistrée dans le document.

e Si vous travaillez sur une sélection complexe,
pensez à enregistrer régulièrement celle-ci 
(la sélection sauvegardée n’est pas mise à jour 
automatiquement). Pour cela, activez 
à nouveau la commande Mémoriser la sélection.
Dans le menu local Sélection, vous retrouverez 
le nom de la sélection que vous aviez enregistrée
précédemment. Sélectionnez-le. Dans les options
qui s’affichent dans la partie inférieure de la 
palette, optez pour Remplacer la sélection .65

6
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Et maintenant, que fait-on?

À la différence de Photoshop, Photoshop Elements ne permet pas d’accéder
à la couche alpha (une couche de l’image utilisée pour stocker une sélection),
ce qui prive l’utilisateur d’un moyen simple pour visualiser la sélection 
sous forme d’un masque seul. Il existe cependant une technique de rem-
placement que les utilisateurs experts pourront tester : créer une fausse
couche alpha à l’aide d’un calque de réglage. Voici comment procéder.

e À partir de votre image de travail contenant la sélection, utilisez 
le menu Calque > Nouveau calque de réglage > Niveaux et validez les deux 
boîtes de dialogue qui s’affichent, en conservant les réglages par défaut.
La palette Calques propose alors un nouveau calque de réglage associé 
à un masque de fusion contenant votre sélection.

e Cliquez sur la vignette du masque (celle de droite) avec la touche [Alt]
enfoncée. Photoshop Elements affiche alors le masque, une image 
en niveaux de gris dans laquelle les zones blanches correspondent 
aux zones sélectionnées et les zones noires aux zones hors sélection . 
Comme vous le constatez, l’affichage du masque seul permet de remarquer 
très rapidement les petites « pétouilles » qui n’ont pas été corrigées parce
que vous ne les avez pas vues en mode Masque. Pour corriger celles-ci,
vous utiliserez le pinceau ordinaire avec les couleurs noir et blanc.

e Une fois ces corrections effectuées, il vous faudra récupérer 
la sélection en cliquant sur la vignette du masque avec la touche [Cmd]
enfoncée, puis masquer le calque de réglage ou bien le supprimer 
à l’aide des commandes de la palette Calques.

A

Simulez une couche alpha

www.vvmac.com L’image exemple de l’atelier est 
à télécharger sur le site du magazine,
lien en page Sommaire VVMac N°12.

Nous voilà parvenus au terme 
de notre détourage. 

N’oubliez pas d’enregistrer 
une nouvelle fois la sélection 
finale via l’article du menu 
Sélection > Mémoriser 
la sélection. Enregistrez 
aussi votre fichier au format 
PSD afin de sauvegarder 
les informations de sélection. 

e Voilà, nous avons réalisé 
un beau détourage, mais 
à présent que peut-on en faire?
Les possibilités sont multiples.
Les seules limites sont celles 
de votre imagination créative. 

e Nous pouvons ainsi exploiter 
la sélection pour y coller 
un nouveau ciel copié depuis
une autre photo, ou encore 
utiliser un calque de remplissage
pour remplacer la sélection 
par un dégradé ou un aplat 
de couleur . Nous pouvons
aussi copier la statue détourée
pour la coller dans un autre
document Photoshop. Attention, 
pour ce type d’utilisation, 
vous devrez inverser 
la sélection avant de la copier 
(menu Sélection > Inverser),
sans quoi c’est le ciel qui serait
pris en compte.

10
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Préparation

Je vais donc créer une signature HTML et l’ouvrir en local avec Safari. 
Mieux vaut placer les images utilisées dans la signature sur un espace 

Internet. Personnellement, je possède un compte .Mac, aussi cette manipulation 
est-elle réalisée en quelques clics. J’ouvre une fenêtre dans le Finder (menu Fichier >
Nouvelle fenêtre Finder). Je clique sur l’icône de mon iDisk dans la barre latérale
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Depuis que la version de Mail, livrée avec Mac OS X Tiger, supporte le rendu des pages HTML 
au travers du Web Kit de Safari, vous pouvez envisager la création d’une signature percutante pour
vos messages. La mise en place d’un tel projet ne vous prendra que quelques minutes. Vous pourrez 
même inclure une image cliquable ou des liens hypertextes. À utiliser à bon escient, car nombre 
d’utilisateurs n’aiment pas recevoir ce type de message qui augmente les temps de chargement 
(problématiques en RTC ou GPRS) et alourdissent leur base de messages Mail. n Frédéric Blaison

Lancez Mail, puis dans les préférences (menu Mail > Préférences), 
placez-vous dans l’onglet Signatures. Les signatures sont 

indépendantes des comptes de courrier électronique : vous les créez, 
puis vous les attribuez. Une même signature peut être affectée à plusieurs
comptes et un même compte peut offrir plusieurs signatures (vous faites 
votre choix lors de la rédaction d’un message, par exemple).
Le plus simple est de se placer, dans la colonne de gauche, sur la rubrique
Toutes les signatures. Vous cliquez sur le bouton + (situé sous la colonne 
centrale) afin de créer une signature. Donnez-lui un nom, puis saisissez 
ou collez le texte de la signature dans la zone qui s’affiche à droite.
Pour affecter une signature à un compte, il suffit de glisser le nom 
de la signature depuis la colonne centrale sur l’intitulé du compte dans 
la colonne de gauche. Répétez l’opération autant de fois que nécessaire si
une même signature est attribuée à plusieurs comptes. Si vous greffez 
plusieurs signatures à un même compte, leur nombre s’inscrit sous l’intitulé
du compte et le menu local Choisir la signature… devient actif. 
On peut décider à ce niveau d’une signature par défaut et d’un mode 
de passage d’une signature à l’autre. Avec l’option Aucune, Mail n’ajoute pas
de signature par défaut lorsque l’on crée un message, mais vous pouvez 
toujours choisir de signer via le menu Signature qui est activé par défaut 
dans la fenêtre d’édition d’un message. Si vous ne le voyez pas, cliquez 
sur l’icône en forme de « liste » à l’extrême gauche de la zone de l’en-tête 
et demandez Personnaliser… Cochez alors la case du champ Signature.
Toujours dans l’onglet Signatures des préférences, la case Placer la signature

avant le texte cité permet de placer la signature en début de message 
lorsque vous répondez à un correspondant. Bien que cette pratique 
soit contestée par les puristes, je la trouve pour ma part efficace : si vous
êtes le huitième à répondre dans une chaîne de réponses, votre signature
peut en effet se trouver enfouie tout en bas de la page du message.

e Pour cet atelier, je vais créer une nouvelle signature . Je clique sur 
le bouton + et je nomme ma signature «Signature VVMac». Je tape n’importe
quoi dans la zone à droite, cela n’a aucune importance (mais ne la laissez pas
vide sinon la signature ne sera pas ajoutée lorsque vous refermerez 
les préférences). Je glisse la signature sur un de mes comptes pour l’affecter.
Voilà, j’abandonne Mail pour l’instant… J’y reviendrai à la fin de l’atelier. 

1

Offrez graphisme et interactivité à vos

signatures dans Apple Mail

Création et configuration des signatures dans Apple Mail

1

2

Ce qu’il vous faut : Mac OS X 10.4.3, Mail 2.0.5, Nvu 1.0, un compte .Mac ou un espace personnel chez votre FAI
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(on affiche cette icône via les préférences du Finder, menu Finder > Préférences,
dans le panneau Barre latérale). Je repère le dossier Sites dans lequel je crée 
un sous-dossier que je nomme Mail. J’y glisse l’image de ma signature, un fichier
au format PNG, de 500 x 150 pixels pour un poids de 32 Ko, intitulé logo.png . 

e Vous pouvez utiliser la même méthode avec le compte Web personnel qui
vous est fourni par votre fournisseur d’accès à Internet ou sur votre serveur Web
personnel. Vous créez alors à la racine de votre espace Web un dossier intitulé
Mail dans lequel vous glissez les images grâce à n’importe quel client FTP.

e Ensuite, je clique sur l’icône de mon dossier Départ (en forme de maison)
dans la barre latérale et je crée un nouveau dossier Documents-Nvu 
dans lequel je placerai le modèle de page HTML utilisé pour ma signature.

3

2

Il existe quelques logiciels dédiés à la création de pages Web sur Mac OS X :
Dreamweaver, GoLive, Freeway Pro… Il y en a vraiment pour tous les goûts 

et pour tous les budgets. Cet atelier est cependant une bonne occasion de 
découvrir Nvu, un logiciel de création pour le Web distribué sous licence open
source et gratuit. Téléchargez-le à l’adresse : http://frenchmozilla.sourceforge.
net/nvu/. Attention, vous ne devez lancer Nvu qu’après l’avoir copié sur le disque 
dur et non depuis l’image disque.

e Je lance Nvu : un nouveau document est alors créé. Vous pouvez ouvrir 
plusieurs pages dans des onglets distincts (comme dans un navigateur) et donc 
éditer plusieurs pages simultanément, mais pour cet atelier, je n’ai besoin 
que d’une seule page. Il n’y aura donc qu’un seul onglet, CQFD!
Je clique sur l’onglet Sans titre, puis sur l’icône Enregistrer. Je suis d’abord 
invité à donner un nom à ma page – ici «Signature VVMac» –, et dans la fenêtre 
d’enregistrement proprement dite qui s’affiche ensuite, j’intitule le fichier 
«SignatureVVMac.html» (sans aucun espace entre les mots) et je le place 
dans le dossier Documents-Nvu que j’ai créé précédemment .

e L’onglet s’intitule désormais Signature VVMac et le fichier est enregistré 
sur mon disque dur. Pour une simple signature de courrier électronique, je vais
recourir à une méthode très basique. 
Avant tout, je vérifie que je travaille bien dans l’onglet Normal (en bas 
de la fenêtre) puis, dans la barre d’outils, je clique sur l’icône Image. Une fenêtre
me permet alors de choisir et de configurer certaines options pour l’image. 
Dans Emplacement, je saisis l’URL absolue de celle-ci, celle qu’il me faudrait 
taper si je voulais l’ouvrir dans un quelconque navigateur. Il s’agit donc 
d’une adresse du type http://homepage.mac.com/votrenom/Mail/logo.png. 
Dans le champ Texte alternatif, j’écris «Logo». J’aperçois d’ailleurs 
une vignette de mon image, preuve que l’URL est correcte .
Je clique ensuite sur Lien, et dans le champ, je note l’adresse suivante : http://
www.vvmac.com , puis OK… Nvu ajoute une image cliquable dans la page.

e Pour enrichir ma signature d’informations utiles – et surtout au cas 
où l’un de mes correspondants lirait le message hors connexion (donc sans
l’image) –, je rajoute quelques lignes de texte. Par exemple, mon nom 
et mes coordonnées. Comme dans un document Word, il suffit de positionner 
le curseur à droite de l’image et d’appuyer sur [Entrée] pour aller à la ligne. 
J’écris alors : «Vous et Votre Mac : faites le plein de solutions !
www.vvmac.com - email : redac@vvmac.com»
La barre d’outils de Nvu offre de nombreuses options pour régler mon texte. 
Je sélectionne les deux lignes, puis je choisis le jeu de polices Helvetica 
et Arial. Je conserve pour ma part la taille du texte telle qu’elle est définie .

e Comme je me trouve en mode HTML, je peux rendre ma signature interactive
en ajoutant des liens. Ainsi mes correspondants pourront-ils 
cliquer sur un lien qui sera immédiatement ouvert par l’application adéquate 
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Création de la signature HTML avec Nvu
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Je lance le navigateur Safari et j’ouvre le fichier 
SignatureVVMac.html que j’avais enregistré

dans le dossier Documents-Nvu de mon compte
Départ. Safari charge la page Web créée avec
Nvu . J’en profite pour tester cette page, et
notamment vérifier que les liens s’exécutent
correctement. À ce stade des opérations, il s’agit
de convertir le document HTML pour une utilisa-
tion sous forme de signature dans Mail. 
J’enregistre la page sur mon Bureau au format 
Archive Web. Safari reprend le nom du titre 

de la page. C’est accessoire puisque je ne vais
pas conserver ce nom dans la suite 
des opérations . Voilà, j’en ai fini avec Safari.11

10

Vous voici arrivé à l’étape la plus «ardue» de cet atelier, mais vous vous 
en sortirez bien si vous suivez correctement mes indications. 

Notre tâche consiste à donner à l’archive Web créée sur le Bureau à l’étape 
précédente un nom de fichier correspondant à la signature que nous souhaitons
modifier, celle que nous avons créée au tout début de cet atelier.

e Dans le Finder, je passe par le menu Aller > Aller au dossier : ~/Bibliothèque/
Mail/Signatures et je valide avec le bouton OK. Dans le dossier 
qui s’ouvre à l’écran, je trouve plusieurs archives Web, reconnaissables 
à leur extension « .webarchive» ainsi que des noms de fichiers compliqués, 
du type «6A9E84FE-C9EC-413B-82EC-4BE5B262FD93.webarchive» . 

Vous ne savez pas de quoi il en retourne ? Il s’agit tout simplement 
des fichiers qu’utilise Mail pour les signatures des messages ! Il fallait le savoir,
voilà la chose faite… 

e Si je n’ai créé qu’une seule signature dans Mail, c’est un véritable jeu 
d’enfant : tout d’abord, je copie le nom de l’archive Web d’origine. Ensuite, 
je remplace cette archive par celle que j’ai créée avec Safari. Elle se nomme

12

Convertissez la page en archive Web 

Installez la nouvelle signature

(un lien «www» pour un navigateur ou «mailto» pour un logiciel de courrier 
électronique…). Je sélectionne donc «www.vvmac.com», puis je clique 
sur l’icône Lien dans la barre d’outils et je tape dans le champ l’adresse
«http://www.vvmac.com» . Je valide avec OK. Je procède de la même 
manière avec «redac@vvmac.com»: dans la fenêtre de configuration du lien, 
je saisis «redac@vvmac.com» et coche la case La valeur ci-dessus est une
adresse électronique . OK à nouveau. J’enregistre la page et je quitte Nvu.

e Évidemment, vous n’avez découvert ici que certaines fonctions vraiment 
très simples de l’application Nvu. Avec un peu d’expérience, vous pourrez ajouter
des éléments graphiques plus sophistiqués ou encore des feuilles de styles 
pour égailler davantage vos messages avec des effets surlignés ou des images
animées. Si vous attachez une feuille de styles dans un fichier externe, 
ou encore un script JavaScript dans un fichier externe, vous devez télécharger
sur Internet ces fichiers et taper leur adresse absolue dans le code source 
de la page Web, comme je l’ai fait pour mon image. 

9
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Pour tester ma nouvelle signature, j’ouvre Mail, puis je crée un nouveau 
message (menu Fichier > Nouveau message). Je me choisis comme 

destinataire. Dans le champ Objet, j’inscris «Test» et éventuellement une petite
bafouille dans la zone du message. Dans le menu local Signature – remontez 
à l’étape 1 (si vous ne le voyez pas, je vous ai expliqué comment le configurer) –,
j’opte bien entendu pour… Signature VVMac.

e L’onglet Signature de la fenêtre des préférences de Mail n’affiche pas
l’image. C’est aussi parfois le cas de la fenêtre de rédaction du message… 
lorsque le compte utilisé n’est pas connecté. Pour simplifier, Mail ne connecte 
le compte que lors de la relève du courrier ou de la lecture d’un message. 
Je dois donc d’abord enregistrer ce dernier et le fermer. Il se retrouve 
alors dans la BAL Brouillons. Je m’assure d’être bien connecté à Internet, j’ouvre 
à nouveau le message depuis la BAL Brouillons pour le lire : ma signature HTML
apparaît bien en entier . Je m’estime satisfait et je clique sur Envoyer.

Vous avez appris dans cet atelier comment agrémenter vos signatures 
dans Mail d’une image et d’un zeste d’interactivité. Vous pourriez aller plus loin
en créant facilement des messages percutants en HTML. Suivez simplement 
les étapes 1 à 5 de cet atelier, mais dans Safari, au lieu d’enregistrer 
une archive Web, choisissez le menu Fichier > Envoyer le contenu de cette page
par courrier électronique. Pour plus de détails, reportez-vous à l’atelier En RTF 
ou en HTML, créez et envoyez des emails graphiques paru dans VVMac N°9.

15

«Signature VVMac» et se trouve encore sur le Bureau. Une fois que j’ai procédé
à la substitution, je renomme celle-ci en collant tout simplement le nom 
copié de l’archive d’origine. Compris? Alors le tour est joué. Nous pouvons 
désormais passer à l’étape suivante. Sauf si…

e Il se trouve que je possède plusieurs signatures dans Mail. C’est alors un poil
plus compliqué car je suis face à plusieurs fichiers aux noms improbables. 
Il me faut déterminer quel est celui qui correspond à la signature que je veux
modifier. Le catalogue des signatures est enregistré dans un fichier unique 
SignaturesByAccount.plist au format XML. Je l’ouvre avec TextEdit 
et je recherche l’expression «Signature VVMac». Je découvre alors une ligne :
<string>Signature VVMac</string>, et en dessous, <key>SignatureUniqueId</key>.
Sous cette dernière se trouve la suite de chiffres et de lettres correspondant 

à la Web Archive, par exemple 6A9E84FE-C9EC-413B-82EC-4BE5B262FD93 .
Je copie cette série, sans les balises <string> et </string>. Je renomme l’archive
Web enregistrée sur le Bureau avec Safari en collant la série de chiffres 
et lettres et j’ajoute l’extension « .webarchive». Enfin, je glisse le fichier dans
~/Bibliothèque/Mail/Signatures et j’accepte la substitution . 
Enfin, je quitte TextEdit sans modifier le fichier SignaturesByAccount.plist.

14

13

Utilisez votre nouvelle signature

14

15

550 pages

e Conservez les PDF haute résolution 
des 6 premiers numéros de VVMac.

e Une navigation confortable grâce aux liens.

d’astuces et d’ateliers 
pour optimiser Mac OS X et 
mieux utiliser vos logiciels et votre Mac !

À commander sur notre site www.vvmac.com
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Un mur de briques, un ciel de nuages, des lettres en bois, un bas-relief en marbre, une photo 
imprimée sur du tissu. On pourrait compléter cette liste avec un raton laveur, mais ce serait hors 
de propos… Vous l’avez sans doute deviné, nous allons parler d’effets de texture. Si vous pratiquez
la 3D, vous connaissez bien ces effets de matière qui permettent de donner plus de réalisme 
à vos créations, mais vous ignorez peut-être que Photoshop Elements dispose lui aussi de textures
et les exploite sur une image en 2D. Je vous propose donc de voir de plus près comment 
fonctionnent ces textures, et même comment en créer vous-même de nouvelles. n Mathieu Lavant

Photoshop Elements propose plusieurs commandes qui 
permettent d’appliquer des textures, les unes regroupées 

dans le sous-menu Filtre > Textures, les autres accessibles 
par la rubrique Effets > Texture de la palette Styles et effets.

e Vous trouverez dans le sous-menu Textures cinq filtres
qui produisent des effets de texture prédéfinis ainsi que le filtre
Placage de texture… auquel nous nous intéresserons tout 
particulièrement puisqu’il est le seul qui permet d’exploiter 
des textures externes, comme celles que nous allons créer.
Lorsque vous lancez le filtre Placage de texture, Photoshop 
Elements affiche l’interface Galerie de filtres qui intègre une zone 
de prévisualisation dans sa partie gauche, une zone 
de paramétrage dans sa partie droite et, au centre, une section 
escamotable pour accéder aux autres filtres gérés par l’interface.
Le filtre Placage de texture applique à l’image active une texture
d’arrière-plan que vous pouvez sélectionner à partir du menu local
Texture. Comme vous le constaterez, le filtre agit uniquement sur 
le relief du support en simulant un fond de pierre, brique ou toile .
Toutefois, l’intérêt du filtre ne réside pas dans les quatre ou cinq
textures que vous propose le menu local, mais dans la petite flèche
noire qui jouxte ce dernier et permet d’accéder à la commande
Charger une texture… Nous y reviendrons un peu plus loin !

e Pour les effets, dans la palette Styles et effets, la rubrique 
Effets > Texture propose ses propres textures . Ici, il ne s’agit
plus de doubler le fond d’une image d’un effet de matière, 
mais de remplir un premier plan (sélection ou calque) d’une matière
prédéfinie. Plus concrètement, dans notre exemple la texture métal
rouillé est appliquée à une sélection de l’image : Photoshop 
Elements génère alors un nouveau calque contenant la sélection 
remplie par la texture .
La palette Styles et effets ne vous permet pas de charger 
de nouvelles textures, mais rien ne vous empêche d’exploiter 
de la même manière des textures de remplissage créées dans des
fichiers externes. Nous en reparlerons dans un prochain numéro…

4

3

2

1

Avec Photoshop Elements, 

jouez la carte des textures!

État des lieux…
1

2

3

4
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Comment ça marche?

Les textures dont se sert le filtre
Placage de texture sont 

des fichiers en niveaux de gris, 
enregistrés au format PSD 
(le format natif de Photoshop).

e Le filtre interprète les différentes
valeurs de gris du fichier comme 
autant de niveaux de relief 
ou de profondeur. Le principe est 
le suivant : le blanc produit un relief, 
le noir produit un creux. L’interface 
du filtre propose l’option Inverser
pour permuter les valeurs de noir et 
de blanc ainsi que la gamme de gris.
Exemple : j’ai ici un fichier de texture
(copyright) en niveaux de gris

que j’applique sur une image via 
le filtre Placage de texture .

e Le fichier de texture n’a pas 
de dimensions minimales. Lorsque
l’image cible est plus grande que 
le fichier de texture, Photoshop 
Elements exploite ce dernier 
en mosaïque afin de couvrir toute 
la surface de l’image à traiter. 
Si vous utilisez une texture régulière,
les raccords seront invisibles, mais 
si vous avez créé une texture 
irrégulière, des joints apparaîtront.
Pour éviter cela, n’hésitez pas 
à travailler sur des textures en grand 
format (1025 x 768 pixels ou plus).

6

5

Àprésent que vous connaissez le fonctionnement des textures, 
nous allons passer à la pratique en préparant une texture qui produira 

un effet de grillage . Quoi de plus facile, n’est-ce pas?

e Pour réaliser cette texture, nous partirons d’un document vierge 
de 800 x 600 pixels en niveaux de gris sur lequel nous commencerons par créer
un damier régulier en nous aidant de la grille (Affichage > Grille).
Activez le rectangle de sélection et tracez un premier carré dans l’angle 
supérieur gauche du document, en vous calant sur le premier carreau 
de la grille. Si vous trouvez les carreaux trop grands, n’hésitez pas à modifier 
les paramètres de cette dernière dans la boîte de dialogue des Préférences
(Menu Photoshop Elements).
Remplissez le premier carré de noir (Édition > Remplir), puis créez un second
carré noir sur le second carreau de la deuxième ligne de la grille 
de manière à produire un motif à damier que nous allons ensuite dupliquer. 
Nous avons donc le motif de base de la grille .
À l’aide du Rectangle de sélection, sélectionnez ce motif de quatre carreaux, puis 
récupérez le Pointeur de déplacement. Appuyez sur la touche [Alt] et déplacez 
le motif de deux carreaux vers la droite. Une fois la position atteinte, relâchez le
bouton de la souris, puis la touche [Alt] : le motif est dupliqué . Répétez cette
opération de déplacement-duplication jusqu’à remplir l’ensemble du document.

e Le damier est achevé. Il va falloir le pivoter à 45°. Pour ce faire, vous pourriez
utiliser les commandes du sous-menu Image > Rotation, mais pour plus 

de simplicité nous utiliserons la commande
Transformation > Transformation manuelle.
Activez la commande Transformation 
manuelle : Photoshop Elements affiche 
une alerte vous demandant si vous 
souhaitez convertir votre document 
en calque. Cliquez sur OK et validez la boîte
de dialogue qui suit avec ses réglages 
par défaut. Votre damier s’affiche alors 
dans un rectangle de transformation 
doté de huit poignées. Placez le pointeur 
de la souris à proximité de l’une 

9
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7

5

6

7

eee

À vous de jouer!

8 9
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Désormais, tout est possible ! 
Si vous avez compris 

le principe et la mise en œuvre,
vous pourrez par exemple 
créer une texture de carton ondulé
ou de tôle ondulée 
en exploitant les dégradés 
et un filtre de bruit pour ajouter 
un peu de matière.

1514

Et après?

des poignées d’angle, celui-ci affiche dès lors une double flèche incurvée. 
Effectuez ensuite un cliquer-glisser pour faire pivoter le damier de 45°, avec 
la touche [Maj] enfoncée .

e Comme vous le constatez, la rotation fait apparaître le fond transparent 
du document. Il va falloir combler ces vides pour exploiter le fichier comme 
texture. Deux solutions : soit vous validez la transformation telle quelle 
avec la touche [Entrée] et vous remplirez les vides en opérant par duplication
d’une sélection – comme nous l’avons fait plus haut –, soit vous profiterez 
de la commande Transformation manuelle pour agrandir le damier de manière 
à ce qu’il occupe toute la surface du document. Quelle que soit la solution 
retenue, votre damier aura l’allure suivante au final .

e Dernière étape. Avant que la texture ne produise l’effet de grillage
attendu, il reste une dernière opération à effectuer : appliquez un filtre
à l’ensemble du damier. Cela dit, vous pouvez d’ores et déjà tester 
le fichier à partir du filtre Placage de texture. Après avoir ouvert 
un fichier RVB quelconque qui vous servira de fichier test, ouvrez 
Filtre > Textures > Placage de texture… Cliquez sur la flèche noire 
pour activer la commande Charger une texture… et, dans la boîte 
de dialogue qui s’affiche, sélectionnez votre fichier de texture.
Revenons à notre fichier de travail. Pour transformer le damier que
vous avez créé en quelque chose qui ressemble à un grillage, utilisons 
le filtre Contour lumineux en conservant ses réglages par défaut. 
Vous accédez à ce filtre via le sous-menu Filtre > Esthétiques ou bien 
à partir de l’interface Galerie de filtres .

e Voilà le moment tant attendu : le test de la texture. Reprenez votre image 
RVB de test et relancez le filtre Placage de texture… Chargez la texture 
que vous venez de créer et admirez le résultat ! En pratique, il se peut que 
ce que vous voyez ne soit pas vraiment ce que vous espériez. La raison est 
simple, votre filtre n’est pas correctement paramétré.
Pour remédier à cela, rendez-vous dans la partie droite de l’interface où sont 
regroupés les paramètres du filtre. Commencez par ajuster le réglage 
du Relief à sa valeur maximale, puis vérifiez que le réglage Lumière est sur 
l’une des valeurs suivantes : Haut, Bas, Gauche ou Droite. Enfin, ajustez éventuel-
lement le réglage Échelle pour modifier la taille des mailles du grillage .13
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FORMULAIRE DE COMMANDE D’ANCIENS NUMÉROS
À remplir LE PLUS LISIBLEMENT POSSIBLE et à retourner à l’adresse :

howtodo publishing – 114, rue des Pyrénées - 75020 Paris

Oui, je commande 1 e xemplaire du nn°°22 n,, 33 n,, 44 n,, 66 n,, 88 n,, 99 n,, 1100 n ou 1111 n au prix unit aire 
de 6,85 € et le hors-série Tiger n au prix de 5,50 € (Frais de port inclus). Tarif valable uniquement pour
la France Métropolitaine. Je règle aujourd’hui par chèque à l’ordre de howtodo publishing.

o M. o Mme o Mlle

Prénom :

Nom :

Adresse :

C.P. :                       V ille :

E-mail :

Tél. : 

Vos e-mail et téléphone servent à vous joindre rapidement 
au cas où nous aurions des difficultés à relire votre 
formulaire, en cas d’erreurs ou d’oublis dans vos coordonnées.
Conformément à l’article 27 de la loi Informatique et Libertés du 6 janvier 1978, vous disposez d’un droit d’accès et de rectification aux informations vous 
concernant. Les informations ci-dessus, étant traitées informatiquement, sont indispensables à la gestion de votre commande. Vous pouvez vous opposer à leur ces-
sion ultérieure en nous le précisant par écrit.

VVMac numéro 
HORS-SÉRIE

Vous avez manqué les premiers numéros de Vous et Votre Mac ?

Complétez votre collection !
Vous et Votre Mac N°2

EDossier : Tiger à quoi faut-il 
vous attendre ?

EMac OS X : protégez-vous, 
installez un pare-feu.

EOptimiser : des outils pour tirer
parti du PDF.

ETrucs et astuces Word-Excel.
ECréez votre site Internet avec 

les outils .Mac.

Vous et Votre Mac N°6

EDossier : La fièvre du podcasting.
EDossier : Tiger, notes et astuces.
EOptimiser : Créez autant de 

photothèques que vous voulez.
EOptimiser : le diaporama de 

papy est de retour !
ETrucs et astuces Excel.
EDes idées pour utilise à fond

votre iSight.

Vous et Votre Mac N°3

EDossier : Le Mac mini, il tient 
toutes ses promesses !

EMac OS X : Choisir un utilitaire 
alternatif au Dock

EOptimiser : pilotez votre Mac 
au clavier

ETrucs et astuces Word-Excel.
ETirez tout le parti de votre 

enregistreur de DVD de salon.

Vous et Votre Mac N°8

EDossier : Tout sur iTunes !
EMac OS X : postez en toute 

liberté grâce au serveur Postfix.
EOptimiser : comment créer un

petit widget.
EHabillez d’une interface 

graphique une commande Unix.
EComment chapitrer et diffuser

votre podcast.

Vous et Votre Mac N°10

EDossier : Entretenez Mac OS X.
EMac OS X : Vous premiers pas

avec Automator.
EOptimiser : Open Source, 

utilisez des logiciels libres.
ETrucs et astuces iLife 05.
EPréparez vos films vidéo pour 

les visionner sur un iPod 5G.
EDessinez une boîte en 3D.

Vous et Votre Mac N°11

EDossier : Magnétoscopes 
numériques et mediacenters

EMac OS X : Bien xploiter les 
dossiers à graver.

EOptimiser : sécurisez votre 
borne AirPort.

EVidéo : maîtrisez la puissance 
de MPEG Streamclip.

EUn site avec RapidWeaver.

Vous et Votre Mac N°9

EDossier : Réalisez le DVD de vos
vacances avec iLife 05.

EMac OS X : Gérez vos fontes avec
le Livre des polices.

EOptimiser : Tout partager entre
Mac et PC.

ECréez facilement un blog.
EEn RTF ou HTML, créez et 

envoyez des emails graphiques.

Vous et Votre Mac N°4

EDossier : Redécouvrez Panther.
EDossier : Newsgroup, le grand

forum mondial.
EMac OS X : donnez un bon coup

de pinceau à votre Finder.
ETrucs et astuces AppleWorks.
EColorisez les cartes postales.
EModifiez simplement l’interface

de votre iPod.

E Indispensable pour 
optimiser votre utilisation
de Tiger.

E Incontournable si vous 
envisagez de faire la mise 
à jour ou d’acheter un 
nouveau Mac.

Date :____/____/______ et signature
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Cette rubrique a été 
spécialement conçue 

pour vous !

Contactez

Angélique Mermet
Tél. : 01 40 33 79 56

angelique@vvmac.com

Vous 
voulez 
communiquer?
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Commençons par mettre en place le document, définir son format, l’enregistrer
et placer quelques repères qui nous seront utiles ultérieurement.

e Quand vous ouvrez Inkscape, s’affiche par défaut un document vierge au format
A4. Si ce n’est pas le cas, activez la commande File > New pour créer 
un nouveau document. Notre première tâche consistera à redéfinir son format
afin de l’adapter à celui de la carte de vœux: rendez-vous dans le menu File
où vous choisissez l’article Document Preferences et affichez la palette . 

e Dans le menu local de la rubrique Canvas size
(taille du document), optez pour Custom
qui permet de définir un format personnalisé, 
puis descendez dans la partie inférieure 
de la palette (Custom canvas) afin de préciser 
les dimensions du document (pour notre projet,
la carte est au format 210 x 95 mm). N’oubliez pas
de sélectionner «mm» dans le menu local Units.

e Enregistrez votre document à l’aide de la com-
mande File > Save as… Dans la boîte de dialogue
d’enregistrement, contentez-vous de nommer 
le fichier. Inkscape l’enregistrera automatiquement
dans son format de travail, à savoir le format SVG.

1

Mise en place du document
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Vous n’avez pas 
encore sacrifié à la
tradition des vœux ?
Je vous propose donc
de créer une carte
personnalisée avec
Inkscape, le logiciel 
de dessin vectoriel
open source que 
je vous avais présenté
dans Vous et Votre
Mac de décembre.

P
ourquoi donc utiliser Inkscape, me demanderez-vous ? Tout
simplement parce que cette application associe des fonctions
de dessin évoluées et d’autres de mise en page que vous ne trou-

verez ni dans votre traitement de texte favori, ni dans votre logiciel
de traitement d’images. Mieux, vous pouvez le télécharger et l’utili-

ser gratuitement… La carte de vœux que je vous propose de réaliser
est composée d’un fond dégradé sur lequel nous placerons une image
associée à une découpe, une série de petits carrés régulièrement espa-
cés, un objet texte et le logo « bidule» avec son texte curviligne. En
somme, rien de bien compliqué. On y va? n Mathieu Lavant

Démarrez l’année en beauté avec Inkscape:

concevez votre carte de vœux!

ATELIER

2

1

e Inkscape affiche à présent une carte vierge qui ne demande qu’à recevoir 
un contenu. Encore faut-il savoir où placer ledit contenu. Pour nous aider 
dans le positionnement des différents éléments, nous allons utiliser des repères
que nous insérerons de la manière suivante… 
Assurez-vous tout d’abord que la fenêtre de travail affiche les règles graduées 
(sinon, faites [Ctrl R]), puis effectuez un cliquer-glisser depuis la règle verticale 
pour insérer un premier repère vertical que nous utiliserons afin de matérialiser 
le bord droit de la photo.
Insérez ensuite deux autres repères verticaux pour indiquer la position 
du logo «bidule», puis deux repères horizontaux; le premier pour caler les petits 
carrés et le texte, le second pour caler le haut du logo .2
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L’image et sa découpe

Comme vous l’aurez certainement remarqué, la photo qui occupe la partie
gauche de la carte est dotée d’une «enveloppe» qui n’est pas rectangulaire,

mais légèrement convexe. Cet effet est produit par l’utilisation d’un tracé 
qui vient découper la photo. Selon ce même principe, nous pourrions créer 
une enveloppe au contour ondulé ou d’une tout autre forme.

e Commencez par importer la photo que vous souhaitez utiliser dans 
le document à l’aide de la commande File > Import. Vous pouvez sélectionner 
un fichier bitmap, car Inkscape reconnaît la plupart des formats courants 
(Tiff, JPeg, Pict…). Peu importe donc le format de votre fichier, l’essentiel 
est que ses dimensions ne soient pas trop importantes, sans quoi l’image 
risque d’envahir votre fenêtre de travail que vous devrez redimensionner.
Une fois l’image importée, déplacez-la sur le côté du document à l’aide 
du pointeur de sélection (le premier outil de la palette), et ce afin de dégager 
le terrain pour la suite des opérations.

e Il faut maintenant dessiner la forme qui servira de découpe. C’est la tâche 
la plus délicate à réaliser si vous n’êtes pas familier des outils de dessin vectoriel.
Il s’agit de tracer un rectangle dont le côté droit est légèrement arrondi.
Activez l’outil de dessin de courbe de Bézier (le second outil placé en dessous 
de l’outil Spirale) et insérez un premier point en cliquant sur l’intersection 
du bord haut de la carte et du premier repère vertical. Ensuite, rendez-vous 
sur l’angle supérieur gauche de la carte et cliquez à nouveau afin d’insérer 
un second point. En cours de déplacement, vous remarquerez que le pointeur 
est relié au point précédent par un fil rouge qui matérialise le futur tracé. 
En procédant de manière identique, insérez un point sur l’angle inférieur 
gauche de la carte, puis sur l’intersection de son bord inférieur et du premier 
repère vertical de notre document. 

e Pour tracer le côté arrondi du rectangle, positionnez le pointeur à mi-hauteur
de la carte et décalez-le vers la droite du repère vertical, puis effectuez 
un cliquer-glisser vers le haut. Vous constaterez que plus vous tirez 
sur la tangente et plus le dernier segment que vous avez tracé s’arrondit . 
Pour refermer le tracé, cliquez sur le point de départ de votre rectangle. 
Si tout se déroule comme prévu, Inkscape affichera alors le tracé entouré 
d’un rectangle en pointillés .

e Vous pouvez respirer, car vous avez
effectué le plus dur… Nous disposons
à présent d’un tracé et d’une photo
que nous allons réunir pour produire
l’effet de découpe. Au préalable, 
il nous faudra convertir la photo 
en Pattern (ou motif). Pour ce faire,
reprenez le pointeur de sélection 
et cliquez sur la photo, puis faites Edit >
Object to pattern. Ne vous inquiétez
pas si rien ne semble se passer, 
c’est tout à fait normal.
Revenez au tracé, sélectionnez-le 
en cliquant sur son contour 
et déplacez-le jusqu’à le positionner 
sur la photo. Faites Object > Raise 
to top de manière à ramener 
votre tracé au premier plan . 

e Sélectionnez le tracé et la photo
avec le pointeur de sélection et la
touche [Maj] enfoncée. Faites Object >
Intersection afin de combiner 
le tracé de premier plan avec la photo d’arrière-plan. Le tracé agit alors comme
une découpe et masque la zone de l’image située à l’extérieur de celui-ci. Pour 
finir, repositionnez la photo découpée dans la partie gauche de la carte.7
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Dans cette troisième étape, nous créons la série
de carrés roses en bas de la carte (comme 

des points de suspension), puis l’année «2006».

e Avec l’outil Rectangle, tracez un premier carré 
(la contrainte au format carré s’effectue en maintenant
enfoncée la touche [Ctrl] durant le tracé). 

e Pour la mise en couleur du carré, nous pourrions
avoir recours à la palette Fond et contour, mais 
nous ferons plus simple en utilisant la Pipette avec
laquelle nous récupérons directement une couleur
de la photo. Après avoir tracé le premier carré, 
activez l’outil Pipette (le dernier outil de la palette)
et cliquez dans la photo sur la teinte que vous 
souhaitez utiliser. Le carré adopte automatiquement
la couleur précédemment prélevée.

e Reprenez le pointeur de sélection, cliquez sur le carré pour le sélectionner,
puis faites un copier suivi d’un coller jusqu’à l’obtention de cinq ou six carrés 
supplémentaires. Alignez-les ensuite grossièrement sur votre carte de vœux.

e Pour parfaire l’alignement des carrés et leur espacement régulier, 
Inkscape dispose d’une palette Align (alignement), accessible par le menu 
Object > Align and distribute.

Le fond dégradé

Les petits carrés et le texte

Si vous avez franchi brillamment la première étape, la création du fond 
dégradé sera pour vous un jeu d’enfant. En pratique, il s’agit de dessiner 

un rectangle et de lui donner un fond dégradé. Nous utiliserons l’outil 
Rectangle de la palette Tools (outils) et la palette Fill and stroke (fond et contour)
qu’on affiche avec la combinaison de touches [Ctrl F].

e L’outil Rectangle activé, tracez le rectangle de fond de la carte en effectuant
un cliquer-glisser, puis reprenez l’outil de sélection. Le rectangle 
s’affiche entouré de huit poignées fléchées qui permettent, le cas échéant, 
de le redimensionner. Notez qu’il s’affiche au premier plan et masque la photo.
La première chose à faire est donc d’envoyer ce rectangle à l’arrière-plan 
avec le menu Object > Lower to bottom.

e Pour créer le fond dégradé, cliquez dans la palette Fill and stroke sur 
l’onglet Fill. Dans la partie supérieure de la palette, cliquez sur l’icône Flat color
(à droite de la croix) , sélectionnez une couleur dans l’anneau de couleur et

ajustez la teinte en cliquant à l’intérieur
du triangle . Cette opération aura
pour effet de remplir votre rectangle 
de fond d’une couleur en aplat 

e Cliquez ensuite sur l’icône Linear 
gradient (dégradé) qui jouxte l’icône Flat
color : le fond du rectangle est converti
en dégradé .

e Arrivé à ce stade, vous constaterez
peut-être que votre fond dégradé est 
inversé. Si tel est le cas, activez l’outil 
Dégradé (au-dessus de l’outil Pipette,

dans la partie inférieure de la palette Tools) et effectuez un cliquer-glisser 
sur le rectangle, de son bord droit jusqu’à son bord gauche. Vous verrez alors,
sous vos yeux ébahis, le dégradé changer de sens !
Si la manipulation de l’outil Dégradé vous pose des difficultés, reprenez 
le pointeur de sélection et cliquez deux fois sur le fond dégradé de manière 
à faire apparaître des doubles flèches arrondies à ses quatre angles. 
Cliquez sur l’une de ces flèches et faites pivoter le rectangle de fond de 180 °.
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La palette Align affichée, sélectionnez l’ensemble des carrés en effectuant 
un simple cliquer-glisser, puis cliquez sur la commande d’alignement 
horizontale . Cliquez ensuite sur la commande de répartition située 
juste en dessous . Facile !

e Reste à insérer l’année «2006» avec l’outil Texte et la palette Text 
and fonts (texte et polices) que vous affichez en cliquant sur l’icône A située
dans la partie supérieure de la fenêtre de travail. Ensuite, cliquez sur la carte
de vœux et saisissez l’année «2006». Sélectionnez le texte que vous venez
d’entrer, et dans la palette Text and fonts réglez la police et le corps. 
Dans le modèle réalisé ici, j’ai utilisé du Triplex Extrabold en corps 90) .
Validez vos réglages en cliquant sur le bouton Apply (appliquer) et déplacez
éventuellement le bloc de texte à l’aide du pointeur de sélection.

14

13

12

On finalise…

Nous voilà rendus à la dernière étape, celle où l’on personnalise la carte 
avec, par exemple, l’insertion d’un logo. Si vous disposez déjà d’un logo 

enregistré dans un format bitmap ou vectoriel, rien ne vous empêche 
de l’insérer directement dans le document à l’aide du menu File > Import.
Étant donné sa simplicité, je préfère redessiner le logo en trois clics de souris : 
il s’agit de deux disques de couleur superposés et d’un texte curviligne 
qui vient se placer sur le contour du disque extérieur.

e À l’aide de l’outil Ellipse, dessinez deux disques, le premier doté 
d’un diamètre double du second, puis modifiez leur couleur de fond à l’aide 
de la palette Fill and stroke (fond et contour) que nous avons déjà mise 
en œuvre. Sélectionnez ensuite les deux disques et alignez-les comme 
dans notre exemple, en utilisant la palette Align .

e Reprenez l’outil Texte pour taper le mot «bidule» (ou ce que vous voulez,
bien sûr) et enrichissez-le avec les options que vous offre la palette 
Text and fonts que nous connaissons aussi. Placez-le ensuite à cheval sur 
les deux disques de manière à vérifier qu’il est bien au premier plan. 
Dans le cas contraire, activez la commande Object > Raise to top.
Sélectionnez à nouveau le disque de fond et convertissez-le en tracé via 
le menu Path > Object to Path. Sélectionnez le mot «bidule» avec la touche
[Maj] enfoncée de façon à obtenir une sélection du disque et du texte . 

e Pour créer le texte curviligne, utilisez le menu Text > Put on path
(qu’on peut traduire par «accrocher au tracé») : le texte vient alors se caler 
sur la périphérie du disque. Malheureusement, il est à l’extérieur… Pour remédier
à cela, dans le menu Path, faites Inverse (inverser). Miracle, tout rentre 
dans l’ordre . Le logo est achevé, ou presque… Reste à régler quelques 
détails comme la taille, la position du texte, et éventuellement sa couleur. 
Surtout, nous devons placer cet assemblage dans notre carte de vœux.

e Double-cliquez sur le disque de fond et faites-le pivoter en utilisant l’une 
de ses poignées d’angle. Pour modifier les attributs du texte, double-cliquez 
sur son bloc afin de basculer en mode d’édition de texte, puis sélectionnez 
ce dernier. Dans la palette Text and fonts, ajustez le corps du texte, puis passez
à la palette Fill and stroke (fond et contour) et fixez sa couleur.
Cela fait, sélectionnez l’ensemble du logo et, avec le menu Object > Group
(grouper) transformez l’assemblage en un objet unique que vous pourrez 

déplacer d’un seul bloc 
et redimensionner pour 
l’adapter à la carte de vœux.

e Voilà, la carte de vœux est
prête ! Oui, mais qu’en faire?
L’expédier par email 
ou l’envoyer par courrier 
classique après l’avoir 
imprimée? Quelle que soit 
la solution retenue (et ayant eu
quelques soucis d’impression

depuis Inkscape), je vous conseille d’exporter votre document dans un format
plus standard que vous pourrez rouvrir avec Aperçu ou Photoshop Elements, 
ou importer directement dans Mail. Si vous souhaitez exporter votre carte 
dans un format bitmap, utilisez la commande File > Export bitmap qui génère 
un fichier au format PNG, largement reconnu par les applications Mac OS X .
Si vous souhaitez préserver le contenu vectoriel du document, utilisez 
la commande File > Save as… et enregistrez la carte au format EPS. Vous pourrez
ensuite rouvrir et imprimer votre fichier à partir de Photoshop Elements. 
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Vous êtes l’heureux possesseur d’un iPod 5G? Ne vous abîmez
plus les yeux à regarder vos films sur l’excellent, mais trop 
petit écran; regardez-les plutôt en grand sur n’importe 
quel téléviseur. Dans cet atelier, je vous indique comment 
fabriquer des fichiers de la meilleure qualité.

Utilisez votre iPod 5G et votre télévision
avec un maximum de confort

ATELIER

Connectez votre iPod à un téléviseur

C
onçu au départ comme un simple
baladeur musical, l’iPod a su évo-
luer d’abord vers la photo, puis les

podcasts, et enfin la vidéo est venue tout naturellement pren-
dre place avec la prise en charge des formats vidéo MPeg-4 et H.264.
Les iPod 5G ont un écran à cristaux liquides translectif de 2,5” de

diagonale (50 x 38 mm réels mesurés), rétro-éclairé par des diodes,
et affichant plus de 65000 couleurs à une résolution de 320 x 240
pixels avec un pitch de 0,156 mm. Cet écran tire pleinement parti
des capacités et de la taille de l’appareil. Grâce à lui, le visionnage
d’une vidéo s’effectue dans de bonnes conditions, mais cela reste tout
de même un plaisir solitaire et l’on perd beaucoup à regarder ainsi
des œuvres conçues pour des diagonales de plus de 20 m!
Puisque l’appareil dispose d’une sortie mini-jack (audio et vidéo com-
posite), il est tentant de le brancher à un téléviseur pour profiter à
plusieurs et dans de meilleures conditions de son contenu. Las, ce
qui apparaissait impeccable sur le tout petit écran n’est plus aussi
beau sur le grand! Si aucun outil ne vous permet d’améliorer la qua-
lité de vos sources – il ne servira ainsi à rien de tenter d’augmenter
la taille ou la résolution d’une vidéo déjà de mauvaise qualité –, nous
allons voir qu’il y a tout de même quelques techniques pour faire de
votre iPod 5G un vrai magnétoscope de poche. n Frédéric Blaison

La prise «écouteurs» de l’iPod 5G accepte 
un mini-jack stéréo, vidéo composite et audio.

Sur la plupart de nos postes de télévision courants,
on trouve une prise Péritel et/ou des prises RCA. 
De quoi afficher sans problème une vidéo Pal.

e Pour relier l’iPod 5G à la TV, il faut vous procurer
le câble vidéo proposé en option par Apple (19 €).
De très bonne qualité, il ne se branche pas sur 
la Péritel, mais a trois connecteurs Cinch (blanc et
rouge pour l’audio, jaune pour la vidéo). Si votre TV
n’a qu’une Péritel, vous devrez en plus acquérir 
un adaptateur très courant Péritel/RCA 
(l’AppleStore vend un Belkin à 7,50 €). L’idéal serait
que les bricoleurs qui savent souder puissent 
confectionner eux-mêmes le câble en utilisant 
des connecteurs mini-jack et Péritel plaqués or ainsi
que le câble vidéo adéquat, histoire d’avoir une liai-
son directe d’une dimension plus confortable 
(le câble AV d’Apple ne mesure que 1,40 m de long).
Reste que le mini-jack 3,5 à 4 contacts, 
nécessaire du côté de l’iPod, semble pour l’instant

très difficile à trouver dans les boutiques 
de composants électroniques. 

e En option également, vous vous munirez 
du nouveau Dock universel d’Apple (39 €)
– aucune station d’accueil n’est fournie avec l’iPod
5G – et de la télécommande Apple Remote (29 €)

–, à moins que vous ne soyez le propriétaire
d’un iMac G5 avec iSight, fourni avec la même 
télécommande. Hélas, ce système ne permet pas 
de naviguer dans l’iPod et ne servira qu’à faire 
des pauses, des avances/retours (pas très) rapides,
ou à régler le niveau sonore. D’ailleurs, celui-ci est
très faible et il faudra impérativement le mettre 
à fond sur l’iPod et ajuster ensuite le son de la TV.

e L’iPod doit savoir si vous voulez lire la vidéo 
sur son écran ou sur un téléviseur. La commutation
ne se fait pas directement lorsqu’on branche 
le câble, comme on aurait pu l’imaginer ; il faut le lui
dire. Pour cela, il existe une préférence dans Clips
vidéo > Réglages vidéo. L’article Sortie télévision

propose les choix Oui, Non
ou encore Demander. Le choix Demander permet
d’afficher à l’écran TV éteinte (lecture sur l’iPod) 
ou TV allumée (lecture extérieure). À l’article Signal
TV, choisissez entre PAL et NTSC. Ainsi équipé, l’iPod
devient un très pratique magnétoscope de poche.
Au-delà de la simple lecture de clips musicaux, 
il vous permettra d’emmener partout vos vidéos 
familiales, votre CV vidéo, des présentations d’en-
treprise, des supports de cours et de formation… 
Il suffit d’une TV et le tour est joué. C’est quand
même beaucoup plus facile que de s’encombrer 
de cassettes VHS, ou même de DVD, et de trouver
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sur place un magnétoscope VHS ou un lecteur 
de DVD. Ici, tout tient dans une poche : iPod, câble,
adaptateur et même (si vous avez pris cette option)
le Dock universel et la télécommande…
D’autant plus qu’avec un encombrement d’environ

700 Mo par heure de vidéo de très bonne 
qualité (comme on le verra ci-dessous), 
ce ne seront pas moins de 85 h de films divers 
et variés qui trouveront place dans un iPod 60 Go.
De quoi épater amis et collègues.

Quels fichiers vidéo utiliser?

Selon les caractéristiques techniques de l’iPod
données par Apple, nous avons le choix 

entre deux types différents d’enregistrement :
H.264 : jusqu’à 768 kb/sec, 320 x 240 pixels, 30 ima-
ges par seconde, profil de référence jusqu’au niveau 
1.3 avec AAC-LC jusqu’à 160 kbps, 48 kHz, son stéréo
aux formats de fichier .m4v, .mp4 et .mov.
MPeg-4 : jusqu’à 2,5 Mb/sec, 480 x 480 pixels, 
30 images par seconde, profil simple avec AAC-LC
jusqu’à 160 kbps, 48 kHz, son stéréo aux formats 
de fichier .m4v, .mp4 et .mov. 

e Pour la vidéo, le H.264 est le bon choix tant que
la lecture s’effectue sur l’écran de l’iPod.
La résolution de l’image (320 x 240) est en revanche
trop faible pour une télévision. Vous choisirez 
donc le MPeg-4, d’ailleurs nettement plus rapide 
à l’encodage, qui autorise un flux de données 
(2,5 Mbps) et un format d’image plus importants
(480 x 480 maxi). La taille des fichiers est bien plus
conséquente, mais ce n’est pas ici un problème.
En ce qui concerne l’audio, cela dépendra 
de la qualité finale souhaitée, mais vous pourrez
pousser (en stéréo 48 kHz) jusqu’à 160 kbps, 
ce qui est largement suffisant ; 128 kbps reste 
une valeur standard communément utilisée.
Une valeur moindre suffira pour la parole, mais 
on n’y gagne plus grand-chose en terme de poids, et
comme on n’en est plus à gratter le moindre octet…

e Côté vidéo, on peut même faire mieux, aller 
au-delà de ce qu’Apple indique comme limites! 
D’ailleurs, les nombreux outils qui ont fleuri depuis 
la sortie de l’iPod 5G nous le confirment. Par exemple,
l’utilitaire iSquint propose, à partir d’une source 
courante 4:3 Pal en .mov, DV, VOB, Mpeg (720 x 576),
un encodage MPeg-4 en 544 x 408 au lieu du 480 x
360 auquel on aurait pu s’attendre, 480 étant 
le maximum indiqué par Apple (360 la hauteur 
correspondante au rapport 4:3). On constate 
la même chose en utilisant l’exportation depuis
EyeTV au format iPod (recommandé) . Là encore, 
on obtient 544 x 408, la meilleure solution à partir
d’un enregistrement EyeTV. Je l’utilise avec mon
TVMini pour la TNT. Capture, sélection, exportation, 
le tour est joué! En cochant Ouvrir iTunes une fois
terminé, le fichier rejoint automatiquement la biblio-
thèque iTunes, prêt à être transféré dès que l’iPod
sera connecté. Trouver plus simple, ça va être dur!
Les caractéristiques complètes du fichier généré
sont: 544 x 408 pixels à 25 i/sec. Débit vidéo MPeg-4:

1510 kbps. Débit audio AAC stéréo 48 kHz: 
128 kbps. Débit total : 1638 kbps. Poids moyen
du fichier : 11,72 Mo/min (ou 703 Mo/h).

e Vérification faite, le fichier est parfaitement 
lu par l’iPod et passe très bien à la télévision, 
dans une qualité déjà remarquable. Le compromis
poids/qualité est bien optimisé.
Pour la meilleure qualité vidéo, vous retiendrez donc
un format de 544 x 408 en 4:3. D’autres essais m’ont
permis de constater que la valeur de 2500 kbps 
représente le débit total maximal utilisable (audio et
vidéo) du fichier. Avec un débit audio maximum 
autorisé de 160 kbps, ce sont donc encore 2340 kbps

qui restent pour la vidéo, et c’est plus que suffisant!
De même, par expérience, il vaudra mieux disposer
de fichiers DV, VOB ou MPeg; de toute façon, 
MPEG Streamclip est là pour passer d’un format 
à un autre. Depuis iMovie, vous aurez donc tout 
intérêt à partager le montage vers QuickTime Haute
Qualité, ce qui produira un fichier DV. Depuis 
un DVD, il n’y aura qu’à ouvrir les VOB avec MPEG
Streamclip pour les éditer et les Convertir en MPeg.
Depuis tout autre format, un passage par MPEG
Streamclip s’avérera nécessaire, et une conversion
en MPeg constituera sans doute la meilleure solution.

Les utilitaires de conversion sont légion, et après les avoir tous plus 
ou moins testés, c’est iSquint qui décroche la palme ! Outre un solide
sens de l’humour – je vous laisse découvrir les petits messages –, il est
d’une utilisation simplissime et vraiment très efficace.
Bien entendu, vous cliquez sur le bouton radio de l’option Optimisé pour
la télé. Ensuite, vous optez pour un niveau de qualité. Pour un clip 
destiné à être regardé sur une télévision, pas de prise de tête : placez 
le curseur sur le réglage maximal : À fond ! Cochez la case Ajouter 
à iTunes… pour automatiser complètement la production. L’encodage est
par défaut en MPeg-4 ; ne cochez pas la case Encodage H-264 qui vous
limiterait à la résolution 320 x 240 et à un débit vidéo de 768 kb/sec.
Pour mes tests, je me suis servi d’un fichier d’essai .mpeg obtenu après
l’édition d’un fichier VOB (sur un DVD) converti en MPeg avec MPEG
Streamclip. Le résultat est un fichier .mp4 au format MPeg-4, 544 x 408,
audio stéréo 48 kHz à 105 kb/sec, et pour la vidéo, suivant le niveau 
de qualité demandé : À fond = 1 568 kb/sec (11,96 Mo/min), Haute = 1 025
kb/sec (8,7 Mo/min), Standard = 528 kb/sec (4,52 Mo/min). Les réglages
Basse et P’tite sont à éviter. Vous opterez systématiquement pour À fond
qui permet de rentrer quelque 85 h de vidéo dans un iPod 60 Go… Notez
qu’à partir de sources différentes (VOB, DV, MPeg) on obtient, pour 

le même réglage À fond, des débits
vidéo allant de 1 250 à 2 250 kbps.
C’est très étonnant et j’ai mainte-
nant pris l’habitude de confier 
d’office tous mes fichiers à MPEG
Streamclip pour les convertir 
en MPeg chaque fois que possible 
– ou en DV-Pal (notamment 
à partir de fichiers .mov, surtout
s’ils sont au format NTSC).

Préparez facilement vos clips
grâce à iSquint
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L’acquisition des photos depuis un appareil photo numérique (APN)
ressemble plus à ce qui se passe avec Transfert d’images qu’avec

iPhoto. GraphicConverter vous offre le choix entre toutes les photos 
ou celles que vous sélectionnez. Rien n’interdira donc de définir, dans
les Préférences de Transfert d’images (dont la fonction clé est de fixer
les règles d’acquisition des photos pour Mac OS X), GraphicConverter
comme application à ouvrir dès la connexion d’un appareil.
Si c’est le cas, GraphicConverter se lance et affiche cette alerte . 
Sinon, vous procédez manuellement et après avoir connecté 
votre appareil comme d’habitude, faites Fichier > Acquisition > 
Sélectionner les images à télécharger depuis l’APN connecté.
Dans les deux cas, un dialogue présente les photos stockées dans
la mémoire de l’APN . Vous pourrez les sélectionner 
et les importer dans un dossier qu’un dialogue de sauvegarde 
vous permettra de choisir après avoir cliqué sur Télécharger, ou 
dans le dossier proposé (date du jour et film xx) qui sera créé 
dans le dossier Images lors du chargement.
À la fin de l’importation, vous vous retrouvez dans le Gestionnaire
d’images, directement placé (voir image en page suivante) dans 
le dossier concerné.

2
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Chargez directement vos photos
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ATELIER

Si vous n’aimez pas la manière dont iPhoto gère vos images et que vous souhaitez conserver 
une totale liberté d’organisation de votre photothèque, nul besoin de payer très cher un logiciel
professionnel. Jetez un œil sur GraphicConverter, car ce shareware (28 €) a bien des atouts !

G
raphicConverter est réputé pour sa prise en charge de nom -
breux formats, ce qui en fait un merveilleux outil de conver-
sion. Cette application offre également une multitude de fonc-

tions de traitement et d’organisation: ajustement des couleurs, trai-
tement de la transparence, montages photographiques… Graphic-
Converter n’a parfois pas toute la souplesse d’un Photoshop et de
ses calques, mais c’est une trousse à outils très complète et variée,
pour un prix raisonnable, aussi à l’aise dans la préparation des ima-
ges pour le Web, l’adaptation de photos pour l’impression, que la ré-

cupération de captures d’écran Palm! Son gestionnaire d’images et
sa commande de conversion en masse permettent même de traiter
de gros volumes d’images avec confort. Désigner GraphicConverter
comme application à ouvrir par iPhoto lors de l’édition par dou-
ble-clic n’étonnera donc personne. Alors, pourquoi ne pas aller plus
loin? Nous allons voir comment gérer l’ensemble des opérations di-
rectement sous GraphicConverter, en passant par l’acquisition, le
rangement, le traitement, la conversion… n Jean-Jacques Ardoino
www.macvf.com/GraphicConverter/info.html

Importez, gérez et traitez vos photos

avec GraphicConverter

ATELIER
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Le Gestionnaire d’images constitue la plaque tournante de vos opérations 
ultérieures. Il ne gère pas son «propre» catalogue : la liste des dossiers 

à gauche est celle du Finder et, quand vous passez de l’un à l’autre 
des dossiers, vous voyez ce qui est physiquement rangé sur votre disque dur.
Rien ne vous interdit toutefois de déplacer ou copier une image, de rassembler 
les photos de plusieurs dossiers vers un seul dossier ou, au contraire, créer 
un nouveau sous-dossier dans le dossier sélectionné (il vous sera alors proposé 
de déplacer les photos éventuellement sélectionnées dans ce nouveau dossier).
Avec un double-clic sur une image, celle-ci sera évidemment ouverte dans une
fenêtre, prête à toutes les modifications classiques proposées par l’application.
Cela dit, même sans passer en mode édition, le Gestionnaire d’images
vous offre de modifier directement une ou plusieurs images, via le menu 
contextuel qui propose rotation, miroir, export, ajout de commentaires et de mot-
clé, impression de catalogue… , et surtout via la fonction Traitement .54

3

Àpartir du Gestionnaire d’images, vous pouvez utiliser le traitement en série
de deux façons, soit en sélectionnant des images et en utilisant les options

de traitement en haut et à droite de la fenêtre du gestionnaire , soit en dési-
gnant un dossier de la liste de gauche et en demandant Ouvrir dans Convertir 
& modifier dans le menu contextuel. C’est en gros la même fonction appelée 
de deux manières différentes ; optez pour l’une ou l’autre selon le contexte. 

e En passant par Convertir et modifier, cela vous semblera peut-être plus clair.
Le dialogue affiche des dossiers Source et Destination (le même si vous utilisez
la flèche entre les deux listes) . Vous pouvez glisser un dossier du Finder
dans l’une ou l’autre des listes afin de mettre à jour le chemin. Vous choisissez
éventuellement un format de sortie et un traitement en série. La commande
Exécuter s’appliquera à tout ce que vous sélectionnez dans la fenêtre de gauche.
Le format de sortie ne nécessite pas d’explications, c’est du classique. Le bouton
Traitements ouvre un dialogue pour combiner plusieurs actions choisies 
dans la liste de gauche et ajoutées dans l’ordre que vous voulez dans celle 
de droite . Vous pouvez modifier l’ordre des actions en les glissant et chacune
d’elles offre éventuellement ses propres réglages. Vous sauvez un traitement

pour l’utiliser ultérieurement : par exemple, fixer la résolution 
à 72 dpi et mettre les images à l’échelle en pourcentage 
ou bien suivant une hauteur fixe en pixels (la largeur 
sera calculée). Parfait pour illustrer vos pages Web ou modifier
contraste et luminosité suivant un taux compensant 
les performances de votre imprimante.

e Si vous utilisez les menus locaux Traitement et Format avec
les pop-up en haut de la fenêtre , la procédure est légère-
ment différente, mais vous retrouvez les mêmes possibilités .
Déterminez un format de sortie avec ou sans traitement 
en série, rappelez un traitement enregistré ou définissez-en 
un nouveau, puis choisissez un dossier de destination.

9
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Gérez vos images
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Appliquez des traitements en série
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Dans GraphicConverter, vous ne travaillerez pas vraiment comme dans iPhoto.
Une différence essentielle est que ce logiciel ne conserve ni photothèques, 

ni albums, ni diaporamas. Cela dit, si vous voulez jouir d’une liberté totale pour
organiser vos photos comme vous le voulez, dans des dossiers du Finder, Graphic
Converter est alors fait pour vous. Vous accéderez à ces dossiers et y naviguerez 
sans contrainte. Toutes les copies (ou déplacements d’images) effectuées depuis 
le Gestionnaire d’images sont immédiatement répercutées au niveau du Finder.

e Toutefois, vous retrouvez des possibilités de consultation et de navigation 
quasiment aussi pratiques que celles que vous propose iPhoto, mais en plus, vous
gagnez ici des possibilités d’édition , de filtres et d’effets , ainsi que des
conversions très puissantes. S’il n’enregistre pas de diaporama (comme unité de
rangement d’images), GraphicConverter a néanmoins une fonction de diaporama
qui est exécutée depuis le Gestionnaire d’images et essentiellement consultative.
Attention, ici, pas d’accompagnement sonore ni de transitions personnalisées,
mais il ne s’agit pas de savoir si GraphicConverter peut remplacer iPhoto. Il s’agit

1110

d’une application qui peut prendre 
en main une grande partie des opéra-
tions d’acquisition, de classement 
et de modifications diverses.
Ensuite, rien ne vous empêche 
d’importer tel ou tel de vos dossiers
de photos dans iPhoto pour 
les intégrer à d’autres tâches 
(un diaporama personnalisé ou 
un livre). Il est dommage que 
les commentaires et mots-clés IPTC
ajoutés sous GraphicConverter ne
soient pas pris en compte par iPhoto.

e À vous d’explorer les moyens de combiner les avantages respectifs des deux
logiciels, mais vous savez désormais qu’il serait dommage de confiner 
GraphicConverter au seul rôle d’éditeur d’images. Exploitez ses diverses fonctions 
d’acquisition, de gestionnaire d’images et de traitement ainsi que d’autres 
fonctions que je vous laisse découvrir, notamment l’export vers un service photo

ou l’export de photos vers iDVD – qui ne crée pas de nouveau 
projet iDVD, mais ajoute un diaporama fonctionnel dans le menu du dernier 
projet iDVD ouvert. Bref, c’est à vous de jouer!

1312

Comme dans iPhoto?

12
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11
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e Tous les sommaires
e Un index complet des magazines
e Une recherche des anciens articles
e Des nouvelles de la rédaction
e Un forum chaleureux et efficace

Vous recherchez un article ? Visitez notre site Web !

www.vvmac.com
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Votre première démarche consiste à ouvrir 
un compte. Pour les besoins de l’exercice, 

nous allons nous contenter de la formule gratuite
qui impose évidemment plus de limitations 
que la formule payante (25 $ annuels), mais 
permet de se faire une idée de ce qu’est Flickr. 
Cliquez sur le lien Sign Up Now! Il vous faut 
un compte Yahoo!, car Flickr a été racheté 
par ce moteur de recherche. Si vous n’avez pas 
de compte, créez-en un: c’est gratuit, rapide 
et ne vous engage à rien (vous n’êtes pas obligé
d’utiliser la messagerie qui l’accompagne). 

Cela fait, vous êtes invité à vous connecter 
à Flickr. Une nouvelle page (que vous ne reverrez
d’ailleurs plus) s’affiche qui donne quelques liens.
Cliquez sur le lien Go to your homepage.
Vous voici arrivé sur la page d’accueil de votre 
espace Flickr . Pour être franc, cette page n’est
pas un modèle de design ni de clarté! Quelques
explications rapides pour vous y retrouver…
Un premier lien vous permet de transférer 
des photos. Un deuxième vous dirige vers 
vos collections de photos. Le troisième lien 
Everyone’s Photos permet d’afficher les clichés 

1

Pour partager vos photos sur 
Internet, vous pouvez créer un site
de A à Z, choisir une solution comme
RapidWeaver, ou bien faire confiance 
à un service en ligne. Parmi 
ces derniers, j’ai opté pour Flickr 
(non, il ne manque pas une lettre…). 
Pourquoi cette solution plutôt 
qu’une autre ? Parce qu’elle repose
sur une série de principes qui 
la distinguent d’autres plateformes
de publication en ligne. Je ne doute
pas que vous deveniez, vous aussi, 
un adepte de ce système.

B
ien sûr, vous pouvez créer vous-même un su-
perbe site pour exposer vos œuvres. Achetez
Dreamweaver ou Freeway et prévoyez quel-

ques longues heures d’apprentissage avant de pouvoir
afficher le moindre cliché en ligne! Si vous ne voulez
rien faire d’autre que trier vos photos personnelles,
les sites de publication automatique constituent une excellente solu-
tion pour partager les meilleures. Selon moi, Flickr est l’un des mieux
conçus; je vous propose de le découvrir, ou de mieux le connaître,
dans ce petit atelier. Votre découverte de Flickr sera d’autant plus fa-
cile si vous connaissez le vocabulaire particulier utilisé par ce service.
Photoset désigne un album photo tandis que Photostream renvoie
à la photothèque dans son ensemble. Les Contacts sont d’autres uti-
lisateurs du service dont vous appréciez les photos et que vous pou-
vez classer en trois catégories: Contacts simples, Friends ou Family.

Ces derniers possèdent plus de droits que vos amis, qui en ont eux-
mêmes davantage que vos contacts. Vous pourrez ainsi réserver des
séries de photos à vos seuls amis ou ne les dévoiler qu’aux seuls mem-
bres de votre famille. Une dernière chose: le terme Favorites s’appli-
que à des photos que vous avez remarquées en feuilletant les albums
des autres utilisateurs et qui vous ont plu pour une raison ou pour
une autre. Elles sont alors référencées dans un album Your Favori-
tes que tout un chacun peut consulter. Dis-moi quelles photos tu
aimes, je te dirai qui tu es… n Vincent Absous

Publiez et gérez facilement vos photos

en ligne avec le service Flickr

S’inscrire à Flickr

1
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Transférez vos photos avec un navigateur

les plus récents postés par les autres utilisateurs.
Enfin, le quatrième lien affiche la liste des groupes 
auxquels vous êtes abonné. Les groupes sont 
représentatifs de l’esprit communautaire de Flickr :

ce sont des espaces virtuels que vous pouvez 
rejoindre ou créer et où vous posterez vos photos
(une même photo peut appartenir aux groupes 
Macintosh, iMac, Intérieur Design, etc). Pour 

le moment, vous n’appartenez à aucun groupe. 
Vous savez l’essentiel et je vous fais confiance 
pour découvrir par vous-même la richesse de l’outil. 
Mettons-nous au travail et publions nos photos.

Cliquez sur le lien Upload photos to Flickr.
Une nouvelle page s’affiche avec une série 

de boutons qui vous permettent d’aller chercher 
vos photos. Pour chaque cliché, appuyez successive-
ment sur les boutons Choisir le fichier . Localisez
à chaque fois sur votre disque dur (ou un volume
monté) la photo que vous voulez transférer. 
Lorsque le transfert est achevé, une nouvelle page
s’affiche et vous pouvez donner à chaque cliché 
un titre, écrire quelques lignes de commentaire 
et définir les mots-clefs (Tags) .

e Donnez des mots-clés
J’attire toute votre attention sur ces tags. Ils forment 
une autre caractéristique essentielle de Flickr. Ainsi,
vous venez de publier une photo prise à Marseille,

l’été dernier. Vous pouvez lui associer quelques mots
clefs («marseille provence france coursjulien», 
par exemple) que vous saisirez l’un après l’autre, 
séparés par un espace, sans majuscule et en un seul
mot pour les expressions. Vous pourrez par la suite
effectuer vos recherches dans votre photothèque 
et permettrez aux autres de retrouver facilement 
vos photos. Validez en cliquant sur Save.

e Organisez vos photos
Votre image est désormais en ligne. Vous allez 
la glisser dans un album. Vous n’en avez pas 
encore créé un? Qu’à cela ne tienne, cliquez 
sur une des photos que vous venez de transférer,
puis sur le petit bouton Add to Set de la barre 
d’icônes qui s’affiche au-dessus de la photo.
Créez un nouvel album (le mien s’appellera 
Marseille , et le vôtre?). Enregistrez. 
Plus tard, quand vous aurez fureté ici et là dans
Flickr, vous aurez peut-être rejoint un ou plusieurs
de ces groupes dont je vous parlais plus haut.
Vous penserez alors que telle photo que vous avez
publiée pourrait intéresser les abonnés au groupe

Wallpaper… Vous afficherez à nouveau cette image
et cliquerez alors sur le bouton Send to Group ;
la liste des groupes que vous aurez rejoints 
s’affichera, vous sélectionnerez le bon et confirmerez.
Une même photo peut être partagée sur plusieurs
groupes. Prenez soin toutefois de ne pas proposer
trop vite une photo à un groupe. Le principe 
de Flickr est qu’on peut aussi commenter les clichés
proposés. Les autres abonnés du groupe vous re-
prendront vertement si vous publiez sans réfléchir…

e «Cadrez» pour annoter
Publions donc une autre photo (celle, par exemple, 
de votre bureau). Nous allons maintenant lui associer
des notes. Affichez le clichéet appuyez sur le petit
bouton Add Note, juste au-dessus de votre photo, 
à gauche. Un petit cadre avec des poignées et 
une zone de texte apparaît. Je vous laisse déplacer
le cadre au-dessus d’un élément de la photo 
que vous voulez commenter et l’agrandir avec 
les poignées. En ce qui me concerne, je vais pointer
mon iBook, mon iMac, ma souris et mon clavier 
Bluetooth , soit trois cadres. Ainsi, lorsqu’on 
affichera la photo, les cadres apparaîtront et leur
contenu sera lisible dès que la souris les survolera.
Vos visiteurs peuvent eux aussi laisser des notes 
sur vos photos (à moins que vous ne l’interdisiez
dans les préférences de votre compte). Tout cela,
vous pouvez le faire sans quitter votre navigateur,
mais pour utiliser Flickr, vous pouvez aussi recourir 
à des logiciels qui vont vous faciliter la vie.
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Les badges Flickr

Si vous avez par ailleurs ouvert un blog ou créé une page Web
personnelle, alertez les visiteurs de l’existence de votre photo-

thèque sur Flickr. Vous pouvez donner tout simplement son URL
(www.flickr.com/photos/votrenom), mais le mieux est sans doute 
de l’indiquer par un Badge (www.flickr.com/badge_new.gne). 
Choisissez quel type de badge (HTML ou Flash ), et au fil 
des cinq étapes, choisissez quelles photos afficher dans l’encadré
(les vôtres, celles d’un groupe particulier, un choix aléatoire dans

l’ensemble de la photothè-
que Flickr), et déterminez 
sa présentation (de façon 
à ce qu’il s’intègre bien dans
votre site). In fine, vous 
récupérerez un code 
qu’il vous suffira d’insérer
ensuite dans celui de votre
site. Les visiteurs cliqueront
sur le badge pour accéder 
à votre photothèque Flickr.

9

Flickr Upload (www.flickr.com/tools/) est un petit
logiciel qui va faire l’essentiel du travail pour

vous. Prenez vos photos et glissez-les sur l’icône 
de Flickr Upload (que vous aurez peut-être d’ailleurs
placée dans le Dock) : une fenêtre s’affiche où vous
retrouvez vos photos sous la forme de vignettes .
Vous pouvez alors attribuer un titre, écrire 
un commentaire et choisir les mots-clefs pour
chaque image ou pour l’ensemble (onglet Batch).

Vous pouvez aussi décider de ne montrer tel 
ou tel cliché qu’à vos amis ou à votre famille 
ou de les laisser visibles à tous. Enfin, vous ajouterez
automatiquement les photos à un album existant 
ou en créerez un nouveau. Cela fait, il ne vous reste
plus qu’à cliquer sur le bouton Upload .

e Il existe aussi un petit widget gratuit, Flidget
(www.apple.com/downloads/dashboard/blogs_
forums/flidget.html), pour transférer facilement 
une photo. Une fois installé, choisissez une photo, 
appuyez sur F12 pour activer Dashboard et glissez-la
sur le widget . Saisissez vos mots-clefs, donnez 
à l’arrière vos codes d’accès au service et appuyez
sur le bouton Upload pour démarrer le transfert.

e Si vous utilisez iPhoto pour gérer vos clichés, 
passer par votre navigateur Internet ou même par
Flickr Upload n’est pas évident, sauf si vous utilisez
FlickExport (http://connectedflow.com/flickrexport/).
La procédure d’installation est automatisée 
et vous n’aurez rien à faire sinon qu’à cliquer 
sur quelques boutons. À la fin, l’installateur vous 
propose de lancer iPhoto. Acceptez…
Sélectionnez l’album ou seulement la ou les photos
que vous souhaitez poster sur Flickr. Faites Partager
> Exporter et cliquez sur le bouton Flickr. Le plug-in 
affiche pour chaque photo le titre qui est 
le sien dans iPhoto: c’est l’occasion de le modifier 
ou de donner le même titre à toutes les photos 

(bouton Apply Title to All). Libre à vous de saisir 
un commentaire pour chaque cliché ou de choisir 
là encore d’attribuer le même commentaire pour 
toutes vos photos (bouton Apply Description to All).
N’oubliez pas les fameux tags, ils peuvent être 
identiques pour toutes les photos à publier ou 
différents. Pour en ajouter un, cliquez sur le petit +.
Pour en retirer un (vous avez le droit à l’erreur!), 
cliquez sur le petit -. Si vous le voulez, glissez tout 
de suite les photos que vous allez exporter dans 
un album (photoset). Vous pouvez d’ailleurs en créer
un nouveau directement depuis l’interface du plug-in.
Voilà, vous n’avez plus qu’à appuyer sur le bouton 
Exporter pour que le logiciel s’occupe de tout. 
Une fois le transfert effectué, allez sur votre page
perso de Flickr pour vérifier le travail et modifier
éventuellement certaines informations.

8
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Transférez vos photos sans passer par un navigateur

Prenez le temps de bien réfléchir au système de licence que vous allez adopter. Si, comme
moi, vous êtes un photographe du dimanche, vos photos n’ont d’intérêt que pour vous 
et vos proches et il y a peu de risque qu’on veuille les utiliser. Quoique… Mais si vous avez 
un talent de photographe, si vous publiez des clichés dont l’originalité est patente, 
vous aurez tout intérêt à les protéger. Ne publiez pas les photos en trop haute résolution.
Dans l’interface Web de Flickr, cliquez sur Your Account (tout en haut, à droite) : vous voici
dans la salle des commandes du système. Grâce à l’option Allowing Downloads,
vous décidez si les visiteurs de Flickr peuvent afficher les photos dans leur résolution 
maximale et les télécharger. Plusieurs solutions s’offrent à vous: vous pouvez réserver ce
traitement de faveur à vos amis ou à votre famille, à vos seuls contacts, à tous les abonnés
Flickr, voire à tout le monde. A contrario, vous pouvez choisir d’interdire complètement 
le téléchargement de vos photos. Revenez à la page Your Account et cliquez sur Photo 
Licensing pour définir le contrat de licence par défaut qui s’appliquera aux photos que vous
publiez (vous pourrez modifier ce contrat au coup par coup). Plusieurs types de contrats
sont proposés, dont les fameux Creative Commons (équivalent de l’open source). Un lien
Wizard renvoie à une page, en français, où vous pouvez déterminer quel contrat est fait
pour vous. Dans le doute – et si vous n’avez pas l’intention de faire commerce de vos clichés –,
choisissez la première option de la liste proposée par Flick, None (All Rights Reserved).

Quelle licence choisir ?
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